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Preface

This ASG-Recap User’s Guide describes how to use ASG-Recap (herein called Recap)
for application definition and report generation. Recap offers automated inventory
analysis capabilities to evaluate COBOL applications. Recap reports contain function
point analysis and metrics data, program quality assessments, intra-application and
inter-application comparisons and summaries, and historical reporting of function point
and metrics data. The portfolio analysis information can also be viewed online or
exported to PC databases, spreadsheets, or graphics packages.

Allen Systems Group, Inc. (ASG) provides professional support to resolve any questions
or concerns regarding the installation or use of any ASG product. Telephone technical
support is available around the world, 24 hours a day, 7 days a week.

ASG welcomes your comments, as a preferred or prospective customer, on this
publication or on any ASG product.

About this Publication

This publication consists of these chapters:

. Chapter 1, "Introduction," gives an overview of Recap, its interfaces, and operating
system.

. Chapter 2, "Concepts." describes the concepts and terms related to the operation of
Recap.

. Chapter 3, "Building and Analyzing an Application," guides you through the
procedures used to define an application and generate function point data.

. Chapter 4, "Using Portfolio Analysis Data," presents several scenarios to illustrate
potential uses of Recap’s function point and inventory analysis data.

. Chapter 5, "Viewing and Editing Function Point Data," discusses the various
options for viewing and editing function point data.

. Chapter 6. "Report Descriptions," describes and illustrates each report generated by
Recap.

X
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. Chapter 7, "Report Generator Language," provides ways to adjust or change report
content and format to meet your organization’s requirements using Recap’s Report
Generator Language.

. Chapter 8, "Import Facility," gives detailed information about the Import Facility
and how it allows you to import an application definition into the AKR.

. Chapter 9, "Export Metrics Facility," guides you through the creation of files for
export and for output from export.

. Chapter 10, "Exporting an Application Definition," provides information about
copying the application definition, exporting it, and creating one similar to the
original one.

. Chapter 11, "AKR Utilities," explains both online and batch AKR utilities.

. Chapter 12, "Application Conversion," states that to take advantage of the more
accurate function point values of the more recent version of Recap, it will be
necessary to do a full analyze of your applications.

. Chapter 13, "Report Options," summarizes the report options and product default
for each option.

. Chapter 14, "Help Facility," describes the various online Help facilities available
and methods to access them.

. Chapter 15, "Sample AKR." provides information concerning the AKR with sample
applications provided on the Recap installation tape.
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Related Publications

The documentation library for ASG-Recap consists of these publications (where nn
represents the product version number):

Note:

ASG-Application Definition and Analysis User’s Guide (ALL0200-nn) describes
defining and analyzing an application in ASG-Alliance, ASG-Recap, and
ASG-Estimate.

ASG-Center Installation Guide (CNX0300-nn) provides installation and
customization procedures for ASG-Center, the common platform for all
ASG-Existing Systems Workbench components. ASG-Center must be installed
before installing ASG-Recap.

ASG-ESW Enhancement Summary (ESW1000-nn) highlights the new functionality
for this release.

ASG-Recap Installation Guide (RCX0300-nn) contains information on the
installation and maintenance of ASG-Recap.

ASG-Recap User’s Guide (RCX0200-nn) provides instructions for using
ASG-Recap for application definition and reports generation.

To obtain a specific version of a publication, contact ASG Customer Support.

xi
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ASG-Existing Systems Workbench (ASG-ESW)

Xii

ASG-ESW (herein called ESW) is an integrated suite of components designed to assist
organizations in enhancing, redeveloping, or re-engineering their existing systems. ESW
products use the Application Knowledge Repository (AKR) to store source program
analysis information generated by the Analytical Engine. Figure 1 represents the
components of ESW.

Figure 1 + ASG Existing Systems Workbench

Existing Systems Workbench I

ASG-Alliance for Application Understanding

ASG-AutoChange for Mass Change Projects
ASG-Bridge for Conversion Projects
ASG-Encore for Evolving COBOL Programs
ASG-Center ASG-Estimate for Resource Estimation
ASG-Insight for Program Understanding
ASG-Recap for Portfolio Analysis

. . ASG-SmartDoc for Program Documentation
Analytical Engine |«

A4

ASG-SmartEdit for COBOL Intelligent Editing

ASG-SmartQuest for Analyzing Abends

Application
Knowledge
Repository (AKR) - TS0
- CICs

- IMS

- ASM

- APS

- PLI

- TCA for Test Coverage Analysis
- DB2 Stored Procedure

ASG-SmartTest for Testing/Debugging
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This table contains the name and description of each ESW component:

ESW Product

ASG-Alliance

Herein Called

Alliance

Description

The application understanding component that is
used by IT professionals to conduct an analysis of
every application in their environment. Alliance
supports the analysis and assessment of the
impact of change requests upon an entire
application. Alliance allows the programmer/
analyst to accurately perform application analysis
tasks in a fraction of the time it would take to
perform these tasks without an automated
analysis tool. The impact analysis from Alliance
provides application management with additional
information for use in determining the resources
required for application changes.

ASG-AutoChange AutoChange

The COBOL code change tool that makes
conversion teams more productive by enabling
quick and safe changes to be made to large
quantities of code. AutoChange is an interactive
tool that guides the user through the process of
making source code changes.

ASG-Bridge

Bridge

The bridging product that enables field expansion
for program source code, without being required
to simultaneously expand the fields in files or
databases. Because programs are converted in
smaller groups, or on a one-by-one basis, and do
not require file conversion, testing during the
conversion process is simpler and more thorough.

ASG-Center

Center

The common platform for all ESW products.
Center provides the common Analytical Engine to
analyze the source program and store this
information in the AKR. This common platform
provides a homogeneous environment for all
ESW products to work synergistically.

xiii
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ESW Product

ASG-Encore

Herein Called

Encore

Description

The program re-engineering component for
COBOL programs. Encore includes analysis
facilities and allows you to extract code based on
the most frequently used re-engineering criteria.
The code generation facilities allow you to use the
results of the extract to generate a standalone
program, a callable module, a complement
module, and a CICS server. Prior to code
generation, you can view and modify the
extracted Logic Segment using the COBOL
editor.

ASG-Estimate

Estimate

The resource estimation tool that enables the user
to define the scope, determine the impact, and
estimate the cost of code conversion for COBOL,
Assembler, and PL/I programs. Estimate locates
selected data items across an application and
determines how they are used (moves, arithmetic
operations, and compares). Time and cost factors
are applied to these counts, generating cost and
personnel resource estimates.

ASG-Insight

Insight

The program understanding component for
COBOL programs. Insight allows programmers
to expose program structure, identify data flow,
find program anomalies, and trace logic paths. It
also has automated procedures to assist in
debugging program abends, changing a
computation, and resolving incorrect program
output values.

ASG-Recap

Recap

The portfolio analysis component that evaluates
COBOL applications. Recap reports provide
function point analysis and metrics information,
program quality assessments, intra-application
and inter-application comparisons and
summaries, and historical reporting of function
point and metrics information. The portfolio
analysis information can also be viewed
interactively or exported to a database,
spreadsheet, or graphics package.

ASG-SmartDoc

SmartDoc

The program documentation component for
COBOL programs. SmartDoc reports contain
control and data flow information, an annotated
source listing, structure charts, program summary
reports, exception reports for program anomalies,
and software metrics.

Xiv
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ESW Product Herein Called  Description

ASG-SmartEdit SmartEdit The COBOL editing component that can be
activated automatically when the ISPF/PDF
Editor is invoked. SmartEdit provides
comprehensive searching, inline copybook
display, and syntax checking. SmartEdit allows
you to include an additional preprocessor (for
example, the APS generator) during syntax
checking. SmartEdit supports all versions of IBM
COBOL, CICS, SQL, and CA-IDMS.

ASG-SmartQuest  SmartQuest The diagnostic tool for analyzing batch and CICS
transaction abends. SmartQuest has been
designed to make the maximum use of simple
point-and-shoot techniques to enable fast and
easy navigation through any data dump.

ASG-SmartTest SmartTest The testing/debugging component for COBOL,
PL/I, Assembler, and APS programs in the TSO,
MVS Batch, CICS (including file services), and
IMS environments. SmartTest features include
program analysis commands, execution control,
intelligent breakpoints, test coverage, pseudo
code with COBOL source update, batch connect,
disassembled object code support, and full screen
memory display.

Invoking ESW Products

The method you use to invoke an ESW product depends on your system setup. If you
need assistance to activate a product, see your systems administrator. If your site starts a
product directly, use the ISPF selection or CLIST as indicated by your systems
administrator. If your site uses the ESW screen to start a product, initiate the ESW screen
using the ISPF selection or CLIST as indicated by your systems administrator and then
typing in the product command on the command line.

The product names can also vary depending on whether you access a product directly or
through ESW. See "ESW Product Integration" on page xvi for more information about
using ESW.

XV
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To initialize ESW products from the main ESW screen, select the appropriate option on
the action bar pull-downs or type the product shortcut on the command line.

Product Name (ESW Name) Shortcut  ESW Pull-down Options
Alliance (Application Understanding) AL Understand » Application
AutoChange (Conversion Set) CC Change » Conversion Set
Bridge BR Change » ASG-Bridge
Encore (Program Re-engineering) EN Re-engineer » Program
Estimate ES Measure P ASG-Estimate
Insight (Program Understanding) IN Understand » Program
Recap (Portfolio Analysis) RC Measure » Portfolio
SmartDoc (Program Documentation) DC Document » Program
SmartEdit SE Change » Program

Or

Change » Program with Options

SmartQuest SQV Understand » Abend/Dump

SmartTest (Testing/Debugging) ST Test » Module/Transaction

ESW Product Integration

Because ESW is an integrated suite of products, you can access individual ESW products
directly, or through the main ESW screen. As a result, different fields, values, action bar
options, and pull-down options display on a screen or pop-up depending on how you
accessed the screen or pop-up.

Certain ESW products also contain functionality that interfaces with other ESW products.
Using SmartTest as an example, if Alliance is installed, SmartTest provides a dynamic
link to Alliance that can be used to display program analysis information. If Insight is
installed and specified during the analyze, the Insight program analysis functions are
available for viewing logic/data relationships and execution path. For example, the
Scratchpad option is available on the Options pull-down if you have Insight installed.

Xvi
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Access to these integrated products requires only that they be installed and executed in
the same libraries.

Figure 2 shows the Encore Primary screen that displays when you access Encore directly.

The Encore Primary screen contains these eight action bar menu items: File, View,
Extract, Generate, Search, List, Options, and Help.

Figure 2 « Encore Primary Screen

File Uiew Edtract Generate 3Zearch List Options  Help

RAEG-EnCore
CoHAHand ===
etttk debebbk kbbbt Aottt
ettt Hbtebk bbbkl Atk
Atk Htebk Bass s S o s 2 Aotk
Atttk Atttk Atttk etk =tk
Attt
Atttk

Copwright Allen systeds Group, Inc., an unpublished wark.
A proprietary product of A%G, Inc.  Use restricted to authorized licensees.
Uizit the ASG Zupport Web Zite at www.asg.cod
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Figure 3 shows the Encore Primary screen that displays when you access Encore through
ESW by selecting Re-engineer P Program from the ESW action bar menu. Notice that the
Primary screen name changes to ASG-ESW - Program Re-engineering when you enter
Encore through ESW. Also, the Logic menu item displays if Insight is installed.

Figure 3« ESW Encore Primary Screen

File Wjew Extract Generate $£earch Logic List Options Help

AFE-EZN - Prograd Re—engineering

ComAand ===
ettt Hbtebk bbbkl Atk
Aottt Akt bbbk Aotk
Atttk Atttk Aotttk etk Atk
etk etttk Aotttk etk Aok
Atk
etttk

copwright ALlen SysteWs Group, INcC., an unpublished vork.
A proprietary product of A%G, IncC. Use restricted to authorized licensesaz.
Visit The ASE Support Web %ite at wuw,asg.coM

Example 2

Figure 4 shows the File - Analyze Submit pop-up that displays when you access
SmartTest directly. Figure 5 on page xix shows the File - Analyze Submit pop-up that
displays when you access SmartTest through ESW.

Figure 4 « File - Analyze Submit Screen

File - Analyze ZubMit
CorAdand ===

E - Edit TCL 2 - Eubnit TCL

CoHpile and link JCL [PDE o sequentiall:
Data =&t nade

Analyze features [v-M]:
AEG-EMartTests ¥ Extended Analysiss N

AKR data set nawe
AER prograd nane  NEWDEHO [if overriding PROGRAR-IO0)

Analyze options:

CoHpile? [Y<H] « v o« v o o o o i) [7¥ if needad bY features)
Link load Hodule reusable® [Y-M] Y
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The actions shown on these screens can also vary. For example, the D - Doc Options
action is only available on the File Prepare Program screen (or File - Analyze Submit
screen) if SmartDoc is installed on your system. In Figure 4 on page xviii, the Doc
Options action is not displayed.

Figure 5« ASG-ESW - Prepare Program Screen (accessed through ESW)

A%E-EZW - Prepare PrOgrand
CoHHand ===

E - Edit JCL F - EubRit TJCL 0 — Doc Options

CoHpile and link JCL [PDE o sequentiall:
Data set name

Analyze features [v-N]:
Understand: W Testl Y Extended Analysizs N DocuHent: M
Re-engineeri W Abend-<Dunp:

AER data et nane

AKR prograd nade  NEMDEHO [if overriding PROGRAR-ID0]

Analyze options:

CoHpile? (YNl o o o o o 0 o o ¥ [v if needed by features)
Link 1oad Hodule reusable® [Y-M] T [Test and Abend-ODuHp onlyl

Notice that the Analyze features field in Figure 5 lists additional ESW products than
shown on Figure 4 on page xviii. This field is automatically customized to contain the
ESW products you have installed on your system. These are the names of the analyze

types:

ASG-Encore Re-engineer
ASG-Insight Understand
ASG-SmartDoc Document
ASG-SmartQuest Abend/Dump
ASG-SmartTest Test

Extended Analysis (ASG-SmartTest with Extended Analysis
Insight installed)

XIX



ASG-Recap User’s Guide

Publication Conventions

ASG uses these conventions in technical publications:

Convention Represents

ALL CAPITALS Directory, path, file, dataset, member, database,
program, command, and parameter names.

Initial Capitals on Each Word Window, field, field group, check box, button, panel (or
screen), option names, and names of keys. A plus sign
(+) is inserted for key combinations (e.g., Alt+Tab).

lowercase italic Information that you provide according to your
monospace particular situation. For example, you would replace
filename with the actual name of the file.

Monospace Characters you must type exactly as they are shown.
Code, JCL, file listings, or command/statement syntax.

Also used for denoting brief examples in a paragraph.

Vertical Separator Bar (| ) Options available with the default value underlined (e.g.,
with underline Y|N).

Underline Denotes a cursor-selectable field or line.

ASG Customer Support

XX

ASG provides support throughout the world to resolve questions or problems regarding
installation, operation, or use of our products. We provide all levels of support during
normal business hours and emergency support during non-business hours.

ASG Third-party Support. ASG provides software products that run in a number of
third-party vendor environments. Support for all non-ASG products is the responsibility
of the respective vendor. In the event a vendor discontinues support for a hardware and/or
software product, ASG cannot be held responsible for problems arising from the use of
that unsupported version.
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Intelligent Support Portal (ISP)

Online product support is available at: http://www.asg.com/support/support.asp via the
ASG Intelligent Support Portal (ISP). Your logon information for ISP online support is:

Customer ID = NNNNNNNNN
Password = XXXXXXXXXX

where:

NNNNNNNNNN is your customer ID supplied by ASG Product Distribution.
XXXXXXXXXX is your unique password supplied by ASG Product Distribution.

The ASG-Intelligent Support Portal User's Guide provides instructions on how to use the
ISP and is located on the ASG Support web page.

Telephone Support

To expedite response time, please have this information ready:

Product name, version number, and release number

List of any fixes currently applied

Any alphanumeric error codes or messages written precisely as displayed
A description of the specific steps that immediately preceded the problem

Verify whether you received an ASG Service Pack or cumulative service tape for this
product. It may include information to help you resolve questions regarding installation of
this ASG product. The Service Pack instructions are in a text file on the distribution media
included with the Service Pack. You can access the latest software corrections and Service
Packs via the ISP.

The severity code (ASG Customer Support uses an escalated severity system to prioritize
service to our clients. The severity codes and their meanings are listed below.)

Severity Codes and Expected Support Response Times

Severity Meaning Expected Support Response Time
1 Production down, critical situation Within 30 minutes

2 Major component of product disabled Within 2 hours

3 Problem with the product, but customer has ~ Within 4 hours

work-around solution

"How-to" questions and enhancement Within 4 hours
requests
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The Americas

Phone Fax E-mail

United States and
Canada

800.354.3578 1.703.464.4901 support@asg.com

Europe, Middle East, and Africa (EMEA)

During normal business hours, we recommend that you call the Central Support number
first (except in South Africa).

Phone Fax E-mail

Central Support 00.800.3544.3578 44.1727.812018 support.emea@asg.com
English 44.1727.736305 44.1727.812018 support.uk@asg.com
French 33.141.028590 33.141.028589 support.fr@asg.com
German 49.89.45716.200 49.89.45716.400 support.de@asg.com
Italian 39.0290450025 support.it@asg.com
Dutch 31.30.241.6133 support.nl@asg.com
Spanish 34.913.523.800 34917.156.961 support.es@asg.com
South Africa 800.201.423 support.sa@asg.com

Asia Pacific (APAC)

Phone Fax E-mail
Central Support 61.3.9645.8500 61.3.9645.8077 support.au@asg.com
Australia 800.637.947 61.3.9645.8077 support.au@asg.com
Hong Kong 800.96.2800 support.hk@asg.com
Japan 81.3.5326.3684 81.3.5326.3001 support.au@asg.com
Singapore 65.224.3080 65.224.8516 support.sg@asg.com

All Other Countries (Also for any non-working numbers)

Phone

Fax

E-mail

All other countries

1.239.435.2201

support@asg.com

If you receive a voice mail message, follow the instructions to report a production-down
or critical problem. Leave a detailed message including your name and phone number.
An ASG Customer Support representative will be paged and will return your call as soon
as possible. Please have available the information described previously when the ASG
Customer Support representative contacts you.
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ASG Documentation/Product Enhancements

Submit all product and documentation suggestions to ASG’s product management team
at http://www.asg.com/asp/emailproductsuggestions.asp.

If you do not have access to the web, FAX your suggestions to product management at
(239) 263-3692. Please include your name, company, work phone, e-mail ID, and the
name of the ASG product you are using. For documentation suggestions include the
publication number located on the publication’s front cover.
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Introduction

This chapter gives an overview of Recap, its interfaces, and operating system, and
contains these sections:

Section Page

Introduction 1
Recap Overview 2
Application Definition and Analysis 2
User Interface 4
Interfaces 4
Operating Systems S
Printers S
COBOL Compiler Support 5
Preprocessor Support 5

Introduction

Recap is the portfolio analysis component of ESW used to evaluate COBOL applications.
Recap reports provide this information:

. Function point analysis and metrics information
. Program quality assessments
. Intra-application and inter-application comparisons and summaries

. Historical reporting of function point and metrics information
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Recap Overview

Recap provides IT professionals with an automated tool to conduct a portfolio analysis of
every application in their environment. Using industry-accepted measures, Recap
analyzes an application and provides:

. Metrics data

. Function point analysis

. Program quality assessments

. Intra-application and inter-application comparisons and summaries

. The ability to track the impact of process improvements and specific program

changes and enhancements

Recap provides an Import Facility that allows you to import an application definition
generated using another ESW product.

Review information generated from a portfolio analysis from easy to read reports
produced directly from the mainframe component of Recap, or export the analysis
information into a CDF format that can be downloaded to your PC for use in spreadsheet,
database, and presentation packages. In these various formats, Recap analysis data can
support these management activities:

. Feasibility, selection, and cost benefit of redevelopment/re-engineering projects
. Allocation and justification of resources
. Scheduling of new software development projects

. Scheduling of software maintenance and enhancement

Application Definition and Analysis

You prepare an application for analysis by defining the COBOL, Load, Module, JCL,
CICS, and IMS libraries and members and the library and member attributes in Recap.
Attributes include copy libraries, procedure libraries, maclibs, and compile parameters
needed to successfully compile the members in the application. The application definition
is stored in the Application Knowledge Repository (AKR). After the application is
defined, it is ready to be submitted for analysis.

In the analysis process, the ESW Application Analytical Engine (AAE) gathers
information about each program in the application, including program relationships,
logic, data, and execution paths. This information is then used to calculate the metrics and
perform the progressive, comparative, and statistical analysis calculations.
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Output from the analyze job is stored in the AKR where it can be retrieved for online
viewing, report generation, export to a database manager, spreadsheet, or presentation

graphics package.

Recap Reports

Recap provides this set of reports used to organize and present portfolio analysis data:

Report Description

Program Reports
. Metrics History
. Comparison

. Progress

Program reports present portfolio analysis data for
specific programs and help track the impact of specific
program changes.

Application Reports

. Function Points
. Definition

. Metrics

. Exceptions

. Comparison

. Progress

Application reports present portfolio analysis data for
specific applications and compare programs within an
application to identify candidates for restructuring or
re-engineering.

Enterprise Reports

. Executive
Summary

. Metrics

. Exceptions

Enterprise reports present portfolio analysis data for all
applications in your AKR. These reports provide an
overview of all applications in the organization and
assist in the development and implementation of a
comprehensive process improvement program.

See "Report Descriptions" on page 81 and "Using Portfolio Analysis Data" on page 47

for more information about report content.
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User Interface

The online component of Recap features Common User Access (CUA) screens, action
bars, pull-downs, and pop-ups designed to provide easy access to all of the product
features.

A screen is a full-width display of information, usually containing a full or shortened
action bar. Recap screens are modeled after TSO/ISPF screens.

An action bar is the line of keywords that displays at the top of a screen. Each keyword
represents actions that may be performed on that screen. To display a pull-down showing
the available actions, move the cursor to the desired keyword and press Enter.

A pull-down is the list of actions that displays when a keyword is selected from the action
bar. On a pull-down, actions followed by an ellipsis (...) display a pop-up when selected.
Actions not followed by an ellipsis activate the associated function when selected.

A pop-up is a window that displays as the result of selecting an action on a pull-down or
pop-up, or as the result of entering certain commands. It is superimposed on your screen
to allow entry of information for the requested action. Enter the desired data or option,
and follow instructions on the pop-up to process the information.

Note:
See online help for more information on the action bar, screens, pull-downs, and pop-ups.

Interfaces

Recap is primarily an interactive online product that allows you to complete these tasks:
. Define and submit applications for analysis

. Display application definitions and analysis data

. Select and generate portfolio analysis reports

. Set up and maintain the AKR.

Reports can be selected and generated at the same time as the analyze is submitted or at a

later date. Recap also contains an export facility to export portfolio analysis data to
database managers, spreadsheets, or presentation graphics packages.
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Operating Systems

Recap runs under MVS and uses ISPF (Version 3.5 through 4.8) as its standard online
user interface.

Printers

Recap supports most printers using a standard character set. Program parameters allow
the use of alternate characters where required. See "Report Options" on page 217 for
more information.

COBOL Compiler Support

Recap supports these versions of COBOL compilers:

COBOL/370

COBOL II (including releases 3 and 4)
ANSI COBOL

CASE Generated COBOL

COBOL for MVS and VM

COBOL for OS/390

Preprocessor Support

Recap supports these preprocessor languages directly:

Note:

Command-Level CICS
Command-Level DL/I
IDMS

SQL

Other preprocessed languages are not recognized, but can be supported from the
generated COBOL code.
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Concepts

This chapter discusses the concepts and terms related to the operation of Recap and
contains these sections:

Application Knowledge Repository (AKR) 7
Application Portfolio Analysis 8
Function Points 8
Metrics 18
Statistical Terms 21

Application Knowledge Repository (AKR)

The Application Knowledge Repository (AKR) is a BDAM or VSAM file organization.
Various utilities are provided to allocate and maintain the AKR. Multiple AKRs may be
allocated.

When an application is analyzed by the Application Analyzer, the resulting portfolio
analysis information is stored in the AKR. Recap uses that information to generate the
portfolio analysis reports.

Note:
For more information about the structure of the AKR, or maintaining the AKR, see
"Batch AKR Utilities" on page 186. For more information about the Application
Analyzer, see the ASG-Application Definition and Analysis User’s Guide.
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Application Portfolio Analysis

Application portfolio analysis information is used to assess the quantity and quality of
software development products. This information can then be used to develop process
improvement initiatives or to track the impact of program changes and enhancements.
Recap automates the portfolio analysis process and provides this information:

. Function point analysis

. Program exceptions

. Software quality and complexity metrics

. Metrics history

. Comparative analysis statistics

. Progress analysis statistics

This information is presented in enterprise, application, and program level reports. For

example, at the Enterprise level the Enterprise Metrics report provides a summary of
metrics information for the applications within the enterprise.

Function Points

A function point measures the external economic value of a software application.
Function points measure the size of an application from your point of view; that is, from
the logical view, not the physical. The more functionality an application provides, the
higher its function point count, and therefore, the greater its value to the organization.

The advantage of using function points is that they are not dependent on the language or
technical environment for an application; they rely solely on the functionality provided to
you and the complexity of the application or program being measured. Function points
can also be used as the basis for other metrics, including these:

. Productivity (e.g., Function Points / Work Effort)
. Quality (e.g., Number of Defects / Function Points)
. Financial metrics (e.g., Project Cost / Function Points)

Note:

The function point analysis process used in Recap is based on the standards established
by the International Function Point User's Group (IFPUG). These standards are described
in the IFPUG Function Point Counting Practices Manual.
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Function Point Counting

Function Point Counting is the process used to calculate the function point value for an
application. This section describes the information required for Recap analysis and the
IFPUG Function Point Counting process that is the basis for the function point analysis
performed by Recap.

Note:

il

See "Building and Analyzing an Application" on page 23 and "Viewing and Editing
Function Point Data" on page 69 for details on using Recap to count function points.

Information Needed for Function Point Analysis

To populate the AKR with accurate data, certain application components must be
included in the application definition and analyzed. For correct analysis, the code
exceptions and metrics need COBOL source. The function point and enhanced function
point metric needs COBOL source and these components:

Component Purpose

Job Execution Relates the PROGRAM-ID, from the COBOL source, to a CSECT
Load Modules  in a load module. The load module name is related to the program
executed in the JCL or the transaction executed in CICS or IMS.

JCL Determines EIF/ILF, EI, and EOs. It also allows Recap to recognize
temporary work files and eliminate possible duplicate ILFs and
EIFs.

CICS FCT tables Relates the FCT DD name to the COBOL program EXEC CICS I/O
statement dataset. The FCT helps Recap determine whether the FD
in the program should be an EIF, ILF, or transaction. If your site
retains FCT information in a CSD file rather than the FCT tables,
the CSD file must be included.

CICS BMS Map Counts DETs based on how many fields are inputs/outputs to the
map.

IMS PSBGEN  Determines whether a segment is an EIF or ILF. The PSBGEN PSB
is related to the PSB referenced in the IMS statement found in
COBOL source. The segment is also used to count DETs. The IMS
Stage 1 definition contains transactions and their associated load
module names. The IMS/DC load module name is usually the same
as the PSB name. Therefore, this name also relates to the PSB
referenced in the IMS statement.
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Establishing the Boundaries of the Application

Before function point counting can begin, the scope of the application must be clearly
defined to identify components that are internal to the application and those that are

external.

Using an external specification or another appropriate document (such as a system flow
chart), a boundary can be drawn that defines the application.

Counting Function Point Types

10

After establishing the application boundaries, the application components are assigned
one of these five function point element types:

Function Point

Element Type

Internal Logical File (ILF)

Description

Logical group of data maintained and utilized by the
application. For example, application data (such as
personnel information in a payroll application) usually
corresponds to at least one ILF.

External Interface File
(EIF)

Logical group of data that is utilized by the application,
but maintained by another application.

External Input (EI)

Components that maintain (add, change, or delete) data
on an ILF. For example, if a screen within the application
contains actions that add, change, and delete information,
the screen counts for three External Inputs.

External Output (EO)

Process that sends data or controls information outside
the application boundary. For example, reports generated
by the application and data formatted and processed for
use by another application.

External Inquiry (EQ)

Functionality provided for queries of ILFs and EIFs.

For a more thorough description of the five function point element types, see the [FPUG
Function Point Counting Practices Manual. Included in that manual are definitions,
methods of identifying, and examples of each type.
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How Recap Classifies Function Point Element Types

This table shows the entities classified as function point types and indicates which
function point type each entity could be.

Entity El EO EQ ILF EIF
Files (batch) X X X X X
CICS files X X X X X
IMS segments X X
DB2 tables X X
IDMS records X X
CICS maps X X X

IDMS maps X X X

IMS formats X X X

IMS segments, DB2 tables, and IDMS records are classified according to their CRUD
information. If there is Read only information, they are classified as EIFs. If there is at
least Create, Update, or Delete information, they are classified as ILFs.

Batch files and CICS files with Read only information could be either Els or EIFs.

Batch files and CICS files with at least Create with the Read, Update, or Delete become
candidate ILFs. These candidate ILFs become either iteration files, extract files, or real

ILFs. Iteration files are temporary files that gather information before they are saved in

real ILFs. Extract files are temporary files used to generate reports.

Backward and forward tracing of all fields movements to the closest entities determines
the final function point type classification of the entities. Backward tracing is useful for
Create (Write) only entities that are likely to be EOs or EQs. Backward trace results of a
field show the source fields and whether the field was involved in a calculation.
Backward trace results also indicate what entities move to the EOs and EQs.

Forward tracing is useful for Read only entities that could be Els or EIFs. Forward trace
results of a field show destination fields and comparison fields and indicate the entities
that the Els and EIFs move to and what entities they are compared to.

The most dense candidate ILFs become real ILFs. The most dense ILFs contain more
unique fields than iteration or extract files. Other candidate ILFs that move to real ILFs
become iteration files. In the same manner, candidate ILFs that are from real ILFs
become extract files.

11
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Closure of iteration/extract files is done. The closure links the input of the
iteration/extract files to the corresponding output.

Any read only files, maps, or formats with fields in real ILFs become Els.

Any create (Write) only files, maps, or formats containing fields from real ILFs or EIFs
become EOs (field contains a calculation) or EQs (field does not contain a calculation).
An EIF is then identified if its fields are referred to by an EO or EQ. The constraint that
EIFs are Read only is maintained.

More EIFs can be identified based on Els. An EIF might be compared with an El to do a
validation process of the EI before it updates ILFs. Consequently, read only files that are
compared with Els are EIFs.

Determining Functional Complexity

12

When components are classified as function point element types, each component is
assigned a functional complexity of Low, Average, or High. For ILFs and EIFs,
functional complexity is based upon the number of associated Record Element Types
(RETs) and Data Element Types (DETs). The functional complexity of an EI, EO, and
EQ is based on the number of File Types Referenced (FTRs) and DETs. This is a
description of the three factors influencing functional complexity:

. RETs are logical subsets (based on your point of view) of ILFs and EIFs. For
example, if the application being measured contains an ILF that is comprised of
customer and product information, that ILF would have two RETs. ILFs and EIFs
that cannot be broken down are considered to have one RET.

. DETs are user recognizable, non-recurring fields residing in an ILFs or EIFs and
used by an EI, EO, or EQ.

. An FTR is counted for each ILF maintained (for an EI only) or each EIF or ILF
referenced during the processing of an EI, EO, or EQ.

For more detailed information on RETs, DETs, and FTRs, see the IFPUG Function Point
Counting Practices Manual.
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To determine the functional complexity of each component, use the appropriate
complexity matrix. Each function point element type has a distinct complexity matrix.
Figure 6 shows an example of the ILF Complexity Matrix.

Figure 6 * Internal Logical File Complexity Matrix

Internal Logical File (ILF) Complexity Matrix

1l to 19 Z0 to 50 51 or more
DET DET DET
1
RET L L i
2 to 5
RET L s H
6 or more
RET i H H

= Becord Element Type
DET = Data Element Type

Lomr
Lyerage
High

Functional Complexity: L
i
H

For example, assume that in the application being counted, eight ILFs are identified. This
chart displays the complexity ratings for each of these ILFs, given the number of RET
and DETs.

Complexity Ratings for Sample ILFs

ILF # 1 2 3 4 5 6 7 8
# of RET 1 3 1 6 4 1 2 2
# of DET 15 30 58 37 60 24 18 28
Complexity Rating L A A H H L L A

The functional complexity for each identified occurrence of the other four function point
element types is determined in a similar manner.

For more information on the Complexity Matrices and determining functional
complexity, see the IFPUG Function Point Counting Practices Manual.

13
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Computing the Unadjusted Function Point Value

14

Each complexity rating for a function point element type has an associated unadjusted
function point value. For example, this table shows the unadjusted function point values
for the Internal Logical File function type.

Functional Complexity Rating Unadjusted Function Points

Low 7

Average 10

High 15
Note:

Unadjusted function point values are different for each function point element type. For
example, the unadjusted function point values for the EIF element type are 5 (for Low), 7
(for Average), and 10 (for High). Likewise, different unadjusted function point values
exist for Els, EOs, and EQs.

To compute the unadjusted function point value for a function point element type,
multiply the complexity rating's unadjusted function point value by its number of
occurrences.

In the earlier example, the application being measured contained 3 Low ILFs, 3 Average
ILFs, and 2 High ILFs. Therefore, the ILF contribution towards the application's
unadjusted function point value is calculated as:

# of Low ILFs * Unadjusted Function Point value for Low) +
# of Avg ILFs * Unadjusted Function Point value for Average) +
# of High ILFs * Unadjusted Function Point value for High)

Or

(3 7)) + (3 * 10) + (2 * 15) = 81

The unadjusted function point total for each of the remaining function point element
types (EIF, EI, EO, and EQ) is calculated in the same manner. After calculating the
unadjusted function points for the five element types, the numbers are added to obtain the
Unadjusted Function Points for the application.

For more information on calculating Unadjusted Function Points, see the IFPUG
Function Point Counting Practices Manual.
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Computing the Value Adjustment Factor (VAF)

The Unadjusted Function Points reflect the functionality and value of the application
from your perspective. However, other factors that are often transparent to users also
need to be considered to accurately assess the value, quantity, and size of an application.
For example, the complexity of the application can be dependent on environmental,
physical, or logistical problems that may be encountered while implementing, operating,
or maintaining the application. IFPUG has established a set of 14 General System
Characteristics (GSC) to further assess the general functionality and complexity of an
application.

These are the General System Characteristics, defined by IFPUG:

. Data communication

. Distributed processing

. Performance

. Heavily used configuration

. Transaction rates

. Online data entry

. End user efficiency

. Online update

. Complex processing

. Reusability

. Installation ease

. Operational ease

. Multiple sites

. Facilitate change

Note:
See the "Glossary" on page 237 for a definition of each General System Characteristic.
For more information on specifying the General Systems Characteristics in Recap, see
"Computing the Function Point Value Adjustment Factor" on page 41.

15
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Each GSC is evaluated on a scale of 0 to 5 in terms of its degree of influence (DI) on the
application. The degree of influence assigned to each characteristic is based on this scale:

0 = Not present or no influence
1 = Incidental influence

2 = Moderate influence

3 = Average influence

4 = Significant influence

5 = Strong influence throughout

For example, if the application is entirely batch, a degree of influence of 0 is assigned to
Online data entry. However, if over half of the transactions are interactive data entry, a
degree of influence of 5 is appropriate.

IFPUG has guidelines for scoring the degrees of influence for each GSC. See the IFPUG
Function Point Counting Practices Manual for details.

To compute the Value Adjustment Factor

1 Add the 14 degrees of influence together to arrive at the Total Degrees of Influence
(TDI).

2  Use this industry accepted algorithm to compute the Value Adjustment Factor
(VAF) to determine the influence of the GSCs on the application:

VAF = (TDI * .01) + .65

In this equation, these two constants are used: .01 and .65. The first constant, .01, is
used to express the VAF in terms of percentages; the second, .65, is a preliminary
adjusting factor.

Computing the Adjusted Function Point Value

16

The Adjusted Function Point value is calculated as:

VAF * Unadjusted Function Point Value (for the application)
When applied, the VAF adjusts the Function Point total any where between a positive
35% or a negative 35%. If all 14 GSCs are given a value of 5, the function point total is

increased by 35%; if all are given a value of 0, the function point total is reduced by 35%.

In Recap, the Adjusted Function Point Value is calculated when the application is
submitted for analysis.
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Computing the Enhancement Function Point Count

The Enhancement Function Point count measures the modifications to an existing
application that add, change, or delete user function within the scope of the project. This
measurement can be used to calculate the effort required to enhance an application. In
Recap, this value is calculated during application analysis.
In contrast to the Adjusted Function Point value that quantifies the functionality of the
application in its present state, the Enhancement Function Point value quantifies the net
change in functionality since the application was last analyzed.
The Enhancement Function Point value is calculated using this formula:

EFP = (ADD + CHGA) * VAFA + DEL * VAFB
where:

EFPis the Enhancement Function Point count.

ADD is the Unadjusted Function Point count of functions added in the enhancement
project.

CHGA is the Unadjusted Function Point count of functions modified by the
enhancement project.

DEL is the Unadjusted Function Point count of those function that were deleted by
the enhancement project.

VAFA is the Value Adjustment Factor of the application after the enhancement
project.

VAFB is the Value Adjustment Factor of the application before the enhancement
project.

17
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Metrics

Software metrics provide information about complexity, program architecture, and
software quality that indicate the condition or state of applications. This information can
then be used to perform these tasks:

. Predicting the amount of effort necessary to maintain an application
. Identifying in-house applications in need of improvement
. Measuring performance degradation/improvement

. Helping to establish quality standards, with particular emphasis on continuous
improvement

. Assisting in evaluating vendor software applications

Recap calculates software metrics that measure the level of complexity, size, and
structure in a program and application. These metrics are stored in the AKR containing
the application. Recap reports that present the metrics results at the enterprise,
application, and program level are also available.

Cyclomatic Complexity

18

Cyclomatic Complexity is a measure of the complexity and the ability to understand and
maintain an application or a program. The Cyclomatic Complexity metric measures the
number of logic paths in a program. This metric is based on the premise that the number
of paths in a program determines how difficult it is to understand. As a general rule, a
value of 10 is desirable for a module.

For example, the sample code block shown in Figure 7 contains three logic paths;
therefore, the Cyclomatic Complexity for the code block is 3. (This is a simplification of
the Cyclomatic Complexity calculation.)

Figure 7 « Sample Code for Cyclomatic Complexity

1 ATART
IF WAR-L < CONSTANT1 THEN...
IF WAR-E < CON3ITLNTZ
THEM. ..
Do ..
EL3E
Do ..
ENDIF
ENDIF
ITOP
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Control Variable Complexity

Like the Cyclomatic Complexity, the Control Variable Complexity metric is also a
measure of the complexity and the ability to understand and maintain a program. This
metric measures the number of logic paths and the number of control variables in a
program. This metric is based on the premise that programs with equal flow paths, but
more variables controlling the flow, are more difficult to understand and maintain than
programs with fewer control variables.

For example, the code block in 3 contains three logic paths. In addition, there are two
control variables: VAR-A and VAR-B. Adding the logic paths (3) to the number of
control variables (2) yields the Control Variable Complexity for the sample code (5).
(This is a simplification of the Control Variable Complexity calculation.)

Software Science Volume

The Software Science Volume metric measures the size of a program. This metric factors
in data and variables (i.e., operands) and COBOL verbs (i.e., operators). This metric is
based on the premise that the larger the application or program, the more difficult it is to
understand and maintain.
Use this formula to calculate the Software Science Volume metric:

V = (N1 + N2) * log, (nl + n2)
where:

V equals the Software Science Volume.

N1 equals the total number of operators in the program.

N2 equals the total number of operands in the program.

n1 equals the number of distinct operators in the program.

n2 equals the number of distinct operands in the program.

Essential Complexity

Essential Complexity measures how well a program is logically structured. The Essential
Complexity metric measures the number of GO TOs that are not GO TO exits. This
metric is based on the premise that the higher the number of GO TOs that are not GO TO
exits, the more unstructured the program. A value of 1 indicates that a program is
perfectly structured. (This is a simplification of the Essential Complexity calculation.)
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For example, the sample code block shown in Figure 8 contains four GO TOs, none of
which represent a GO TO exit; therefore, the Essential Complexity for the code block is
4.

Figure 8 « Sample Code for Essential Complexity

PARAGELPH-A.
IF ViaR-4 < CON3STANTL THEHN
GO0 TO PARAGRAPH-C
EL3E
0 TO PARAGRAPH-E
ENDIF.
PARLGRAPH-E.

G0 TO PARAGRAPH-D.
PARLGRAPH-C.
IF VAR-B > CON3TANTZ
THEN
G0 TO PARALGRLPH-E
EL3E
HEXT 3ENTENCE
ENDIF.
PARLGRAPH-DI.

PARLGRAPH-E.

Knots Count

The Knots Count metric measures how well a program is physically structured. Each
control path is marked with a line (e.g., from an IF to its ENDIF, or from a GOTO to its
destination); the intersections of the control paths are the knots. For example, in Figure 9,
there are seven intersections, or knots, of the control paths.

Figure 9 ¢ Illustration of Knots Count

PARAGRAPH-A.
+- IF WAR-4 < CONITANT1 THEN

o G0 TO PARAGRAPH-C
o ELSE
o o GO TO PARLGRAPH-E
' 4+— ENDIF.
'+ PARAGRAPH-E.
4+——++--— GO TO PARALGRAPH-D.

++ PALARAGRAFH-C.
. +— IF WAR-B > CON3ITANTZ THEN

i

I

I

I

I

I 1

o

| | 4+-—+-—-- GO TO PARAGRAPH-E
Lo | ELSE

Lo ! NEXT SENTENCE
Lo +- ENDIF.

| +--— FPARAGRAFH-D.

I

I

I

i .

Hmm e PARAGRAPH-E.

A knot count of 0 is desirable. A high knot count indicates a program control flow path
that is too complex, which may be difficult to understand and to maintain.

20



2 Concepts

Statistical Terms

Recap uses these statistical terms in reporting portfolio analysis information:

Average. Recap calculates the average for function point and metrics values. The
average is calculated using this formula:

Db S
n

where:
x _1s the average.

x 18 a metric value.

n is the number of applications or programs for which the average is being
calculated. (Function point values are not calculated at the program level.)

For example, this would be the calculation for the average number of cyclomatic
complexities for an application containing three programs with values of 38, 45, and 50:

+45 +
38445450 _

Standard Deviation. Recap calculates the standard deviation for function point and
metrics values to provide a measurement that shows how these values are clustered or
scattered relative to the average. The Standard Deviation is calculated using this formula:

— | Zex)
S=N=

where:
S is the Standard Deviation.
x is a function point or metric value.

n is the number of programs or applications for which the standard deviation is
being calculated.

For example, this is the calculation for the standard deviation for function points in the
preceding example:

[ ((38-44.3 ) +(45-44.3 +(50-44.3 )
19= :
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Building and Analyzing an Application

This chapter guides you through the procedures used to define an application and
generate function point data, and contains these sections:

FP Task Manager 27
Gathering Information 28
Initiating a Recap Session 29
Verifying User Options 30
Allocating an AKR 36
Creating an Application 39
Defining Application Components and Attributes 41
Computing the Function Point Value Adjustment Factor 41
Analyzing the Application 43
Generating Recap Reports 43
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This table summarizes the procedures described in this chapter. Page references are

provided to access a subject quickly. However, if you are using Recap for the first time,
ASG recommends that you perform the procedures in sequence. The FP Task Manager
screen described in this chapter is used to provide an online view of the status of Recap

tasks.
Task Procedure (Subject Reference)
Gather information for application Review operational job streams.
definition . L .
Interview application experts and review
documentation to locate:
. JCL
. Libraries
. Programs
. IMS and CICS Tables
(See "Gathering Information" on page 28.)
Start Recap Method is site dependent. You usually access

the product from a TSO or ISPF menu. (See
"Initiating a Recap Session" on page 29.)

Verify User Options if this is the first ~ On the Options pull-down select:

time you are using the product.
y gHep . Product Parameters (see "Product

Parameters" on page 30).

. Product Allocations (see "Product
Allocations" on page 31).

. Log/list (see "Log and List File
Parameters" on page 32).

il

. Script File Allocations (see "Script File
Allocations" on page 34).

il

. PF keys (see "PF Key Settings" on
page 35).

Allocate AKR 1 Select File » AKR Utility and press Enter.

2 Type A and press Enter to allocate the
AKR.

(See "Allocating an AKR" on page 36.)

Create the application Select File » New application and press Enter.

(See "Creating an Application" on page 39.)
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Task Procedure (Subject Reference)

Define application components and On the Edit pull-down select:
attributes . COBOL definition
. Load module definition
. JCL definition
. CICS definition
. IMS definition

For detailed information about defining
application components and attributes, see the
ASG-Application Definition and Analysis
User’s Guide.

Review the Application Definition Select View P Current application definition
and press Enter.

For detailed information about application
definition, see the ASG-Application
Definition and Analysis User’s Guide.

Modify the application definition as Use the action on the Edit pull-down to
needed modify the application definition.

Compute Value Adjustment Factor for 1 Select Edit PFunction points and press
Function Point counting Enter.

2 Select Edit GSC and press Enter.

(See "Computing the Function Point Value
Adjustment Factor" on page 41.)

Analyze the application Select File » Analyze and press Enter.

For detailed information about application
analysis, see the ASG-Application Definition
and Analysis User’s Guide.
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Task Procedure (Subject Reference)

Review the analyze results and resubmit  *® Review the Analyze Summary Report
members for analysis if necessary. in output DD VIAARPT.

. Correct problems that caused a return
code of 8 or higher during the analyze.

. Identify discovered components:
1 Select File » Open application and
press Enter.

2 Select Edit » Discovered
Components and press Enter.

. For resolvable discovered components,
add to the application definition if
needed.

. For unresolvable discovered
components, update the application
definition as needed.

. Review Missing and Dead
Components:
1 Select View P Missing Components
and press Enter.

2 Select View » Dead Components
and press Enter.

. Use the actions on the Edit pull-down
to modify the application definition.

For detailed information about reviewing
analysis results, see the ASG-Application
Definition and Analysis User’s Guide.

Repeat the analyze, review, and refine  Use the File pull-down to analyze, and use the
as needed. Edit and View pull-downs to review and
refine as needed.
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FP Task Manager

The FP Task Manager screen, shown in Figure 10, serves as an online checklist to keep
you informed of the status of the application definition, analyze, function point editing,
and report tasks.

To display the Function Point Task Manager screen, follow this step:

» Select View P FP Task Manager from the Recap Primary screen and press Enter.

Figure 10 » Function Point Task Manager Screen

File Options Help

FP Task Manager JCLTEST
Command ===> _ Scroll ===> CSR
AKR : 'VIARAP.TEST.AKR’ 1 OF 13

Cmd : B(Bypass); S(Select Task); E[Explain/Help];
Task Description Status

1 Edit Application Definition

2 Analyze Application

3 Apply Previous Function Type Edit

4 Preview Previous Function Type Edit that cannot be applied
5 Edit External Input

6 Edit External Output

7 Edit External Inquiry

8 Edit Internal Logical File

9 Edit External Interface File

10 Edit General System Characteristics
11 Preview Adjusted FP

12 Preview Enhancement FP

13 Generate Reports

You can also access the screens and pop-ups related to these tasks from this screen.
To select a task, follow this step:

» Type S in the line command field next to the task you want to complete. When the task
is completed, the status field for that task displays Completed.

To bypass a task, follow this step:
» Type B in the line command field for that task.
If a task does not need to be completed, N/A displays in the Status field.

Some tasks may require the completion of previous tasks. If the previous tasks have not
been completed, a warning message displays altering you to complete the previous tasks.
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Gathering Information

Start the application definition process by gathering the information discussed in this
section. You may be able to obtain much of this information by reviewing the compile
JCL that is used most frequently in the application. Record this information on the
Application Inventory Worksheets provided for you in the ASG-Application Definition
and Analysis User’s Guide. This information is required:

. The Application Knowledge Repository (AKR) where the application resides. You
may need the AKR's volume serial number (if the AKR is not cataloged) or its
password (if the AKR is password protected).

. The name of the application and a description. All applications defined to Recap
must be named; you also have the option to further describe the application by
providing a 40 character application description.

. The COBOL, Load Module, JCL, CICS, and IMS source libraries that contain
programs or members to be defined to the application. For each source library, you
need to know:

— Its source manager (for example, PDS, CA-Panvalet, or CA-Librarian).

—  Members that are to be defined to the application (referred to as selected
members). If you need to include many members, you can select members from
the member list available in Recap while you are defining the application.

—  For each COBOL library:

—  The copy libraries used by the majority of members included in the
application definition.

—  Compile JCL dataset and member used for compiling the library's
programs.

—  Whether DB2 or IDMS calls are used when executing the library's
selected programs.

—  The procedure libraries used by the majority of members to be included in the
application definition for each JCL library.

—  Themaclibs used by the majority of the members to be included in the definition
for each CICS or IMS library that uses included source or macros.

. Gather the attribute information for each member within a library that requires
attributes (analysis parameters, copy libraries, procedure libraries, maclibs, or
IDMS information) different from those specified for the library.

After the necessary information is gathered, you are ready to initiate your Recap session.

28



3 Building and Analyzing an Application

Initiating a Recap Session

The method used to invoke Recap depends on your system setup. If you require
assistance to invoke Recap, contact your System Administrator.

To initiate a Recap session, follow this step:

» Choose one of these methods:

. If your site uses the ESW screen to start Recap. Initiate the ESW screen by
using the ISPF selection or CLIST as indicated by your Systems
Administrator.

. Select Measure » Portfolio from the ASG-ESW Primary screen and press
Enter to display the ASG-ESW Portfolio Analysis screen, shown in Figure 11.

. If your site starts Recap directly, use the ISPF selection or CLIST as indicated
by your Systems Administrator. After you activate the session, the
ASG-ESW - Portfolio Analysis Primary Screen displays.

Figure 11 » Recap Primary Screen

File Edit Wiew Facility Options Help

ASG-ESW - Portfolio Analysis

Command ===r _
koo dokskhk skekskskskek sk skokok
sk skokok sk ekl stk ok
koo koo sk skl bk
sk skokok sk skokok bk okl ook
ok kok
EEEEEY

Copyright Allen Systems Group, Inc., an unpublished worl,
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com

Note:
The title on the screen is ASG-Recap Rx.x if the product is started without going through
the ESW Primary Screen.

During installation, Recap options have been customized for your site. If you are using
Recap for the first time, you may want to perform the procedures in "Verifying User
Options" on page 30 to verify that the Recap installation defaults reflect the appropriate
settings for your needs.
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Verifying User Options

During Recap installation, options that define the operating environment for Recap are
set to default values. The first time you use Recap, you should verify that these default

options reflect the appropriate settings for your environment. This section describes these
user options:

. "Product Allocations" on page 31

. "Log and List File Parameters" on page 32
. "Script File Allocations" on page 34

. "PF Key Settings" on page 35

Product Parameters

30

Use the Options - Product Parameters pop-up, shown in Figure 12, to specify alarm and
confirmation settings.

To verify or change product parameter information

1 Select Options P Product parameters from the Recap Primary screen and press Enter
to display the Options - Product Parameters pop-up.

Figure 12 « Options - Product Parameters Pop-up

Options - Product Parameters

Specify parameter information.

Alarm . . . « « . YES (YessfMWo)
Confirm Submit . . NO {Yes/Mo Confirmation displayed before Submit)
Confirm Delete . . ¥ES (YessWo Confirmation displaued bhefore Delete)

ISPF Stats Required YES ({¥essMo If stats required for AMF)

2 Verify that the information on the Options - Product Parameters pop-up conforms to

your needs. Make any desired changes. Field definitions for this pop-up are provided
in online help.

3 Press PF3 to save your changes and exit the pop-up.
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Product Allocations
Use the Options - Product Allocations pop-up, shown in Figure 13, to verify or change

the product allocations used to specify DASD information for the Log, List, and Work
files.

To verify Recap product allocation settings

1 Select Options P Product allocations from the Recap Primary screen and press Enter
to display the Options - Production Allocations pop-up.

Figure 13 » Options - Product Allocations Pop-up

Options — Product Allocations
Zpecify allocation information.
Log File:
Generic unit . . . SRTDA {Generic group name or unit address)
Y¥olume serial . . SRTEO1 {Blank for authorized default volume)
List File:
Generic unit . . . {Generic group name or unit address)
¥olume serial . . SRTEOL {Blank for authorized default volume)
Work File:
Generic unit . . . SYSDA {Generic group name or unit address)
Wolume serial . . (Blank for authorized default wvolume)
Space units . . . CYLS {BLKS, TRKZ or CY¥LS)
Primary space . . B50@ {Space units)
Secondary space oi@ [Space units)
Alternate node . . {Alternate high lewel node}

2 Verify that the allocation information is correct for your site. Make any desired
changes. Field definitions for this pop-up are provided in online help.

3 Press PF3 to save your changes and exit the pop-up.
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Log and List File Parameters

Use the Options - Log/List Definition pop-up, shown in Figure 14, to verify or change the
settings for processing the Log and List files. Also use this pop-up to customize the
dataset names and to specify print or delete options.

1 Select Options » Log/list from the Recap Primary screen and press Enter to display
the Options - Log/List Definition pop-up.

Figure 14 » Options - Log/List Definition Pop-up

Opkions - LopdList Definikion
Command ===}

1 - Process log File 2 - Process list file 3 - Custonized data seb nane

Qptions Log List
Process option . . . . . . PK K,
Prinary tracks I | 1
Jecandary tracks e 2 3
Lihes per pagde . . . . . . 5B Sk
Jysout class o 0 0 0 0w . # *

Process options: PE [printskeep), PD (printrdelete), K, or D.

Job statement information:
A THAHE JOB CACCOUNT 1,MAKE,

£ HEGCLASS=A
e THSERT ‘/+ROUTE PHINT MODE.USER' HEAE 1F MEEDED.
fI®

2 Verify that the allocation and disposition choices conform to your site standards.
Make any necessary changes. Field definitions for this pop-up are provided in online
help.

3  Ifrequired for printing the Log or List file, enter the appropriate information in the
Job statement information field.

4  Press PF3 to save your changes and exit the pop-up.

Note:

The Log file is only allocated if an internal error is encountered, such as an abend. It
contains ESW error messages that can facilitate the debugging process. The List file
contains printed output and is allocated when a request to print is issued.
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Customizing the Log or List Dataset Name

If you specify the K or PK process option, you can customize the dataset where the Log or
List file is allocated. By default, Recap allocates the Log and List files as:

USERID.XEMnnnnn . VIAXXXXX

where nnnnn is a sequential number from 00001 to 99999 and xxxxx is LOG for Log
and LIST for List files.

If you have specified a TSO Prefix, the prefix will be appended to the beginning of the
file name allocated for the Log and List files.

To customize the Log or List dataset name

1 From the Options - Log/List Definition pop-up, type 3 and press Enter to display the
Options - Log/List/Punch Name Customization pop-up, as shown in Figure 15.

Figure 15 « Options - Log/List/Punch Name Customization Pop-up

Options - Log-List NaWe CustoMization
ComHand ===

You can define a CUStoMiZed nade when you choose option PE (print-kesp) ok
K [keepl by specifwing Ul=serl. Specifwing Y(es] on ProWpt later lets wou
define a custoH naWe as wou process each log-list file. Otherwize,
specify data set name and file Hode. Then press Enter.

options Loy List

File Maning « = « = « &« » s s Ui=ser] or s(wsten)
Prodpt later for DEW Yles] aor Hlao]

— -

The following are neaded if Ulser] and Hlo)] are specified above

Log Data set nane [Eeq]
File Hode . . _ ofverwrite]l or Alppend]

List Data set name [=eq]
File Hode . . _ ofvervritel or Alppend]

2 Type U in the File Naming field for Log or List to indicate a user-defined dataset
name.

If you specify N in the Prompt later for DSN field, you must enter a dataset name in

the corresponding Data set name field, and specify Overwrite or Append in the File
Mode field.
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If you specify Y in the Prompt later for DSN field, Recap prompts you for the dataset
name during file processing.

Script File Allocations

34

When Recap is installed, default script files are specified for the site. Use the
Options -Script File Allocations pop-up, shown in Figure 16, to display or change the
default dataset names or the concatenation sequence for your session.

To review or change script file dataset names

1 Select Options P Script file allocations from the Recap Primary screen and press
Enter to display the Options -Script File Allocations pop-up.

Figure 16 » Options - Script File Allocations Pop-up

Options - Script File Allocations
Command ===

R - Restore default Script allocations
Enter desired Script file concatenation.

Script file data set names:

2 Review the current default script file dataset names (when initializing for defaults,
the lines are filled from the bottom to allow concatenation). Field definitions for this
pop-up are provided in online help.

3  To make a change, enter the dataset names for the new script files in the Script file
dataset names field. The files are concatenated in the order entered.

4  To restore the default, type R at the Command prompt.

5  Press PF3 to save your changes and exit the pop-up.
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PF Key Settings

Use the Options - PF Key Definition pop-up, shown in Figure 17, to verify or change
current PF key assignments.

To verify or change PF key assignments

1 Select Options » PF keys from the Recap Primary screen and press Enter to display
the Options - PF Key Definition pop-up. The current PF Key settings display.

Figure 17 » Options - PF Key Definition Pop-up

Options - PF Key (@1-12) Definition
Cammand ===>

Press Enter to process changes andfor to display alternate keys.
Press PF3/15 (EWD) to exit.

Mumber of PF keys: 12 Terminal type: 3278

PFO1 HELP
PFOZ SPLIT
PFO3 END
PFE4 RETURN
PFAS RFIND
PFOE RCHANGE
PFOT UP
PFES DOWN
PFOS SWAP
PF10 LEFT
PF11 RIGHT
PF12 CANCEL

2 To change the function of a PF Key, type over its current setting. If the PF Keys are
not set to their default values, as shown in Figure 17, change them now. Field
definitions for this pop-up are provided in online help.

3 Press PF3 to save your changes and exit the pop-up.
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Allocating an AKR

36

A Recap AKR should be established for each of the major business units (e.g.,
Accounting) in your company. Each AKR can contain multiple applications. If an AKR
has not been allocated, use the File - AKR Utility pop-up, shown in Figure 18, to allocate
one. You can allocate as many AKRs as desired.

Note:

For information on the expected size of the AKR and analyze work files, see the
ASG-Application Definition and Analysis User’s Guide.

To allocate an AKR

1 Select File » AKR utility from the Recap Primary screen and press Enter to display
the File - AKR Utility pop-up.

Figure 18 « File - AKR Utility Pop-up

ASG-ESW - AKR Utility
Command ===%

Blank - Display member list I - Delete member
A - Allocatesexpand AKR R - Rename member

Application Knowledge Repository (AKR):

Data set name . . ‘USER.TEST,.AKR’

Hember . . . . . (if "R" or "D" selected)
Hew name . . . . (if "R" selected}

Yolume serial . . (if not cataloged)
Password . . . . {if password protected)

2 Enter this information:
a  Enter the name of the AKR to be allocated in the Data set name field. If the
high level qualifier is different than your user ID, enter the name in single
quotes ().

b  Type A in the command input area.

¢ Ifthe AKR is not cataloged, enter the serial number of the volume where the
AKR will reside in the Volume serial field.



3 Building and Analyzing an Application

d  To password protect the AKR, enter the password in the Password field.

e  Press Enter to display the File - AKR Allocate/Expand pop-up, shown in
Figure 19.

Figure 19 » File - AKR Allocate/Expand Pop-up with SMS and a VSAM AKR

File - AKR Allocate~Expand

Command ===k
S - Submit JCL E - Edit JCL C - Specify Catalog
Expand existing RKR . . . HO [ fes or Mol
AKR data set hame . . . . 'USER.TEST.AKR’
Volume & . 0 0 0 0 0 e o
1 = [Generic unit name)
Space units . . . . . . RECORDS [Recards, Tracks or Cylinders)
Primary Space « « « & 4000 [(Primary amount in above units)
Secohdary space . . . . TES. [Secondary amount in above units)

Job statement infaormation:
<~LUSER JOB (ACCOUMT ) ,HAME ,
e MEGCLASS=A
ey IMSERT '~#ROUTE PRIWT MODE.USER' HERE IF MEEDED.
e

Note:

The pop-up that displays depends on whether you use BDAM or VSAM AKRs and
if SMS is turned on for your site. Figure 19 assumes SMS with a VSAM AKR

Enter this information:
a Specify NO in the Expand existing AKR field.

b  Ifnecessary, specify a management class for the new AKR in the Management
class field. The default is MGMTCLAS.

¢ Ifnecessary, specify a storage class for the new AKR in the Storage class field.
The default is STORCLAS.

d In the Volume field, enter the volume serial number for the AKR. This field is
required if Storage Class is not specified.

e Ifnecessary, specify a data class for the new AKR in the Data Class field. Data
Class is only valid if SMS is active at your site. The default is DATACLAS.

f In the Space Units field, enter the type of units to allocate. The units must be
records, tracks, or cylinders. After specifying the unit type, enter the amount of

space required in the Space amount field.

g Inthe Unique field, enter NO if the AKR is a VSAM data space.
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h  Specify a valid Jobcard in the Job statement information field.

i If you need to specify a private catalog or a password, type C in the command
input area to display the AKR Catalog Information pop-up and enter the
catalog dataset name and password.

Note:

For more information on the fields in the File - AKR Allocate/Expand pop-up, see
online help.

Submit the JCL to allocate the AKR using one of these methods:

Method 1:

a  Type S in the command input area.

b  Press Enter.

Method 2:

a  Edit the JCL by typing E in the command input area and pressing Enter.

b  Make the appropriate modifications and issue the standard TSO ISPF
SUBMIT command.

¢ Return to the File - AKR Allocate/Expand pop-up by issuing the END
command or pressing PF3.

After the job completes, verify the allocation job by examining the job output. If the
allocation was successful, condition codes of 0 should display in the output.
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Creating an Application

Note:
If you have created an application using a previous release of Recap, you need to convert
the application before using it in the current release of the product. For information on
converting applications, see "Application Conversion" on page 215.

After allocating the AKR, you need to create the application and then specify the libraries
and members to be included in the application. This section describes the steps used to
create the application. See the ASG-Application Definition and Analysis User’s Guide for
information on defining the application.

In Recap, an application is a group of programs that perform a related function. Multiple
applications are grouped together in an AKR that represents a single business unit such as
Accounting. Typical applications within an Accounting AKR would be Accounts

Payable, Accounts Receivable, General Ledger, Fixed Assets, Inventory, and Purchasing.

To create an application

1 Select File » New application from the Recap Primary screen and press Enter to
display the File - New Application pop-up, as shown in Figure 20.

Figure 20 * File - New Application Pop-up

File - New Application
Command ===%

Type AKR information, application name and analyze features.
Then press enter.

Application Knowledge Repository (AKR):

Data set name . . . 'USER,TEST.gKR’

Application name . . ABBEY-TH

Yolume serial . . . (if not cataloged)

Passward . . . . . . (if password protected)
Analyze features {(¥/N):

ASG-Recap HE

ASG-Alliance @ ¥

ASG-Estimate @ ¥
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Enter this information:

a Enter the AKR name in the Data set name field. If the high level qualifier of
the name is different than your user ID, enclose the AKR name in single
quotes ().

b  Enter the Application name. The name can be up to ten (10) characters in
length. For example, if you are defining a General Ledger application within
an Accounting AKR, an appropriate application name is GEN-LEDG.

¢ Ifappropriate, enter a Volume serial or Password. The serial number of the
volume where the AKR resides is required if the dataset is not cataloged; a
password is required if the dataset is password protected.

Note:
If Alliance is installed, enter Y or N in the Features field Alliance option to specify
whether you analyze the application using Alliance. ASG recommends that Recap
and Alliance analysis be performed at the same time to optimize CPU cycles and
DASD usage and avoid duplication of data.

Press Enter to redisplay the Primary screen. You should see a message indicating the
status of the application (e.g., APPLICATION WAS SUCCESSFULLY
CREATED).

Note:
See the online help for more information on the File - New Application pop-up.

To further specify the application, enter a long description (up to 40 characters) to
describe the application's business function. The long description displays on the
Table of Contents.

To enter a long description

1

3

Select Edit P Application description from the Recap Primary screen and press Enter
to display the Edit - Application Description pop-up.

The user ID of the person that created the application displays in the Description
field as the default description. To change the default, type over the existing text.

Press Enter to save the description and return to the Primary screen.

After you successfully create your application, you can define the components and
attributes that the application requires.
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Defining Application Components and Attributes

After an application is created, you must specify the application components. These
include the COBOL, Load Module, JCL, CICS, and IMS libraries and members that you
want to group for impact analysis.

For each library and member included in the definition, you may also need to specify
attributes such as analysis parameters, copy libraries, procedure libraries, macro libraries,
and IDMS information.

For complete information about defining application components and attributes, see the
ASG-Application Definition and Analysis User’s Guide.

Recap also provides an Import Facility to import application definition information from
a file. For information on importing an application definition, see "Import Facility" on

page 153.

Computing the Function Point Value Adjustment Factor

When the application definition is correct, you should compute the function point Value
Adjustment Factor (VAF) before you submit the application for a Recap analysis. The
VAF is calculated from degrees of influence (DIs) assigned to the 14 General System
Characteristics.

To assign DIs and calculate the VAF for an application

1 Select Edit » Function Points from the Recap Primary screen and press Enter to
display the Edit - Function Points pop-up.

2 Select General System Characteristics to initiate the Function Points - General
System Characteristics pop-up, as shown in Figure 21.

Figure 21 » Function Points - General Systems Characteristics Pop-up

Function Points - General Suystem Characteristics

Specify the degree of influence (@ to 5) for each of the system
characteristics. To accept the input press enter.

Data communication . On-line update . . . . . . ]
Distributed processing [} Complex processing . . . . @
Performance . . . + =« - . . [0} Reusability . . . . . . . . ]
Heawily used configuration @ Installation ease . . . . . ]
Transaction rates . . . . . [0} Operational ease . . . . . ]
On-Lline data entry . . . . @ Multiple sites . . . . . . ]
End user efficiency . . . . @ Facilitate change . . . . . ]
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3 On the Function Points - General System Characteristics pop-up, assign the DIs for
each of the 14 GSCs.

4  Press Enter to calculate the Total Degrees of Influence (TDI) and VAF. The values
are placed in the appropriate fields.

If you analyze an application without first assigning DIs to the General System
Characteristics, the Recap job uses default values of zero (0) for each GSC. This yields a
VAF of .65; the result is an Adjusted Function Point value that is 35% less than the
unadjusted amount. This may not be an accurate assessment of the application's
functionality and complexity.

By assigning the DIs before the analyze process, the VAF more accurately reflects those
additional environmental, physical, and logistical problems that may be encountered
while implementing, operating, or maintaining your application. The baseline data that is
generated from the Recap analysis more accurately reflects the application's true business
value.

Note:

An overview of function points, including a discussion of the General Systems
Characteristics, is provided in "Function Points" on page 8.

On the Function Points - General System Characteristics pop-up, if the application was
analyzed, an asterisk displays next to the system characteristic when Recap determines
that the application may contain that characteristic.

This table contains the characteristics found by Recap:

Characteristic Description

Data Communication Communication Section exists in the COBOL source.

Performance CICS, DB2, DL/I, IDMS environments found in the
COBOL source.

Transaction Rate CICS, DB2, DL/I, IDMS environments found in the
COBOL source.

Data Entry CICS environment found in the COBOL source.
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Characteristic Description

Online Update CICS environment found in the COBOL source.

Complex processing  Cyclomatic complexity/Adjusted Function Point > 100 *.

Note:

* The installation option Complex-Process-Threshold
can be used to change the default value of 100. See your
Systems Administrator for details specific to your site.

Analyzing the Application

After defining the application's libraries and members, specifying library and member
attributes, and calculating an accurate VAF, the application can be analyzed to generate
the inventory analysis data, including function points and software metrics. The full suite
of Recap reports cannot be produced until the application is analyzed.

For complete information about analyzing applications, see the ASG-Application
Definition and Analysis User’s Guide.

Generating Recap Reports

After an application is analyzed, you can produce Recap reports. Recap reports provide
progressive, comparative, and statistical analysis data related to function points, software
metrics, and code exceptions at the program, application, and AKR (enterprise) level.

Note:

If you select the Run reports option on the Analyze - Submit Application pop-up, reports
may also be produced during the application analysis.

If you are running Recap reports for the first time, see "Helpful Hints" on page 46 for
some suggestions that may assist you.

Note:
An application must be open for the Report process to be initiated.
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To open a Recap application

1 Select File » Open application from the Recap Primary screen and press Enter to
display the File - Open application pop-up.

2 Enter this information:

a Enter the AKR name in the Data set name field. Enclose the AKR name in
single quotes (') if the high level identifier is different from your user ID.

b  Enter the name of the application in the Application name field.

¢  If appropriate, enter a Volume serial or Password. The serial number of the
volume where the AKR resides is required if the dataset is not cataloged; a
password is required if the dataset is protected. Ask your Systems
Administrator if this information is required for the specified AKR.

3 Press Enter to open the application and redisplay the Primary Recap screen. If the
application was opened, this message displays: APPLICATION [name of
application] SUCCESSFULLY OPENED.

To produce Recap reports

1 Select File P Reports from the Recap Primary screen and press Enter to display the
File - Reports pop-up, shown in Figure 22.

Figure 22 * File - Reports Pop-up

File - Reports APPL-CZR3@
Select desired reports and tupe program name if appropriate.
Then press PF Key for action.
AKR data set name: 'YIADYAP.APPL.AKR'

Print Mazter Index s

Program Reports Application Reports Enterprise Reports
_ Metrics history 4 Function points §  Executive summary
£ Comparison £ Definition £ Metrics
/ Progress £ Metrics #  Exceptiaons

/  Exceptions

/£ Comparison

£ Progress

PF4=0ptions PFS=Edit JCL PFE=Submit JCL
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Select the reports you want to generate by entering a non-blank character in the line
command area to the left of each report name and pressing Enter. In the previous
figure, all reports except the Program Metrics history have been selected.

Note:
A detailed description of each report is provided in "Report Descriptions" on
page 81. Additional information on the File - Reports pop-up is also provided in
online help.

If one of the selected reports is the Executive summary, press PF4 to display the
Report Options pop-up and perform these actions.

a  Select Executive Summary from the Report Options pop-up to display the
Reports - Executive Summary pop-up.

b Onthe Reports - Executive Summary pop-up, indicate the location of the input
data file containing the report generator language for the Executive Summary
Report; enter the dataset Name and Member name.

¢  Press Enter. The Report Options pop-up redisplays.

Note:

The Executive Summary is printed in mixed case by default (member name is
VIAXESUM). If you want to print the Executive Summary in upper case, select
Executive Summary from the Report Options pop-up. The Reports - Executive
Summary pop-up displays and you can specify the upper case data file
(VIAXESUU) in the Member name field.

If necessary, choose Jobcard Information on the Report Options pop-up to display
the Report - Job card information pop-up and perform these actions.

a  Customize the jobcard information as appropriate.
b  Press Enter. The Report Options pop-up redisplays.

c Select Exit to return to the File - Reports pop-up.
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Press PF6 to submit the job. A message displays prompting you to close the
application (reports cannot be run if the application remains open).

Note:

You can select PF5 to edit the JCL. Selecting the PF5 key also prompts you to close
the application.

For an explanation of the PARM values in the REPORT step of the generated JCL,
see "Report Options" on page 217.

After editing the JCL, issue a TSO ISPF SUBMIT command to submit the report
job. You may use the TSO ISPF END command to end the TSO edit session.

Press Enter. The application is closed and the report job is submitted.

Some helpful hints for running reports for the first time are listed below:

After defining an application, it is a good idea to run the Application Definition
report. This report shows the application's hierarchical organization, including its
source libraries, programs, and any analyze attributes. By viewing this report, you
can verify that you have properly defined the application. The Application
Definition is the only Recap report that can be produced before the application is
analyzed.

If you are running reports for an application that has just been analyzed for the first
time, do not produce any progress or history reports (Program Metrics History,
Program Progress, and Application Progress). Because the application was
analyzed only once, there is no progress data or history data available.

If no other applications have been analyzed in the AKR, it is recommended that you
not to produce the Enterprise Metrics, Enterprise Exceptions, and Application
Comparison reports. These reports compare metric values and code exceptions
among all the applications in the AKR. If there is only one application, these reports
lose their effectiveness.



Using Portfolio Analysis Data

This chapter presents several scenarios to illustrate potential uses of Recap’s function
point and inventory analysis data, and contains these sections:

Portfolio Analysis Overview 47
Uses of Function Points 49
Using the Portfolio Analysis Data 51
Modifying the Executive Summary 67
Exporting Portfolio Analysis Data 68

Portfolio Analysis Overview

Today, many IT shops have implemented Quality and Productivity Improvement
Programs to add value to their company by improving processes within their
departments. These programs focus on improving the software applications used by the
organization. But, how does an IT organization measure the effectiveness of software
improvements?

To evaluate improvements to software applications, an organization should measure its
applications at the beginning of any Quality and Productivity Improvement Program and
at regularly scheduled intervals thereafter (e.g., monthly, quarterly, or semi-annually).
The initial measurement establishes baseline data that provides a reference or starting
point. The baseline data can help identify areas within an application or a development
process that could be improved. Measurements taken at scheduled intervals provide
progressive and statistical data concerning the applications. These measurements can help
evaluate the success of the Improvement program. Measurements can also be taken at any
point during an application's (or project's) life cycle.

47



ASG-Recap User’s Guide

48

In IT, two types of quality measurement are important: functional quality and technical
quality. Functional quality is based on your point of view and focuses on how well a
software application supports a business function. By assessing functional quality, an IT
department can more effectively assess customer satisfaction. This enables IT to confirm
that they are building the systems that meet their user requirements. Functional quality is
typically measured through customer satisfaction surveys.

Note:
Functional quality is a subjective value and is not measured by Recap.

Technical quality focuses on how well an application is designed and implemented from
a technical perspective. This includes the degree to which an application can be
understood, maintained, and tested. Technical quality is measured through software
metrics that provide objective, quantitative, and practical ways to measure the quality of
software applications.

Because Recap provides MIS professionals with an automated inventory analysis tool to
measure the technical quality of their software applications, Recap can be used to support
a Quality and Productivity Improvement program. As part of its measurement process,
Recap generates comparative, progressive, and statistical data related to function points
and software metrics (at an enterprise, application, and program level). The inventory
analysis data can be viewed by running the desired Recap reports. Management can then
use this data to assist them in the decision making process.

Note:
An introduction to the software metrics that Recap computes is provided in "Metrics" on
page 18.

In this chapter, several scenarios are presented to illustrate potential uses of Recap's
function point and inventory analysis data.

Note:
Recap's inventory analysis data can be used in more ways than those described in this
chapter. To a large extent, how an organization uses the data depends on the goals of its
Quality and Productivity Improvement Program.
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Uses of Function Points

Scenario

Function Point Analysis is a useful tool at many levels of management. At the topmost
level, Function Point Analysis can provide Chief Executive Officers (CEO) with the
current value of an organization's software and the savings realized by investing in new
technology. At the Chief Information Officer (CIO) level, information such as trends in
productivity and maintenance costs can be determined by using Function Point Analysis.
A project manager can use Function Point Analysis for such activities as determining the
feasibility of software projects, allocating resources, and scheduling maintenance and
development projects.

This section presents a scenario that focuses on using Function Points at the Project
Management level. As noted above, Function Points can be used by all levels of
management. For a more comprehensive discussion on the uses of Function Points at
different managerial levels, see the IFPUG publication, Function Points as Assets --
Reporting to Management.

Y our organization has just completed the requirements definition and external
specifications for a Purchasing/Payables application. From the external specification, you
estimate that the application's size is 1,800 Function Points. You also estimate that the
project requires 12 months to complete. As project manager, you separate the project into
three equal phases, each lasting four months and containing 600 Function Points. Six
full-time information systems staff members comprise your project team.

The project's first phase is completed in the estimated four months. Recap is used to
measure the application's size after this phase. After making the necessary adjustments,
you arrive at an adjusted Function Point value of 640.

The second phase, however, is not completed until the tenth month. Again, you measure
the application's size with Recap. After the second phase, the Function Point count now
stands at 1,800. You want to know if the project can be completed within the next two
months to remain on schedule.
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Estimate the number of Function Points that remain. From the original estimate, 600
Function Points remain. In addition, the original estimate is one-third less than the
actual amount. To obtain a more realistic estimate of the number of Function Points
remaining, add one-third to the phase estimate of 600. This yields a value of 800
Function Points that remain.

Calculate the Function Points per man month:

Function Points/man month = Function Points completed / (#
of persons * # of months)

Or

1,800 / (6 persons * 10 months) = 30 Function Points/man month

Based on the value of 30 Function Points per man month, you estimate that
approximately 26.5 man months are required to complete the project (800/30).
Given this fact, at a staffing level of six persons, the project will be completed
approximately 2.5 months behind schedule:

26.5 man months / 6 persons = 4.4 months;
10 months + 4.4 months = 14.4 months;
14.4 months - 12 months = 2.4 months.

To complete the project on time (in two months), you need to increase staffing. To
calculate the staffing level required, perform this calculation:

Man months remaining / Months remaining in original 12 month
estimate

26.5 / 2 = 13.25.

The staffing level would have to be increased to 14 to complete the project within
the next two months.
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Using the Portfolio Analysis Data

This section presents several scenarios that illustrate how the portfolio analysis data
generated by Recap could be used to assist IT management in decision making. The first
scenario focuses on using the information to support a continuous improvement initiative.
The second scenario illustrates how Recap can support decision making regarding
re-engineering.

Continuous Improvement Scenario

Your IT department's goal is to improve the IT process through continuous improvement.
Continuous improvement (in this case) means that the IT processes are gradually refined
(improved) so that deliverables (systems and service) are of higher quality (from both a
technical and functional perspective).

The first step in accomplishing this goal is to measure. By measuring, you establish a
baseline of information. Using Recap, you build definitions and analyze these
applications: Appl-A, Appl-B, Appl-C, and Appl-D.

After the analyze procedure is run, any Recap report is available. Three levels of
reporting exist in Recap:

. Program

. Application

. Enterprise

At this point, you want to get a feel for the overall status of the enterprise; that is, you
want to see how the four applications within the AKR compare to each other. This should
give you insight on which applications are in good shape and those that are not. For this

global look at the enterprise, you run the Enterprise Metrics and Enterprise Exceptions
reports.
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The Enterprise Metrics report summarizes the metrics for the application in the enterprise
(AKR). Figure 23 shows an example of this report.

Figure 23 « Sample Enterprise Metrics Report

ASG-RECAP-0S (ESA)

APPLICATION PGM
NAME TOTAL
APPL-C 60

APPLICATION PGM

NAME TOTAL
APPL-A 60
APPL-B 48
APPL-D 6

ENTERPRISE TOTAL/SUMMARY

METRICS

ADJUSTED FUNCTION POINTS
ENHANCEMENT FUNCTION POINTS
SOFTWARE SCIENCE VOLUME
CYCLOMATIC COMPLEXITY
ESSENTIAL COMPLEXITY

CONTROL VARIABLE
KNOTS

NUMBER OF LINES OF CODE

LEGEND:LO = VALUE
HI = VALUE

Rx.x LVLxxx ENTERPRISE METRICS
AKR NAME: ASG.RCPSAMP.AKR

NON-CONFORMANT

DD-MMM-YYYY HH:MM:SS PAGE 216

ADJ FP ENH FP VOLUME CYCLOMATIC ESSENTIAL CNTL VAR KNOTS LINES CODE STRUCT CMPLX BUSNS
TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL VALUE
791 0 1315573 HI 17646 HI 7445 HI 23067 19279 HI 34731 HI LOow HIGH HIGH

CONFORMANT
ADJ FP ENH FP VOLUME CYCLOMATIC ESSENTIAL CNTL VAR KNOTS LINES CODE STRUCT CMPLX BUSNS
TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL VALUE
667 0 999458 1250 LO 115 LO 2623 LO 70 LO 22985 HIGH Low Low
625 0 977421 2790 453 6675 1481 42950 LOow HIGH Low
171 0 146795 LO 474 63 1241 28 6579 LO HIGH LOW LOwW

(NUMBER OF APPLICATIONS = 10, NUMBER OF PROGRAMS = 333)

TOTAL AVERAGE STD. DEV LOW BOUND HIGH BOUND
2928 293 96 197 389

0 0 0 0 0
6304566 630457 283961 346496 914418
35554 3555 4804 0 8359
12626 1263 2146 0 3409
59677 5968 5954 14 11922
35030 3503 5587 0 9090
226518 22652 7116 15536 29768

< AVG.
> AVG.

- STD.
+ STD.

DEV.
DEV.

LOW = VALUE <= AVG.
HIGH = VALUE > AVG.

LOW BOUND = AVG.
HIGH BOUND = AVG.

- STD. DEV. STD. DEV.
+ STD. DEV.

STANDARD DEVIATION
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Appl-A stands out as being much better than the others. Its complexity (Cyclomatic
Complexity and Control Variable metrics) and structure (Essential Complexity and
Knots) metrics are flagged with a LO tag. A LO tag indicates the metric value is greater
than one standard deviation less than the enterprise average for that metric. This implies
that Appl-A is much less complex and much more structured than the other applications
in the enterprise. Yet, Appl-A is one of the larger applications (as indicated by its Volume
metric) and it provides the organization with a reasonable level of business value (even
though its business value is rated as low).

Another application, Appl-C, stands out as being much worse than the others. Appl-C is
listed in the Non-Conformant section of the report, which means that it has at least one
metric (excluding Function Points) that is greater than one standard deviation from the
enterprise average for that metric. Metrics that fall into this category are flagged with a
HI tag. These HI tags could represent potential problem areas. Appl-C's size (Volume),
complexity (Cyclomatic Complexity and Control Variable Complexity metrics), and
structure (Essential Complexity and Knots metrics) metrics are all flagged with a HI tag.
This implies that Appl-C is much more complex and less structured than the other
applications.
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The Enterprise Exceptions report summarizes code exceptions affecting the quality of the
applications in the enterprise. The existence of these code exceptions in the application's
programs may force the program to perform differently than expected. Figure 24 shows
an example of the Enterprise Exceptions report.

Figure 24 « Sample Enterprise Exceptions Report

ASG-RECAP-0S (ESA) Rx.x LVLxxX ENTERPRISE EXCEPTIONS DD-MMM-YYYY HH:MM:SS PAGE 217
AKR NAME: ASG.RCPSAMP.AKR
APPLICATION NUMBER OF NUMBER OF NUMBER OF NUMBER OF NUMBER OF NUMBER OF NUMBER OF NUMBER OF LINES OF LINES OF

NAME PROGRAMS GO TOS ALTERS A-ENTRIES A-EXITS RECURSION JUMPS LIVE EXIT DEAD CODE DEAD DATA
APPL-A 60 92 0 60 66 0 0 0 16 160
APPL-B 43 1602 91 69 110 64 143 3 1050 313
APPL-C 43 1621 210 73 2 120 496 5 1191 404
APPL-D 33 1675 49 60 95 6 129 3 1398 217
ENTERPRISE TOTAL/SUMMARY (NUMBER OF APPLICATIONS = 4, NUMBER OF PROGRAMS = 179)

EXCEPTIONS TOTAL

GO TOS 17693

ALTERS 275

ANOMALOUS ENTRIES 5

ANOMALOUS EXITS 58

RECURSIONS 3809

OUT OF PERFORM RANGE JUMPS 12235

LIVE EXITS 582

DEAD CODE 10595

DEAD DATA 1091

LEGEND: JUMPS = OUT OF PERFORM RANGE JUMPS A-ENTRIES = ANOMALOUS ENTRIES A-EXITS = ANOMALOUS EXITS

Appl-A has far less code exceptions than the other three applications. Appl-C has a larger
number of code exceptions.

Other metrics that you collected (outside of Recap) also make Appl-A appear favorably

when compared to the other applications. These additional metrics also state that Appl-C
is poor in comparison to the other applications.
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Figure 25 shows a listing of some of these additional metrics.

Figure 25 » Other Important Metrics for Scenario

Other Important Metrics

Lpplication
E:s B c o
Cost per Function Point 210 971 §995 510
Function Foints per Man-month 110 14 15 35
Iefects per Function Points 3 15 z1 iz
Code Exceptions per Function Foints .0a7 .01 .11 .08
Customer Satisfaction * 2.1 6.2 4.4 7.1

* Evaluated on a scale from 10 [(Extremely Satisfied)
to 1 [(Extremely Unsatisfied)

After analyzing the data, you want more of the applications to be as structured and as
easy to understand and maintain as Appl-A. After investigating why there is such a
disparity between Appl-A and the other applications you find that:

. Appl-A is a new application. It served as a pilot project utilizing CASE generated
COBOL and had a minor amount of RAD (Rapid Application Development); prior
applications were developed with traditional manual COBOL lifecycles with few
productivity aids.

. User involvement was extensive in the development of Appl-A. In prior
applications, an emphasis was not placed on user involvement during
design/prototyping.

Using this data, your department decides that all future development projects utilize the
same technologies and approaches as Appl-A. It is also decided that Appl-C is in need of
a major overhaul. Appl-C is complex, unstructured and expensive to maintain. A team is
assembled to evaluate which is the more reasonable course of action with regards to
Appl-C: Redevelopment or replacement.
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Re-engineering Scenario

Your IT department is contemplating whether or not to undertake a re-engineering
initiative (versus continuing in a maintenance mode). To a certain extent, this decision is
based on the status of the programs in you organization's software portfolio. Applications
or programs that provide high business value and that are high in complexity are ideal
candidates for re-engineering.

You have responsibility for these IT applications: Accounts Receivable, Customer
Billing, Customer Information, and Sales. The Director of IT has asked you to
recommend programs in which re-engineering could be beneficial. Since this is your
initial effort, the Director asked you to confine your search to those applications that are
complex and provide the organization with substantial value.

To gain an overview of the applications, you first review the Application Comparison
report and the Enterprise Metrics report. These reports present comparison metric
information at the application level.

The Application Comparison report consists of two sets of graphs (quadrant reports) and
tables. One set compares the applications (in an enterprise) in terms of structure
(Essential Complexity) and complexity (Cyclomatic Complexity); the other, in terms of
business value (Function Points) and complexity (Cyclomatic Complexity).

The graphs give you a bird's eye view of the overall structure/complexity and business
value/complexity of the applications. The asterisks (*) represent one or more applications
that have metrics at the X-Y coordinate. The area enclosed by the box represents all the
coordinates that fall within one standard deviation of each of the variables being
measured (either structure and complexity or business value and complexity). The two
horizontal lines of the box represent plus and minus one standard deviation for the Y-axis
variable. The two vertical lines of the box represent plus and minus one standard
deviation for the X-axis variable. Each variable's average is represented by the line
stretching from the axis to the edge of the graph. The intersection of the two lines
(averages) forms the four quadrants.

The tables provide the supporting detail (i.e., the name of the applications) for the graphs.

The next four figures illustrate the Application Comparison report. Figure 26 on page 56
shows the structure/complexity graph with Figure 27 on page 57 presenting the table
associated with the graph; Figure 28 on page 58 shows the business value/complexity
graph with Figure 29 on page 59 presenting the table associated with that graph.
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Figure 26 « Comparison - Essential Complexity versus Cyclomatic Complexity

ASG-RECAP-0S (ESA) Rx.x LVLxxx APPLICATION COMPARISON

AKR NAME: ASG.RCPSAMP.AKR
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STRUCTURED (II) UNSTRUCTURED (I)
HIGH COMPLEXITY HIGH COMPLEXITY
17650 - | *
| |
| i
| |
| i
| |
I i
| |
| i
| |
I i
| |
| i
i i
14120 -
| |
| i
| |
I i
| |
| i
| |
I i
| |
I i
| |
| i
i i
10590 -
| |
I i
| |
| i
| |
| i
i i
CYCLOMATIC - - - - - - - - - - -—-=-=-=-=-=-=-=- - - +
COMPLEXITY 1
i i i
7060 -
i i i
| |
| i
| |
I i
i i
I ! * I
I i
| |
I i
i i i
3555 mm
i i i
i i
I * i I
| ]
! * ok koK |
I * ! I
I i
i i
[ ! I
I i
0 —=mmmmmmmmmmmo- R = i Rt |-——1--
11 2 4 5 7
2 4 9 4 9 4
6 8 7 6 5 4
3 9 8 7 6 5
STRUCTURED (III) UNSTRUCTURED (IV)

LOW COMPLEXITY LOW COMPLEXITY

ESSENTIAL COMPLEXITY

56



4 Using Portfolio Analysis Data

Figure 27 « Comparison - Essential Complexity versus Cyclomatic Complexity

ASG-RECAP-0S (ESA) Rx.x LVLxxx APPLICATION COMPARISON DD-MMM-YYYY HH:MM:SS PAGE 261

AKR NAME: ASG.RCPSAMP.AKR

QUADRANT III (LOWER LEFT) QUADRANT IV (LOWER RIGHT)

QUADRANT I (UPPER RIGHT) QUADRANT II (UPPER LEFT)
STRUCTURED-LO COMPLEX UNSTRUCTURED-LO COMPLEX

UNSTRUCTURED-HI COMPLEX STRUCTURED-HI COMPLEX

ACCT-PAYBL ( 225, 1542)
ACCT-RCVBL ( 495, 1917)

MANF-CNTL (2317, 4729)

SALES (7445, 17646)
CUST-BILL ( 474, 1853)
CUSTOMER (266, 1568)
EMPL-INFO ( 342, 1858)
INVENTORY ( 546, 1946)
PAYROLL (453, 2021)
TELEPHONE ( 63, 474)

F

FGRAPH COORDINATES = (ESSENTIAL COMPLEXITY, CYCLOMATIC COMPLEXITY)
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Figure 28 « Comparison - Function Points versus Cyclomatic Complexity

|ASG-Recap-0S (ESA) Rx.x LVLxXxX APPLICATION COMPARISON DD-MMM-YYYY HH:MM:SS PAGE 262
AKR NAME: ASG.RCPSAMP.AKR
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FUNCTION POINTS

You are primarily interested in those applications that provide a high business value and
are highly complex. Of the four applications you are responsible for, only one, Sales, falls
into this category (see Figure 28 or Figure 29 on page 59, Quadrant I). Notice also that
Sales is well outside the standard deviation box. This signals that Sales is much more
complex and provides far greater value than any of the other applications in the
enterprise.
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The other three applications you are responsible for are of comparable business value and
complexity. These three applications fall within the standard deviation box.

With this in mind, you see the Enterprise Metrics report. This report summarizes the
metrics for the applications in the enterprise.

Figure 29 » Enterprise Metrics Report

ASG-RECAP-0S (ESA) Rx.x LVLxxx ENTERPRISE METRICS DD-MMM-YYYY HH:MM:SS PAGE 269
AKR NAME: ASG.RCPSAMP.AKR
APPLICATION  PGM ADJ FP ENH FP VOLUME CYCLOMATIC ESSENTIAL CNTL VAR KNOTS LINES CODE STRUCT CMPLX BUSNS
NAME TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL VALUE
MANF-CNTL 36 310 0 882297 4729 2317 8524 7272 31698 HI Low HIGH HIGH
SALES 31 514 1315573 HI 17646 HI 7445 HI 23067 HI 19279 HI 34731 HI LOW HIGH HIGH
CONFORMANT

APPLICATION PGM ADJ FP ENH FP VOLUME CYCLOMATIC ESSENTIAL CNTL VAR KNOTS LINES CODE STRUCT CMPLX BUSNS
NAME TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL VALUE
ACCT-PAYBL 36 188 0 511021 1542 225 3245 1070 19048 HIGH Low LOW
ACCT-RCVBL 43 288 0 605906 1917 495 4035 1241 23493 HIGH Low LOW
CUST-BILL 43 337 0 601125 1853 474 3891 1226 23289 HIGH Low HIGH
CUSTOMER 33 266 0 536930 1568 266 3320 1097 20566 HIGH LOwW LOW
EMPL-INFO 35 250 0 558657 1858 342 3622 1092 21325 HIGH LOwW LOW
INVENTORY 34 221 0 531911 1946 546 4623 1502 22985 HIGH LOwW LOW
PAYROLL 36 383 0 614351 2021 453 4109 1223 22804 HIGH Low HIGH
TELEPHONE 6 171 0 146795 LO 474 63 1241 28 6579 LO HIGH Low LOW
ENTERPRISE TOTAL/SUMMARY (NUMBER OF APPLICATIONS = 10, NUMBER OF PROGRAMS = 333)

METRICS TOTAL AVERAGE STD. DEV. LOW BOUND HIGH BOUND

ADJUSTED FUNCTION POINTS 2928 293 96 197 389

ENHANCEMENT FUNCTION POINTS 0 0 0 0 0

SOFTWARE SCIENCE VOLUME 6304566 630457 283961 346496 914418

CYCLOMATIC COMPLEXITY 35554 3555 4804 0 8359

ESSENTIAL COMPLEXITY 12626 1263 2146 0 3409

CONTROL VARIABLE 59677 5968 5954 14 11922

KNOTS 35030 3503 5587 0 9090

NUMBER OF LINES OF CODE 226518 22652 7116 15536 29768

F

LEGEND: LO = VALUE < AVG. - STD. DEV. LOW = VALUE <= AVG. LOW BOUND = AVG. - STD. DEV. STD. DEV. = STANDARD DEVIATION
F HI = VALUE > AVG. + STD. DEV. HIGH = VALUE > AVG. HIGH BOUND = AVG. + STD. DEV.

Sales is listed in the Non-Conformant section of the report, which means that it has at
least one metric (excluding Function Points) greater than one standard deviation from the
enterprise average for that metric. Metrics that fall into this category are flagged with a
HI tag. These HI tags could represent potential problem areas. Sales's size (Volume),
complexity (Cyclomatic Complexity and Control Variable Complexity metrics), and
structure (Essential Complexity and Knots metrics) metrics are all flagged with a HI tag.
This implies that Sales is much more complex and far less structured than the other
applications.

Sales is rated as High in Complexity and Business Value. The High and Low ratings
assigned to Structure, Complexity, and Business Value are relative assignments. For
example, those applications rated as Low in complexity are not necessarily easy to
understand (i.e., not complex). Instead, a Low complexity rating should be interpreted as
meaning that in comparison to the other applications in the AKR, those applications rated
as Low are not as complex as those applications rated as High.
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The assignment of the Highs and Lows is dependent on whether the application's metric
is above (High) or below (Low) the enterprise's average for that metric. The use of High
and Low is consistent with the Application Comparison report. That is, if an application
is in Quadrant I of the Application Comparison report, it is listed as High for business
value (or structure, depending on which version of the graph you use) and complexity on
the Enterprise Metrics report.

Based on the information from these two reports, it is worthwhile to investigate the Sales
application further. Sales has a high business value (almost two times greater than the
next closest application in the AKR), and its Volume, Cyclomatic Complexity, Essential
Complexity, Control Variable, and Knots metric values are at least one standard deviation
greater than the enterprise average. The other three applications in your control fall
within the standard deviation box, indicating that they have average values for their
metrics. Although their Cyclomatic Complexity metrics are not ideal, they are over 10
times less than the Cyclomatic Complexity for Sales. Therefore, because you only want
to look at applications that are the most complex, you decide to hold off on looking at
these three applications in more detail.

To look at Sales more in-depth, the reports for the SALES application are run. This
includes the Executive Summary, application level reports, and program level reports.
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Review the Executive Summary first, shown in Figure 30, which gives an overview of
the application.

Figure 30 » Executive Summary (SALES Application)

ASG-RECAP-0S (ESA) Rx.x LVLxxx EXECUTIVE SUMMARY DD-MMM-YYYY HH:MM:SS PAGE 1
APPLICATION: SALES

GENERAL INFORMATION

The SALES (SALES INFORMATION) application inventory analysis was performed on DD-MMM-YYYY at HH:MM:SS. There
is one historical version of the application. It consists of 37 analyzed programs. For additional details
see the Application Definition Report.

APPLICATION COMPARATIVE ANALYSIS

The SALES application was compared against 9 other applications (see the Enterprise Metrics Report for
the names of other applications).

In comparison with the other 9 applications in this assessment, SALES has a high Adjusted Function Point

value (687), an Enhancement Function Point value of 0, and at the same time it has many Lines Of Code (56128).
This indicates a large application with good business value which may be hard to maintain. The programs within
this application have a high number of lines of code per program (1517). SALES has a high Functional Complexity
(27) (where Functional Complexity = Cyclomatic Complexity/Adjusted Function Points) and a high technical
complexity as shown by the Cyclomatic Complexity (18537), indicating a conceptually difficult application. The
Essential Complexity (7577) indicates that SALES has a poor logical structure. This correlates with the poor
physical structure shown by the Knots value (19664). Of the 10 applications assessed, SALES has a relatively
large number of Code Exception Conditions. See the Function Point Analysis, Enterprise Metrics and
Enterprise Exceptions Reports for additional details.

Due to the poor physical structure for an application with a high business value, we recommend that you
restructure the application. In addition to the option of restructuring, the application could benefit from

re-engineering because it has high technical complexity and poor physical structure, but provides good business

value. The application contains a high number of exceptions that should be corrected to prevent flow problems
(see PROGRAM COMPARATIVE ANALYSIS below) .

PROGRAM COMPARATIVE ANALYSIS

Of the 37 programs in the application, 36 programs have code exceptions which may cause the programs to
function differently than expected. We strongly recommend that you locate the program exceptions and correct
them. See the Application Exceptions Report for additional information.

Of the 37 programs, 2 programs are more than 1 standard deviation greater than the average for Software
Science Volume, 2 programs are more than 1 standard deviation greater than the average for Cyclomatic
Complexity, 2 programs are more than 1 standard deviation greater than the average for Control Variable
Complexity, and 5 programs are more than 1 standard deviation greater than the average for Lines Of Code. If
these programs provide important business functions, they may be candidates for re-engineering or
decomposition. See the Application Metrics or Program Comparison Report for additional details.

Of the 37 programs, 2 programs are more than 1 standard deviation greater than the average for Essential
Complexity, and 1 program is more than 1 standard deviation greater than the average for Knots Count. If these
programs show a history of difficult maintenance and they perform important business functions, they may be
candidates for restructuring.

No information is available to report how many programs have changed significantly.

61



ASG-Recap User’s Guide

62

The Application Comparative Analysis section discusses Sales in relation to the other
applications in the AKR. This confirms that Sales may be a good candidate application
for a restructuring/reengineering project.

The Program Comparative Analysis section discusses the programs within Sales.
Indicated in this section are the number of programs within Sales that are greater than one
standard deviation from the average (for the programs within Sales) for each of the
software metrics. Recall that these programs could indicate potential problems.

Within the Program Comparative Analysis section, you are referred to additional reports
that contain detailed information on the programs within Sales. The two of most interest
to you are the Application Metrics and Program Comparison reports.

The Application Metrics report summarizes the metrics for the programs in the
application. The format of this report is identical to that of the Enterprise Metrics report;
the only difference is that this report concentrates on the programs within an application,
while the Enterprise Metrics report focuses on the applications within the AKR.
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Figure 31 shows the Application Metrics report for Sales.

Figure 31 » Application Metrics Report

ASG-RECAP-0S (ESA) Rx.x LVLXxx APPLICATION METRICS

APPLICATION: SALES VERSION: 1
(A)
NON-CONFORMANT
(B) (C)
PROGRAM VOLUME CYCLOMATIC ESSENTIAL CNTL VAR KNOTS LINES CODE
NAME VALUE VALUE VALUE VALUE VALUE VALUE
GENAMER1 262572 HI 10865 HI 3107 HI 12307 HI 661 7092 HI
KCe601 635414 HI(E) 5535 HI 4121 HI 8084 HI 17797 HI 10899 HI
(F)
CONFORMANT
PROGRAM VOLUME CYCLOMATIC ESSENTIAL CNTL VAR KNOTS LINES CODE
NAME VALUE VALUE VALUE VALUE VALUE VALUE
CM431 7056 22 1 41 14 379
DB204 10089 31 5 61 10 474
E02031 14949 48 8 122 18 882
IC110 200 1 1 1 0 63
IC120 245 2 1 3 0 100
IC207 9855 33 5 66 17 396
Icz17 115 1 1 1 0 42
IX203 13644 52 10 106 15 610
IX214 54980 147 45 296 125 1702
NC110 648 2 1 2 1 61
NC119 33470 82 5 162 93 1034
NC154 15039 43 1 106 46 707
NC165 19314 46 1 98 46 799
NC209 20583 54 5 138 78 776
NC217 24633 63 5 131 43 875
NC431 35310 70 7 150 13 1137
RL151 4656 14 3 27 8 293
RL431 11376 31 7 58 8 567
5G203 17397 66 15 109 48 601
50110 12618 54 25 109 46 514
50120 11880 54 13 109 19 599
50205 15273 58 13 119 27 560
50215 5464 24 5 47 7 314
ST110 70 1 1 1 0 73
ST201 20313 75 9 152 49 806
ST211 17892 49 9 113 39 795
ST441 9918 23 5 49 8 525
TH205 16731 50 5 150 24 588
TH215 13869 50 5 149 19 468
(G)

LEGEND:LO = VALUE < AVG. - STD. DEV LOW = VALUE <= AV

DD-MMM-YYYY HH:MM:SS PAGE 206

(D)

STRUCT CMPLX
LOwW HIGH
Low HIGH

STRUCT CMPLX

HIGH LOwW
HIGH Low
HIGH LOW
HIGH LOow
HIGH LOW
HIGH Low
HIGH LOwW
HIGH LOW
HIGH Low
HIGH LOwW
HIGH LOW
HIGH LOwW
HIGH LOW
HIGH LOowW
HIGH LOwW
HIGH Low
HIGH LOW
HIGH LOow
HIGH Low
HIGH LOW
HIGH LOW
HIGH Low
HIGH LOW
HIGH LOW
HIGH LOW
HIGH LOwW
HIGH LOW
HIGH LOW
HIGH LOow

LOW BOUND = AVG.- STD. DEV STD.DEV.=STANDARD DEVIATIO

HI = VALUE > AVG. + STD. DEV. HIGH = VALUE > AVG. IGH BOUND = AVG.+ STD. DEV.

(H)
APPLICATION TOTAL/SUMMARY (NUMBER OF PROGRAMS = 31)
METRICS TOTAL AVERAGE STD. DEV LOW BOUND HIGH BOUND
SOFTWARE SCIENCE VOLUME 1315573 42438 117345 0 159783
CYCLOMATIC COMPLEXITY 17646 569 2115 0 2684
ESSENTIAL COMPLEXITY 7445 240 895 0 1135
CONTROL VARIABLE 23067 744 2540 0 3284
KNOTS 19279 622 3138 0 3760
NUMBER OF LINES OF CODE 34731 1120 2152 0 3272
LEGEND:LO = VALUE < AVG. - STD. DEV. LOW = VALUE <= AVG. LOW BOUND = AVG-STD. DEV.

HI = VALUE > AVG. + STD. DEV. HIGH = VALUE > AVG. HIGH BOUND = AVG. + STD. DEV.

STD.DEV.=STANDARD DEVIATION
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The Application Metrics report can be used to identify candidate programs for
redevelopment/reengineering projects. An ideal program is one that is high in business
value and complexity.

HI tags are used in a similar manner as in the Enterprise Metrics Report. A HI value is
one that is greater than one standard deviation from the application average. Those
programs that contain a HI value metric are listed in the Non-conformant section of the
report. The programs listed in the Non-conformant section are those that were briefly
mentioned in the Executive Summary.

Two programs in Sales are complex: KC601 and GENAMERI1. One additional program
has a Cyclomatic Complexity above 100, IX214. A value this large also indicates a
program that is difficult to understand and maintain.

Now, you review the Program Comparison report. This report indicates each program's
level of Structure/Complexity (Essential Complexity versus Cyclomatic Complexity).
The format of this report is identical to the Application Comparison report; the only
difference is that this report concentrates on the programs within an application, while the
Application Comparison report focuses on the applications within an AKR.
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Figure 32 and Figure 33 on page 66 show the Program Comparison report. Figure 32
shows the structure/complexity graph with Figure 33 on page 66 presenting the table
associated with the graph.

Figure 32 « Comparison - Essential Complexity versus Cyclomatic Complexity

ASG-RECAP-0S (ESA) Rx.x LVLxxx PROGRAM COMPARISON DD-MMM-YYYY HH:MM:SS PAGE 239
APPLICATION: SALES VERSION: 1
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Figure 33 « Comparison - Essential Complexity versus Cyclomatic Complexity

ASG-RECAP-0S (ESA)

Rx.x LVLxxX

PROGRAM COMPARISON

APPLICATION: SALES

QUADRANT I (UPPER RIGHT)
UNSTRUCTURED - HI COMPLEX

QUADRANT II (UPPER LEFT)
STRUCTURED - HI COMPLEX

DD-MMM-YYYY HH:MM:SS PAGE 240

VERSION:

QUADRANT III (LOWER LEFT)
STRUCTURED - LO COMPLEX

1

QUADRANT IV (LOWER RIGHT)
UNSTRUCTURED - LO COMPLEX

GENAMER1 (3107, 10865) CM431 1, 22)
KC601 (4121, 5535) DB204 5, 31)
E02031 ( 8, 48)
IC110 ( 1, 1)
IC120 ( 1, 2)
IC207 ( 5, 33)
Ic217 ( 1, 1)
IX203 ( 10, 52)
IX214 ( 45, 147)
NC110 ( 1, 2)
NC119 ( 5, 82)
NC154 ( 1, 43)
NC165 ( 1, 46)
NC209 ( 5, 54)
NC217 ( 5, 63)
NC431 ( 7, 70)
RL151 ( 3, 14)
RL431 ( 7, 31)
5G203 ( 15, 66)
50110 ( 25, 54)
50120 ( 13, 54)
50205 ( 13, 58)
50215 ( 5, 24)
ST110 ( 1, 1)
ST201 ( 9, 75)
ST211 ( 9, 49)
ST441 ( 5, 23)
TH205 ( 5, 50)
TH215 ( 5, 50)

GRAPH COORDINATES = (FUNCTION POINTS, CYCLOMATIC COMPLEXITY)

The Program Comparison report confirms that KC601 and GENAMERI1 are much more
complex than the other programs in SALES. Because of their severe level of complexity
and the fact that they are run often, you recommend KC601 and GENAMERI1 as strong

candidates for re-engineering.

You also recommend that program [X214 as a secondary candidate for re-engineering.

This scenario focused on the Sales application because it provided a high business value.
However, while the other applications did not, on the whole, provide high business value
(based on the Function Points), there may be programs within each application that could
benefit from restructuring/reengineering (because the programs are highly complex). To
find out if this is the case, each of the Application Metrics reports for the three other
applications could be reviewed.
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Modifying the Executive Summary

Scenario

The Executive Summary presents high level information on the application, including a
comparison to other applications and recommended actions. The Executive Summary can
be changed to meet the specific needs of your organization by using the Report Generator
Programming Language included with Recap. Chapter 7, "Report Generator Language,"
on page 135 contains detailed information about this subject. This section presents a
simple scenario that involves modifying the Executive Summary.

In your MIS shop, an emphasis towards correcting code exceptions exists, with particular
priority being placed on removing GOTOs and ALTERs. You want the Executive
Summary to indicate if there is a high number of GOTOs or ALTERs.

To preserve the original Executive Summary code, make a copy of the Dataset Member
that contains the code. You want to add a sentence in the first paragraph of the PROGRAM
COMPARATIVE ANALYSIS section (immediately after the first sentence). The sentence
added depends on if there is a high number of GOTOs, ALTERs, or both. The sentence
should read Of particular interest, there is a high number of

.. The high number is determined by a Recap ranking. An explanation of this is
included in Chapter 7, "Report Generator Language," on page 135. If there is not a high
number of GOTOs or ALTERS, no sentence should be added. This is the code added to
accomplish:

&if &exception rank(&gotos)>= 1 or &exception rank(&alters) >= 1

Of particular interest,there is a high number of

&if &exception rank(&gotos)>=1 and &exception rank(&alters)>= 1
GOTOs and ALTERs.

&else
&if &exception rank(&gotos) >= 1
GOTOs.
&else
&if &exception rank(&alters) >= 1
ALTERs.
&endif
&endif
&endif
&endif
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Recap provides a feature that creates a file used to export portfolio analysis data to PC
database, presentation, and spreadsheet packages. A comma (,) and quote (" ") delimited
file can be created, using the Export action on the File pull-down or the Export command
from the Batch AKR utility, to export portfolio analysis data.

Detailed information on the Export Facility is described in "Export Metrics Facility" on
page 175.




Viewing and Editing Function Point Data

This chapter discusses the various options for viewing and editing function point data and
contains these sections:

View Function Point Information On-line 69
View Function Point Analysis Data in Reports 71
Editing Recap Function Points 71
Adding Function Point Types 79
Modifying Existing Function Point Types 79
What if the Application is Reanalyzed? 80

View Function Point Information On-line

You can view adjusted and enhancement function point values online.

To view adjusted and enhancement function point values, follow this step:

» From the FP Task Manager or the Edit - Function Points pop-up, select Preview
Adjusted FP or Preview Enhancement FP and press Enter to display the appropriate
preview screen.

To print adjusted and enhancement function point values, follow this step:

» Select File P Print and press Enter on the displayed preview screen.

See online help for more detailed information on these screens.
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Preview Adjusted FP - Summary

The Preview Adjusted FP - Summary browse-only screen displays this information:

A table weighing the complexity of the five function point types and showing the
total Unadjusted Function Points value.

The Degree of Influence (DI) assigned to each general system characteristic and the
resulting total.

The calculations used to determine the Value Adjustment Factor (VAF) and Total
Adjusted Function Points (FP) and their results.

To view the function points in detail, follow this step:

» Select View P Detail on Preview Adjusted FP - Summary screen. The detail view

shows function point ranges for FTR, RET, DET, and complexity levels for each
function point type.

Preview Enhancement FP - Summary
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The Preview Enhancement FP - Summary browse-only screen displays this information:

Tables weighing the complexity of function point types that have been added,
changed, or deleted.

The DI assigned to each general system characteristic and the resulting total before
and after function point enhancement.

The calculations used to determine the VAF and Total Enhancement Function
Points (EFP). The VAF is shown before and after function point enhancement.

To view the enhancement function points in detail, follow this step:

» Select View P Detail on Preview Enhancement FP - Summary screen. The detail view

shows function point ranges for FTR, RET, DET, and complexity levels for each
function point type before and after enhancement.
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View Function Point Analysis Data in Reports

The results of Recap's Function Point analysis can be viewed by running the Application
Function Point Analysis report. If this report is not generated during the analyze
procedure, you can produce it (assuming that the application was analyzed).

To generate the Application Function Point Analysis report

1 Open an application. If an application is not already open, see "To open a Recap
application" on page 44.

2 Select File » Reports from the Recap Primary screen and press Enter to display the
File - Reports pop-up.

3 Specify Function points in the Application Reports group.

Note:

If this is your first time running Recap reports, you may also have to customize your
Jobcard information. To do this, press PF4 and select Jobcard Information on the
Report Options pop-up. See "Generating Recap Reports" on page 43 for more
information.

4  Press PF6 to submit the report job.

Note:

For descriptions and examples of the Application Function Point Analysis Report, see
"Report Descriptions" on page 81.

After viewing the results, you may want to change the method used to calculate function
points. See Editing Recap Function Points for information on editing Recap function
points.

Editing Recap Function Points

The method Recap uses to calculate function points is based on the /[FPUG Counting
Practices Manual. However, some variations exist between the Recap counting method
and the IFPUG method. If you only plan to use the Recap function point data to make
comparisons between applications analyzed using Recap, you probably do not need to
adjust the function point data. Because Recap uses the same process to generate the
function point count each time an application is analyzed, you can make a valid
comparison between the function point data generated at different times or for different
applications.
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However, if you plan to compare the function point data generated by Recap to function
point data generated by other means, such as a count calculated by a Certified Function
Point Counter, you need to make these adjustments so that the Recap data conforms more
closely with IFPUG standards:

. Eliminate work files and related transactions
. Remove duplicate EIFs and ILFs

. Review EIF and ILF classifications and reclassify if necessary

Procedures for making these adjustments are provided in the topics in this section.

Eliminating Work Files and Related Transactions

72

IFPUG standards do not include Work files in the function point count. If you have
defined the application completely, including all JCL, load modules, CICS, and IMS
components, Recap identifies work files and related transactions and does not include
them in the function point count. However, if you have not defined the application
completely, Recap cannot detect which files are work files. Consequently, the counts for
these files and any related transactions (External Inputs, External Outputs, and External
Inquiries associated with the file) need to be subtracted from the Recap function point
count.

To remove a work file from the Internal Logical File classification (assuming the
application is open)

1 Select Edit » Function Points from the Recap Primary screen and press Enter to
display the Edit - Function Points pop-up.

2 Select Edit Internal Logical File to display the Adjust Function Points - Internal
Logical File Type pop-up Figure 34.

Figure 34 » Adjust Function Points - Internal Logical File Pop-up

Adjust Function Points - Internal Logical File

Command ===r _ Scroll ===: C5R
AKR @ "VYIATTG.L3.AKRS
APPL @ RC3E-HEW 1 0F 2

Select desired Element. Then press the FF key for action.

Data Element RET DET CFLX MAN
— MIAKEZE.ILF1ST 2-3 1-19 LOW MO
— YIAKESO. ILFZHD 2-3 1-19 LOW HO

EBOTTOM 0OF DATA

PF4=Mowe PFS=Modify PFE=Add PF1l0=Remowe
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Select entities that represent work. These files are temporary or intermediate files
used by a program to perform a technical task such as sorting a program. You can
scroll the screen if you need to view all of the elements.

Press PF10 to remove the selected entities.

If the Confirm Delete option on the Options - Product Parameters pop-up is set to
YES, the Remove Function Points - Internal Logical File Type pop-up displays (see

Figure 35).

If the Options - Product Parameters pop-up is set to NO, the selected entities and its
related transactions are deleted.

Figure 35 « Remove Function Points - Internal Logical File Type Pop-up

Remowe Function FPoints - Internal Logical File Type

Fress PF1Q to remowe the data element and its transactions, if desired.
Data Element: WIAKEZD.ILF1ST

RET: 2-5 DET: 1-19 CHPL:: LOW Options 2 1. Element & Transactions
2. Element only

PFlO=Remowve PFll=Browse Transactions

Select the Element & Transactions option and press PF10 to complete the removal
process and return to the Adjust Function Points - Internal Logical File type pop-up
when all entities are removed.

Note:

Press PF11 to display the Internal Logical File Type - Transaction List pop-up that
shows a list of transactions related to the selected data element. This is a view-only

pop-up.

Press PF3 to exit.

To remove a work file from the External Interface File classification (assuming
the application is open)

1

Select Edit » Function Points from the Recap Primary screen and press Enter to
display the Edit - Function Points pop-up.

Select Edit External Interface File to display the Adjust Function
Points - External Interface File Type pop-up.

Note:

You can also access the Adjust Function Points - External Interface File Type
pop-up from the FP Task Manager screen by selecting Edit External Interface File.
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Select entities that represent work files. These files are temporary or intermediate
files used by a program to perform a technical task such as sorting a program. You
can scroll the screen if you need to view all of the elements.

Press PF10 to remove the selected entities.

If the Confirm Delete option on the Options - Product Parameters pop-up is set to
YES, the Remove Function Points - External Interface File Type pop-up displays.

If the Confirm Delete option on the Option - Product Parameters pop-up is set to NO,
the selected entities and related transactions are deleted.

Select the Element and transactions option and press PF10 to complete the removal
process and return to the Adjust Function Points External Interface File type pop-up
when all entities are removed.

Note:

Press PF11 to display the External Interface File Type - Transaction List pop-up
that shows a list of transactions related to the selected data element. This is a
view-only pop-up.

Press PF3 to exit.

Removing Duplicate ILFs and EIFs
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According to IFPUG guidelines, an ILF and EIF should only be counted once for the
entire application. If you have defined the application completely, including all COBOL,
JCL, Load Module, CICS, and IMS components, Recap identifies duplicate ILFs and
EIFs and counts each unique ILF and EIF once for the entire application. However, if the
application definition is not complete, Recap may not be able to identify duplicate files;
consequently a file may be counted as an ILF and EIF for each program that uses the file.
In this case, you need to review the EIFs and ILFs for each program to identify and
eliminate any duplicates.

To remove duplicate ILFs

1

Access the Adjust Function Points - Internal Logical File Type pop-up from the
Edit - Function Points pop-up or the FP Task Manager screen as described in
"Eliminating Work Files and Related Transactions" on page 72.

Select the entities representing duplicate files. You may need to scroll to view all the
files.

Press PF10 to display the Remove Function Points - Internal Logical File Type
pop-up.

Select the Element only option.
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Press PF10 to complete the remove process and return to the Adjust Function
Points - Internal Logical File Type pop-up when all elements are removed.

Press PF3 to exit.

To remove duplicate EIFs

1

6

Access the Adjust Function Points - External Interface File Type pop-up from the
Edit - Function Points pop-up or the FP Task Manager screen as described in

'Eliminating Work Files and Related Transactions" on page 72.

Select the entities representing duplicate files. You can scroll the screen if you need
to view all the files.

Press PF10 to display the Remove Function Points - External Interface File Type
pop-up.

Select the Element only option.

Press PF10 to complete the remove process and return to the Adjust Function
Points - External Interface File Type pop-up when all elements are removed.

Press PF3 to Exit.

Reviewing and Reclassifying ILF and EIF Elements

Recap classifies files as ILFs and EIFs using these rules:

If the application contains WRITEs to the file, the file is classified as an Internal
Logical File.

If the application contains only READs to the file, the file is classified as an
External Interface File.

If the same file is referenced multiple times within the application, Recap only
counts the file one time for the application.

Recap relies on COBOL statements, JCL, Load Module, IMS, and CICS information in
the application definition when applying the classification rules. However, in the context
of an application, you may have files classified incorrectly because of other program or
application information that Recap cannot interpret. Therefore, you need to review the
file classifications and verify that they are correct. You can reclassify them if they are
incorrect.
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To reclassify an Internal Logical File as an External Interface File

1 Access the Adjust Function Points - Internal Logical File Type pop-up from the
Edit - Function Points pop-up or the FP Task Manager screen as described in
"Eliminating Work Files and Related Transactions" on page 72.

2 Select the entities to reclassify as External Interface File Types.
3 Press PF4 to reclassify the entities and move them to External Interface File Types.

4 Press PF3 to exit.

To reclassify an External Interface File as an Internal Logical File, repeat these steps
using the Adjust Function Points - External Interface File Type pop-up.

Reclassifying EO/EI Pairs to EQ
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According to IFPUG standards, when a READ/WRITE combination functions as a query
of an ILF or EIF, it should be counted and classified as an External Inquiry. Because
Recap counts all READS as EOs and all WRITES as Els, you may need to remove the
EI/EO components of each query from the EI and EO list and add an External Inquiry to
represent the READ/WRITE pair.

To record an element as an External Inquiry

1 Delete the input portion of the query from the External Input type.

2 Delete the response portion of the query from the External Output type.

3  Add the appropriate statement to the External Inquiry type.

To record an element as an External Inquiry

1 Review the Application Function Point Analysis Report to identify the EI/EO pair
that comprises the query.

2 Determine which element has the higher function point count. The element with the
highest function point count needs to be reclassified as an EQ and the other element
needs to be removed from the function point count.
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If the EI element has the higher function point count:

a From the Edit - Function Point pop-up, select Edit External Input to display the
Adjust Function Points - External Input Type pop-up (see Figure 36).

Note:

You can also access the Adjust Function Points - External Input Type pop-up from
the FP Task Manager screen by selecting Edit External Input.

Figure 36 » Adjust Function Points - External Input Type Pop-up

fdjust Function Points - External Input Type
Command ===} Scroll ===r C5R

AER @ "VIATTG.L3.AKRS
APPL = RC20-HEW 1 0F 2

Select desired transaction. Then press the FF key for action.

Transaction FTR DET CPLX MAH
— ADD WIAKEZD. ILF1ST WIAAEZO. ILFZHD a3+ 1-4 AYG MO
— DELETE WIMAE3G. ILFZHD o-1 1-4 LOW MO
— UPDATE WIASEZD.ILF1ST o-1 1-4 LOW MO

EOTTOM OF DATA

FF4=Mowe FFS=Modify FPFE=Add PFlGO=Remove

b  Select the transactions that represent the input portion of the query and press
PF4 to display the Move - External Input pop-up.

c Select External Inquiry and press Enter to reclassify the EI as and EQ and
return to the Adjust Function Points - External Input Type pop-up. The
transaction and function point information is added to the EQ element list.

d Press PF3 to Exit.

e  Toremove the EO portion of the query:

—  From the Edit - Function Point pop-up, select Edit External Output to
display the Adjust Function Points - External Output Type pop-up.

Note:

You can also access the Adjust Function Points - External Output Type pop-up
from the FP Task Manager screen by selecting Edit External Output.
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Select the transactions that need to be removed and press PF10. If the
Confirm Delete option on the Options - Product Parameters pop-up is set
to Yes, the Remove Function Points - External Output Type pop-up
displays. Press PF10 to complete the remove process and return to the
Adjust Function Point - External Output Type pop-up when all
transactions are removed.

If the Confirm Delete option on the Options - Product Parameters pop-up
is set to No, the transactions are removed from the Adjust Function
Points - External Output Type pop-up.

Press PF3 to Exit.

4  Ifthe EO element has a higher function point count:

a

Note:

From the Edit - Function Point pop-up, select Edit External Output to display
the Adjust Function Points - External Output Type pop-up.

You can also access the Adjust Function Points - External Output Type pop-up
from the FP Task Manager screen by selecting Edit External Output.

Note:

Select the transactions that represent the output portion of the query and press
PF4 to display the Move - External Output pop-up.

Select External Inquiry and press Enter to reclassify the EO as an EQ and
return to the Adjust Function Points - External Input Type pop-up. The
transaction and function point information is added to the EQ element list.

Press PF3 to Exit.

To remove the EI portion of the query:

From the Edit - Function Point pop-up, select Edit External Input to
display the Adjust Function Points - External Input Type pop-up.

You can also access the Adjust Function Points - External Input Type pop-up from
the FP Task Manager screen by selecting External Input.
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Select the transactions to be removed and press PF10. If the Confirm

Delete option on the Options - Product Parameters pop-up is set to Yes,
the Remove Function Points - External Input Type pop-up displays. Press
PF10 to complete the remove process and return to the Adjust Function
Point - Internal Output Type pop-up when all transactions are removed.
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—  Ifthe Confirm Delete option on the Options - Product Parameters pop-up
is set to No, the transactions are removed from the Adjust Function
Points - External Input Type pop-up.

—  Press PF3 to Exit.

Adding Function Point Types

To add a function point type

1

5

6

From the Edit Function Points pop-up or the FP Task Manager screen, select one of
these options depending on the function point type you want to add:

. Edit External Input
. External Output

. External Inquiry

. Internal Logical File

. External Interface File task

The appropriate Adjust Function Point type pop-up displays. Press PF6 to display the
appropriate Add Function Points pop-up.

Enter the transaction or data element you want to add.

Enter appropriate RET, DET, or FTR count. If you are adding an EI, specify whether
it is counted as an Input or an Output.

Press PF6 to add the new function point type.

Press PF3 to return to the appropriate Adjust Function Point pop-up.

See online help for specific instructions related to each specific Adjust Function Point
type and Add Function Point type pop-up.

Modifying Existing Function Point Types

To modify the complexity level of an existing Function Point type

1

From the Edit Function Points pop-up or the FP Task Manager screen, select the Edit
External Input, External Output, External Inquiry, Internal Logical File, or External
Interface File task, depending on the Function Point type you want to modify.
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2 Theappropriate Adjust Function Point type pop-up displays. Press PF5 to display the
appropriate Modify Function Points pop-up.

3 Enter the appropriate new count for the RET, DET, or FTR. If you are modifying an
El, specify whether it is an Input or an Output.

4  Press PF5 to update the information and display the new complexity level.
5  Press PF3 to return to the appropriate Adjust Function Point pop-up.

See online help for specific instructions related to each specific Adjust Function Point
type and Modify Function Points type pop-up.

What if the Application is Reanalyzed?
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If you edit the Function Point data and later reanalyze the application, you do not have to
perform the edits again. Recap stores the edits that you make; after you reanalyze the
application, you can instruct Recap to automatically reapply any previous edits that you
performed.

To apply previous Function Point edits to a reanalyzed application (assuming the
application is open)

1 From the Edit - Function Points pop-up or the FP Task Manager, select Apply
Previous Function Point Edits to display the Apply Previous Function Point edits
screen.

2 Select File » Apply Previous Edit to apply the previous function point edits to the
new application analysis.

If any previously modified transactions are not found or a DET and RET (or FTR)
changed in the reanalyzed programs, an exceptions list is produced.

To view the exceptions list, follow this step:
» From the Edit - Function Points pop-up or the FP Task Manager screen, select Preview

Previous Function Type Edits that cannot be applied to display the Preview Previous
Function Type Edits that cannot be applied screen.



Report Descriptions

This chapter describes and illustrates each report generated by Recap and contains these

sections:

Report Headings 83
Report Help 84
Table of Contents 84
Application Summary 87
Executive Summary Report 89
Application Definition Report 91
Application Function Point Analysis Report 94
Program Metrics History Report 103
Program Comparison Report 109
Application Metrics Report 113
Application Exceptions Report 116
Application Comparison Report 118
Application Progress Report 125
Enterprise Metrics Report 127
Enterprise Exceptions Report 130
Master Index 133
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Application portfolio analysis information is used to assess the quantity and quality of an
Information Service organization's software portfolio products. This information can then
be used to accomplish these tasks:

. Develop process improvement initiatives

. Track the impact of program changes and enhancements
. Evaluate re-development options

. Verify adherence to quality standards

. Evaluate vendor product quality

. Cost justify development and maintenance staffing levels

Recap automates the portfolio analysis process and generates a collection of reports that
contain this information:

. Function point analysis

. Software quality and complexity metrics

. Enterprise/application/program exceptions

. Metrics history

. Comparative analysis statistics

. Progressive analysis statistics

All or selected reports can be generated simultaneously with an analyze job or at a later

date. The report data can also be exported to a comma delimited file that can be used in
database, spreadsheet, or graphic presentation packages.

See the ASG-Application Definition and Analysis User’s Guide for more information
about generating reports simultaneously with an analyze job.

See "Export Metrics Facility" on page 175) for more information on exporting
information.




6 Report Descriptions

Report Headings

The Recap reports contain a standard heading unless otherwise specified, shown in

Figure 37.

Figure 37 « Report Heading Example

ASG-PECAD-0S(ESA) Px.x LWLaxx (&) PROGRAM COMPARTSON (Bl DD -MMM-TTTT HH-MM: 32 DACE 1

APPLICATION: SALES (C) VERSION: 1 G} (D (E}
PROGCTAM: CM421 (F)

Report Field Descriptions

Field Description

(A)

Product name, operating system, release number, and maintenance level.

(B)

Title of the report.

©)

Name of the application for which the report was generated. On the
application comparison, application progress, and enterprise reports, the
name of the AKR containing the applications displays in this field.

(D)

Date and time the report was generated.

(E)

Page number of the report. The Table of Contents and the Application
Summary are not page numbered.

(F)

On the Program Metrics History report, the name of the program for which
the report was generated displays here.

(©)

Application version number assigned after the application was analyzed.
This field displays in the headings only on these reports:

. Program Comparison Report
. Application Metrics Report

. Application Exceptions Report
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Report Help

All reports except for the Executive Summary begin with a help section providing
definitions and usage notes. For example, the help section on the Program Metrics
History report, shown in Figure 38, explains the purpose of programs metrics and defines
the metrics included on the report.

Figure 38 « Report Help Example

ASG-RECAP-0S (ESA) Rx.x LVLxxx PROGRAM METRICS HISTORY D-MMM-YYYY HH:MM:SS PAGE 210

APPLICATION: SALES

PROGRAM METRICS HISTORY HELP

SOFTWARE METRICS PROVIDE COMPLEXITY, PROGRAM ARCHITECTURE, AND

SOFTWARE QUALITY ASSESSMENTS THAT INDICATE THE CONDITION OR STATE

OR STATE OF EACH PROGRAM. TWENTY VERSIONS OF METRIC DATA ARE

RETAINED FOR EACH PROGRAM. THE PROGRAM METRICS HISTORY PROVIDES GRAPHS
FOR SOFTWARE SCIENCE VOLUME METRIC, CYCLOMATIC COMPLEXITY, ESSENTIAL
COMPLEXITY, CONTROL VARIABLE, AND KNOTS.

SOFTWARE SCIENCE VOLUME METRIC

SOFTWARE SCIENCE VOLUME METRIC IS PRIMARILY SIZE OR VOLUME METRICS BASED
ON THE PREMISE THAT THE LARGER THE PROGRAM, THE MORE DIFFICULT IT IS TO
UNDERSTAND AND MAINTAIN.

CYCLOMATIC COMPLEXITY METRIC

CYCLOMATIC COMPLEXITY METRIC MEASURES LOGICAL FLOW PATHS. THIS METRIC
IS BASED ON THE PREMISE THAT THE NUMBER OF PATHS IN A PROGRAM DETERMINE
HOW DIFFICULT IT IS TO UNDERSTAND.

ESSENTIAL COMPLEXITY METRIC

ESSENTIAL COMPLEXITY QUANTIFIES THE DEGREE OF LOGICAL STRUCTURE OF A
PROGRAM, I.E. THE DEGREE TO WHICH A PROGRAM HAS BEEN CONSTRUCTED USING
ONLY THE STANDARD STRUCTURED CONTROL FLOW CONSTRUCTS.

CONTROL VARIABLE METRIC

CONTROL VARIABLE METRIC MEASURES LOGICAL FLOW PATHS WITH THE NUMBER OF
PROGRAM CONTROL VARIABLES ALSO CONSIDERED. THIS METRIC IS BASED ON THE
PREMISE THAT PROGRAMS WITH EQUAL FLOW PATHS, BUT MORE VARIABLES
CONTROLLING THE FLOW, ARE MORE DIFFICULT TO UNDERSTAND AND MAINTAIN THAN
PROGRAMS WITH FEWER CONTROL VARIABLES.

CONTROL FLOW KNOTS
THE KNOTS METRIC IS A COUNT OF THE NUMBER OF INTERSECTIONS OF CONTROL

FLOW PATHS, HENCE IT QUANTIFIES THE DEGREE OF PHYSICAL STRUCTURE OF
A PROGRAM.

Table of Contents
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The Table of Contents, generated for the reports, is divided into these sections if all
reports are chosen. If only some of the reports are generated, the Table of Contents
reflects the selection.




II.

III.

Iv.

VL

Overview

1. Executive Summary

2. Application Definition
Function Point Analysis

1. Application Function Point Analysis
Program Metric Information

1. Program Metrics History

2. Program Comparison

3. Program Progress
Application Metric Information
1. Application Metrics

2. Application Exceptions

3. Application Comparison

4. Application Progress
Enterprise Metric Information
1. Enterprise Metrics

2. Enterprise Exceptions

Master Index

6 Report Descriptions
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Figure 39 shows the Table of Contents when all reports are generated.

Figure 39 « Table of Contents Report

ASG-RECAP-0S (ESA) Rx.x LVLXxxX TABLE OF CONTENTS APPLICATION: SALES DD-MMM-YYYY HH:MM:SS
() % kR ok ko ok ok ko ok ko ok ok Kok K Kk ok K Kk o Kk ok K K S Kk ok K Kk ok Kk ok ok Kk ok ok Kk ok Kk ok K Kok ok Kk ok K Kk K Kk Kk
* *
* APPLICATION DESCRIPTION: SALES INFORMATION *
* *

R R R

(B) ()
I. OVERVIEW

1. EXECUTIVE SUMMARY 1

2. APPLICATION DEFINITION 2

II. FUNCTION POINT ANALYSIS
1. APPLICATION FUNCTION POINT ANALYSIS 3

III. PROGRAM METRIC INFORMATION

1. PROGRAM METRICS HISTORY 6
2. PROGRAM COMPARISON 8
3. PROGRAM PROGRESS 12

IV. APPLICATION METRIC INFORMATION

1. APPLICATION METRICS 20
2. APPLICATION EXCEPTIONS 22
3. APPLICATION COMPARISON 26
4. APPLICATION PROGRESS 30

V. ENTERPRISE METRIC INFORMATION

1. ENTERPRISE METRICS 33
2. ENTERPRISE EXCEPTIONS 34
VI. MASTER INDEX 35
Field Descriptions
Field Description
(A) Application Description specified on the Application - Description pop-up.
The default is the TSO user ID where the application was defined.
(B) List of reports generated for the application.
©) Page number on which the particular report begins.
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Application Summary

Application Summary information (Figure 40 on page 88) is shown on the page
following the Table of Contents and includes this information:

. Name of the AKR containing the application

. Name of the application

. Application version number

. Number of programs defined to the application

. Number of programs analyzed

. Number of Code Exceptions affecting application quality
. Metrics information for the application

. Parameters specified for the current execution of Recap

. Options in effect for the current execution of Recap
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Figure 40 « Application Summary

ASG-RECAP-0S (ESA) Rx.x LVLxxx APPLICATION SUMMARY DD-MMM-YYYY HH:MM:SS
(B)

R R R RS SRR RS SRR R RS SRR RS SRR E SRR RS SRR RS SRR EEEREREEEEEREEEEEREEEEREEEEEEEEEEEEE]
* *
* AKRNAME. . . . . . . . . . . . . . VIAXE20.PROD.SAMPAKR *
* APPLICATION NAME. . . . . . . . . . SALES *
* VERSION. . . . . . . « . . . . ..1 *
* COBOL PGMS DEFINED. . . . . . . . . 37 *
* COBOL PGMS SUCCESSFULLY ANALYZED. . 31 *
* *
* CODE EXCEPTIONS AFFECTING APPLICATION QUALITY: *
* GO TOS . « . « « . . . . .. .. 3864 *
* ALTERS . . . . . . . o . . . .. 20 *
* ANOMALOUS ENTRIES. . . . . . . . 1 *
* ANOMALOUS EXITS. . . . . . . . . 6 *
* RECURSIONS . . . . . . . . . . . 3794 *
* OUT OF PERFORM RANGE JUMPS . . . 10256 *
* LIVE EXITS . « . « « « « o . . . 571 *
* DEAD CODE. . . . . . . . . . . . 1100 *
* DEAD DATA. . . . . . . . . . . . 3 *
* *
* METRIC INFORMATION: *
* -APPLICATION- —------- ENTERPRISE------—-— *
* METRIC TYPE TOTAL AVERAGE STANDARD DEV  *
K e e e *
* ADJUSTED FUNCTION POINTS . . . . 514 293 96 *
* ENHANCEMENT FUNCTION POINTS. . . 0 0 0o x
* SOFTWARE SCIENCE VOLUME. . . . . 1315573 630457 283961  *
* CYCLOMATIC COMPLEXITY . . . . . 17646 3555 4804  *
* ESSENTIAL COMPLEXITY . . . . . . 7445 1263 2146 *
* CONTROL VARIABLE . . . . . . . . 23067 5968 5954  *
* KNOTS. .« « v v v v v v o v o 19279 3503 5587  *
* NUMBER OF LINES OF CODE. . . . . 34731 22652 7116 *

*

*

R R AR A A R R LS

Kok ok ok k ok kkk kK k ok ok kkkkk kX k ok kkkkkk ok kA k ok kkk kA kkk ok kkkkkk ok kkkkkk ok ko hkkkkkkkhkkkkkhkkkkkkkkkhkkkhkhkkkkkkhkkkhkkkkkkkk*

Kok ok ok ok kkkkkkkkkkkk ok kkkhkk ok kk Kk kkk ok kA kkkkk ok kA kkkkk ok kkkkkk ok kkkkk ok kkkkkkkkkkkkkkkkkkkkkkkkkkkkkk ok kkk ok ok k ok kk k& kk ok kKK
(B)

ASG-RECAP WAS RUN WITH THE FOLLOWING PARAMETERS:

DS=SRENTTG, UN=SRTDA, APPL=SALES, PH, PF

()
OPTIONS IN EFFECT: BANNER, COLON=:, LINESPERPAGE=60, VCHAR=|, APLDEF, EXCSUM, PGMFPA, APLCMP, APLMTC,
APLPRG, APLFPA, APLEXC, PGMCMP, PGMHST, PGMPRG, ENTMTC, ENTEXC

Field Descriptions

Description

(A) Summary information, including the AKR and application name, application
version number, number of programs defined to the application, number of
programs analyzed, code exceptions, and metrics information showing the
totals for the application metrics and the averages and standard deviations for
the enterprise.

(B) List of the parameters in effect for this execution of Recap.

©) Report options in effect for this execution of Recap.
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Executive Summary Report

The Executive Summary Report provides a summary of the portfolio analysis
information including general information about the analysis and a high level discussion
of the results. This discussion includes recommended actions for the IT organization to
take based on the reported results.

The contents and structure of the Executive Summary, shown in Figure 41, can be
changed to meet the specific needs of your organization by using the Report Generator
Language included with the product. See Chapter 7, "Report Generator Language." on
page 135, for more information.

Figure 41 « Executive Summary Report

ASG-RECAP-0S (ESA) Rx.x LVLxxx EXECUTIVE SUMMARY DD-MMM-YYYY HH:MM:SS PAGE 1
APPLICATION: SALES

(B)
GENERAL INFORMATION

The SALES (SALES INFORMATION) application inventory analysis was performed on DD-MMM-YYYY at HH:MM:SS. There
is one historical version of the application. It consists of 37 analyzed programs. For additional details refer
to the Application Definition Report.
(B)
APPLICATION COMPARATIVE ANALYSIS

The SALES application was compared against 9 other applications (refer to the Enterprise Metrics Report for
the names of other applications).

In comparison with the other 9 applications in this assessment, SALES has a high Adjusted Function Point

value (687), an Enhancement Function Point value of 0, and at the same time it has many Lines Of Code (56128).
This indicates a large application with good business value which may be hard to maintain. The programs within
this application have a high number of lines of code per program (1517). SALES has a high Functional Complexity
(27) (where Functional Complexity = Cyclomatic Complexity/Adjusted Function Points) and a high technical
complexity as shown by the Cyclomatic Complexity (18537), indicating a conceptually difficult application. The
Essential Complexity (7577) indicates that SALES has a poor logical structure. This correlates with the poor
physical structure shown by the Knots value (19664). Of the 10 applications assessed, SALES has a relatively
large number of Code Exception Conditions. Refer to the Function Point Analysis, Enterprise Metrics and
Enterprise Exceptions Reports for additional details.

Due to the poor physical structure for an application with a high business value, we recommend that you
restructure the application. 1In addition to the option of restructuring, the application could benefit from
re-engineering because it has high technical complexity and poor physical structure, but provides good business
value. The application contains a high number of exceptions that should be corrected to prevent flow problems
(refer to PROGRAM COMPARATIVE ANALYSIS below) .
()
PROGRAM COMPARATIVE ANALYSIS

Of the 37 programs in the application, 36 programs have code exceptions which may cause the programs to
function differently than expected. We strongly recommend that you locate the program exceptions and correct
them. Refer to the Application Exceptions Report for additional information.

Of the 37 programs, 2 programs are more than 1 standard deviation greater than the average for Software

Science Volume, 2 programs are more than 1 standard deviation greater than the average for Cyclomatic
Complexity, 2 programs are more than 1 standard deviation greater than the average for Control Variable
Complexity, and 5 programs are more than 1 standard deviation greater than the average for Lines Of Code. If
these programs provide important business functions, they may be candidates for re-engineering or decomposition.
Refer to the Application Metrics or Program Comparison Report for additional details.

Of the 37 programs, 2 programs are more than 1 standard deviation greater than the average for Essential
Complexity, and 1 program is more than 1 standard deviation greater than the average for Knots Count. If these
programs show a history of difficult maintenance and they perform important business functions, they may be
candidates for restructuring.

No information is available to report how many programs have changed significantly.
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Report Field Descriptions

Field Description

(A) General information about the application analysis including date and time of
analysis, application version number, and the number of programs defined to
the application.

(B) Summary of the Application Comparative Analysis including:

e Number of applications compared

. Interpretation of the portfolio analysis information in respect to the
other applications

. Recommended actions

. References to other reports for additional information

©) Summary of the Program Comparative Analysis including:

. Number of programs compared

. Interpretation of the portfolio analysis information in respect to other
programs

. Recommended actions
. References to other reports for additional information

. The amount programs have changed since the last analysis was
performed
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Application Definition Report

The Application Definition Report (Figure 42 on page 92) provides a hierarchical view of
all libraries defined to the application. Each library is shown with this information:

Members/programs
Copylibs

Proclibs

Compile parms
IDMS information
Maclibs

Group names

If a member/program has its own compiler information, the information is shown under
that member/program and overrides the corresponding information specified for the

library. See "Building and Analyzing an Application" on page 23 for more information
about defining programs.

The Application Definition report also displays the user ID of the person who last
modified the application definition and the date the modification was made.
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Figure 42 » Application Definition Report

ASG-RECAP-0S (ESA) Rx.xX LVLxxX

(A)

APPLICATION DEFINITION
APPLICATION: SALES

LAST MODIFIED BY VIAMXM ON DD-MMM-YYYY AT HH:MM:SS

(B)

VIAXE21.PROD.SAMPAKR (SALES)

(C)

LIBRARY (COBOL)

ASG.COBOL.

(D)

(E)

I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I——>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>
I—=>

PANLIB - PAN

--> ASM/COMPILE OPTION

COBOL VERSION: COBOL74

--> MEMBER/PROGRAM-ID

CM431/CM431
DB204/DB204
E02031/E02031
GENAMER1/GENAMER1
IC110/IC110
IC120/1IC120
1C207/1C207
IC217/1C217
IX203/1X203
IX214/1IX214
KC601/KC601
NC110/NC110
NC119/NC119
NC154/NC154
NC165/NC165
NC209/NC209
NC217/NC217
NC431/NC431
RL151/RL151
RL431/RL431
5G203/5G203
SQ110/S0Q110
50120/S0Q120
50205/50205
50215/50215
ST110/ST110
ST201/ST201
ST211/ST211
ST441/ST441
TH205/TH205
TH215/TH215

LIBRARY (COBOL)
ASG.CUST.COBOL - PDS

f——>
(F)
|

--> COPYLIB(S)

ASG.COBOL.COPYLIB - PDS COBOL
ASG.CUST.COBOL - PDS COBOL
ASG.COBOL.COPYLIB2 - PDS COBOL

--> ASM/COMPILE OPTION

COBOL VERSION: COBOLII R3

--> MEMBER/PROGRAM-ID

VS401/Vs401

|--> COPYLIB (S)
| ASG.VS401.COPYLIB - PDS COBOL
| ASG.COBOL.COPYLIB - PDS COBOL
| -=> ASM/COMPILE OPTION

COBOL VERSION: COBOL74
VS402/VS402
VS403/VS403
VS404/VS404
VS405/VS405
VS406/Vs406

DD-MMM-YYYY HH:MM:SS PAGE

2
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Report Field Descriptions

Field Description

(A) The user ID of the person who last modified the application definition and the
date the modification was completed.

(B) The name of the AKR and application.

©) Library name including source manager.

(D) Copylibs, proclibs, compile parms, IDMS information, maclibs, or group
names defined to the library.

(E) Member name and Program ID as coded in the COBOL program.

(F) Copylibs, proclibs, compile parms, IDMS information, or maclib defined to

the member/program.
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Application Function Point Analysis Report

The Application Function Point Analysis report shows an unadjusted function point value
for the application. The report format consists of a table showing the total element type
counts for the entire application, followed by tables showing the detail for each element
type. The report also consists of the Total Unadjusted Function Point for the application
and the General System Characteristics worksheet showing the general systems
characteristics to calculate the adjusted function point value for the application.

Note:

See "Concepts" on page 7 for more information about calculating unadjusted and
adjusted function points for an application.

External Input Type Table

Figure 43 shows an example of the External Input Type table.

Figure 43 « External Input Type Table

ASG-RECAP-0S (ESA) Rx.x LVLXxx APPLICATION FUNCTION POINT ANALYSIS DD-MMM-YYYY HH:MM:SS PAGE 120
APPLICATION: SALES

(A)
EI - EXTERNAL INPUT TYPE
(B) (C) (D) (E)
NUMBER TRANSACTION FTR DET CMPLX MANUAL
1 RECEIVE CM-INQUE SEGMENT INTO INCOMING-MSG 1 11 LOW NO
2 MERGE ST-FS4 ON ASCENDING KEY SORT-KEY USING SQ-FS1 SQ-FS2 * 2 2 LOW NO
3 WRITE REC-3 (FD ST-FS4) 2 1 Low NO
4 WRITE IX-FS1R1-F-G-240 (FILE-RECORD-INFO) 1 3 Low NO
5 WRITE NOTICE-TAPE-HEADER-RECORD FROM NOTICE-TAPE-RECORD 0 4 Low NO
6 WRITE SAVED-NOTICE-TAPE-HDR-REC FROM NOTICE-TAPE-RECORD 0 4 Low NO
7 WRITE FRA-INQUIRY-REC FROM FRA-INQUIRY-TN 0 6 Low NO
8 WRITE 200-CHAR-COMP-S-O-REC FROM COMPLETED-S-O-FIELD 0 1 Low NO
115 EXEC CICS RECEIVE MAP (MAPNAME) MAPSET (MAPSET) INTO (DCPREMOI* 1 67 AVG NO
116 EXEC CICS REWRITE DATASET ('DCPRF000') FROM(SPO-FILE-AREA) L* 1 48 AVG NO
117 EXEC CICS WRITE DATASET ('DCPRF(000') FROM(SPO-FILE-AREA) LEN* 1 48 AVG NO
118 EXEC CICS RECEIVE MAP (MAPNAME) MAPSET (MAPSET) INTO (DCPREMII* 1 229 AVG NO
119 EXEC CICS RECEIVE MAP (MAPNAME) MAPSET (MAPSET) INTO (DCPREULI* 1 223 AVG NO
120 EXEC CICS REWRITE DATASET ('DCPRF001') FROM(SP1-RECORD-TYPE-* 1 20 AVG NO
121 EXEC CICS REWRITE DATASET ('DCPRF001') FROM(SP1-RECORD-TYPE-* 1 47 AVG NO
122 EXEC CICS WRITE DATASET ('DCPRF(001') FROM(SP1-FILE-AREA) LEN* 1 11 LOow NO
123 EXEC CICS RECEIVE MAP (MAPNAME) MAPSET (MAPSET) INTO (DCPREM3I* 1 29 AVG NO
124 EXEC CICS REWRITE DATASET ('DCPRF000') FROM(SPO-FILE-AREA) L* 1 48 AVG NO
(F) TOTALS LOW = 61 AVERAGE = 59 HIGH = 4
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6 Report Descriptions

Report Field Descriptions

Field Description

(A)

Name of element type.

(B)

The sequence number of external inputs in the application.

©

The transaction that generated the external input element.

(D)

The function point values for each transaction, including the number of file
types referenced (FTR), the number of Data Element Types used (DET), and
the level of complexity assigned to the element (CMPLX = high, average, or
low).

(E)

This field indicates whether function point information for the transaction
was manually changed.

(F)

The function point totals for all external input elements counted for the
application.
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External Output Type Table

Figure 44 shows an example of the External Output Type table.

Figure 44  Extern

al Output Type Table

ASG-RECAP-0S (ESA) Rx.x LVLxxX APPLICATION FUNCTION POINT ANALYSIS DD-MMM-YYYY HH:MM:SS PAGE 123

APPLICATION: SALES

(A)
EO - EXTERNAL OUTPUT TYPE
(C) (D) (E)
TRANSACTION FTR DET CMPLX MANUAL
SEND CM-OUTQUE FROM SENT-WITH-ESI WITH ESI AFTER ADVANCING * 1 5 LOow NO
SEND CM-OUTQUE FROM SENT-WITH-EMI WITH EMI 1 5 LOW NO
SEND CM-OUTQUE FROM SENT-WITH-IDENTIFIER WITH END-IDENTIFIE* 1 5 LOW NO
SEND CM-OUTQUE WITH END-IDENTIFIER 1 5 LOow NO
SEND CM-OUTQUE FROM SENT-WITH-EGI WITH EGI AFTER ADVANCING * 1 5 Low NO
READ SQ-FS1 1 1 Low NO
READ SQ-FS2 1 1 Low NO
READ SQ-FS3 1 1 Low NO
READ JOB-SALARY-RANGE-FILE 1 7 Low NO
READ PERSONNEL-MSTR-FILE 1 143 AVG NO
EXEC CICS READ DATASET ('DCPRF001') INTO(SP1-RECORD-TYPE-P) * 1 20 AVG NO
EXEC CICS READ DATASET ('DCPRF001') INTO(SP1-FILE-AREA) LENG* 1 11 Low NO
EXEC CICS SEND MAP (MAPNAME) MAPSET (MAPSET) FROM(DCPREM10) C* 1 77 AVG NO
EXEC CICS SEND MAP (MAPNAME) MAPSET (MAPSET) FROM(DCPREU10O) C* 1 75 AVG NO
EXEC CICS READ DATASET ('DCPRF000') INTO(SPO-FILE-AREA) RIDF* 1 48 AVG NO
EXEC CICS READ DATASET ('DCPRF001') INTO(SP1-FILE-AREA) RIDF* 1 11 Low NO
EXEC CICS READ DATASET ('DCPRF001') INTO (SP1-RECORD-TYPE-C) * 1 47 AVG NO
EXEC CICS SEND MAP (MAPNAME) MAPSET (MAPSET) FROM(DCPREM30) C* 1 12 Low NO
TOTALS LOW = 43 AVERAGE = 14 HIGH = 0

Report Field Descriptions

Field Description
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(A)

Name of element type.

(B)

The sequence number of external inputs in the application.

©

The transaction that generated the external input element.

(D)

The function point values for each transaction, including the number of file

types referenced (FTR), the number of Data Element Types used (DET), and
the level of complexity assigned to the element (CMPLX = high, average, or
low).

(E)

This field indicates whether function point information for the transaction
was manually changed.

(F)

The function point totals for all external input elements counted for the
application.




6 Report Descriptions

External Inquiry Type Table
Figure 45 shows an example of the External Inquiry Type table.

Figure 45 » External Inquiry Type Table

APPLICATION FUNCTION POINT ANALYSIS
APPLICATION: SALES

ASG-RECAP-0S (ESA) Rx.x LVLxxX DD-MMM-YYYY HH:MM:SS PAGE 124

(A)
(B) EQ - EXTERNAL INQUIRY TYPE
NUMBER

(C)
TRANSACTION

(E)
MANUAL

TOTALS LOW = 0 AVERAGE = 0

Report Field Descriptions

Field Description

(A) Name of element type.

(B) The sequence number of external inquiries in the application.

©) The transaction that generated the external inquiry element.

D) The function point values for the transaction including the number of file
types referenced (FTR), the number of Data Element Types included (DET),
and the level of complexity assigned to the element (CMPLX = high, average,
or low).

(BE) This field indicates whether the function point information for the transaction
was manually changed.

F) The function point totals for all external inquiry elements counted for the

application.
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Internal Logical File Type Table
Figure 46 shows an example of the Internal Logic File Type table.

Figure 46 » Internal Logic File Type Table

ASG-RECAP-0S (ESA) Rx.x LVLxxX APPLICATION FUNCTION POINT ANALYSIS DD-MMM-YYYY HH:MM:SS PAGE 124
APPLICATION: SALES

(A)
ILF - INTERNAL LOGICAL FILE TYPE
(B) (C) (D) (E)
NUMBER DATA ELEMENT RET DET CMPLX MANUAL
1 FD SQ-Fs1 1 1 Low NO
2 FD SQ-FS2 1 1 Low NO
3 FD SQ-FS3 2 2 Low NO
4 FD IX-FS1 3 45 AVG NO
5 FD ALRU-SOR-INPUT-FILE 20 517 HIGH NO
6 FD SAVED-ALRU-SOR-INPUT-FILE 20 517 HIGH NO
7 FD FRA-INQUIRY-FILE 1 6 Low NO
8 FD COMPLETED-SERVICE-ORDER-FILE 19 19 AVG NO
9 FD SAVED-COMPLETED-SER-ORD-FILE 19 19 AVG NO
10 FD RL-FD1 2 2 Low NO
25 DCPRF000 1 48 Low NO
26 DCPRF001 3 78 HIGH NO
27 DCPRF002 1 6 Low NO
28 FD MSG-FILE 1 42 LOW NO
29 FD SPOOL-MASTER 8 83 HIGH NO
(F) TOTALS LOW = 20 AVERAGE = 5 HIGH = 4

Report Field Descriptions

Field Description

(A) Name of element type.

(B) The sequence number of internal logical file types in the application.

©) The data element that generated the internal logical file element.

(D) The function point values for each data element including the number of

Record Element Types (RET), the number of Data Element Types used
(DET), and the level of complexity assigned to the element (CMPLX = high,
average, or low).

(BE) This field indicates whether function point information for the data element
was manually changed.

(F) The totals for all internal logical file elements counted for the application.
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External Interface File Type Table

6 Report Descriptions

Figure 47 shows an example of the External Interface File Type table.

Figure 47 » External Interface File Type Table

ASG-RECAP-0S (ESA) Rx.x LVLxxX APPLICATION FUNCTION POINT ANALYSIS DD-MMM-YYYY HH:MM:SS PAGE 125
APPLICATION: SALES
()
(B) (C) EIF - EXTERNAL INTERFACE FILE TYPE (D) (E)
NUMBER DATA ELEMENT RET DET CMPLX MANUAL
1 FD JOB-SALARY-RANGE-FILE 1 7 Low NO
2 FD PERSONNEL-MSTR-FILE 2 144 HIGH NO
3 FD IB-ISAM-ORG-FILE 4 66 HIGH NO
4 FD IX-FD1 1 4 Low NO
5 FD CS-5-CHAR-USOC-FILE 1 1 Low NO
6 FD LINE-USOC-FILE 1 1 LOow NO
7 FD DESIGN-LINE-CPE-USOC-FILE 1 1 Low NO
8 FD MULTI-LINE-ACCT-CS-FILE 1 1 Low NO
9 FD BUSINESS-OFFICE-CODE-FILE 1 1 Low NO
10 FD USOC-GRPCD-TABLE-FILE 1 1 Low NO
18 FD SPOOL-1-MASTER 1 6 Low NO
19 FD SPOOL-2-MASTER 1 6 Low NO
20 FD CONTROL-FILE 5 34 AVG NO
21 FD DATASET-FILE-V 1 1 Low NO
22 FD DATASET-FILE 1 1 Low NO
(F) TOTALS LOW = 19 AVERAGE = 1 HIGH = 2

Report Field Descriptions

Field Description

(A)

Name of element type.

(B)

The sequence number of external interface file types in the application.

©)

The data element that generated the external interface element.

(D)

The function point values for each data element including the number of
Record Element Types (RET), the number of Data Element Types used
(DET), and the level of complexity assigned to the element (CMPLX = high,

average, or low).

(E)

This field indicates whether function point information for the data element

was manually changed.

(F)

The totals for all external interface file elements counted.
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Usage Notes

If the definition is not complete, Internal Logical File elements cannot automatically be
distinguished from External Interface File elements. In this case, the External Interface
elements are counted as Internal Logical File elements and listed in the Internal Logical
File Type table. If the definition is complete, the Internal Logical File elements are
automatically distinguished from External Interface File elements.

To determine the External Interface Element count

1 Select the Edit ILF from the Edit - Function Points pop-up or the FP Task Manager
screen to move the appropriate entities from the Internal Logical File element list to
the External Interface File element list.

2 To view the adjustments in the Application Function Point Analysis report,
regenerate the report.

Total Unadjusted Function Points by Element Types Table
Figure 48 shows an example of the Total Unadjusted FP by Element Types table.

Figure 48 » Total Unadjusted FP by Element Types

ASG-RECAP-0OS (ESA) Rx.x LVLxxx APPLICATION FUNCTION POINT ANALYSIS DD-MMM-YYYY HH:MM:SS PAGE 125
APPLICATION: SALES

(R)
TOTAL UNADJUSTED FUNCTION POINTS BY ELEMENT TYPES
(B) () (D)
DESCRIPTION Low AVERAGE HIGH TOTAL
EI - EXTERNAL INPUT TYPE 61 * 3 = 183 59 * 4 = 236 4 * 6 = 24 443
EO - EXTERNAL OUTPUT TYPE 43 * 4 = 172 14 * 5 = 70 0o x 7= 0 242
EQ - EXTERNAL INQUIRY TYPE 0 * 3= 0 0 * 4= 0 0 * 6= 0 0
ILF - INTERNAL LOGICAL FILE TYPE 20 * 7 = 140 5 * 10 = 50 4 * 15 = 60 250
EIF - EXTERNAL INTERFACE FILE TYPE 19 * 5 = 95 1* 7= 7 2 * 10 = 20 122
(E)
UFP - TOTAL UNADJUSTED FUNCTION POINTS -——=> 1057
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6 Report Descriptions

Report Field Descriptions

Field Description

(A)

The name of the table.

(B)

The description of the element type.

©

The function point value computed for the level of information processing
function associated with each element type. For each information processing
function category (Low, Average, High), the function point value is
calculated using this formula:

Function point value = number of elements *
information processing function

The information processing function values are assigned in accordance with
IFPUG standards.

D)

The Total Unadjusted Function Points for each element type. The total for
each element is calculated using this formula:

Total Unadjusted Function Points = Low function
point value +

Average function point value + High function point value.

(E)

The Total Unadjusted Function Points for the application.
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General System Characteristics Table

Figure 49 shows the General System Characteristics Table used to calculate the Total
Adjusted Function Points. The calculated values are placed on the Final Calculations
Table.

Figure 49 » General System Characteristics and Final Calculations

(A)
GENERAL SYSTEM CHARACTERISTICS

| # | DESCRIPTION \ DI | | # | DESCRIPTION \ DI
S S S S -
;Cl S*DATA COMMUNICATION ; 0 ; 3C8 3 ON-LINE UPDATE 3 0
T L R A
;CZ 3 DISTRIBUTED PROCESSING ; 0 ; 3C9 3 COMPLEX PROCESSING 3 0
O B S L T L
;C3 3 PERFORMANCE ; 0 ; 3C103 REUSABILITY 3 0 3
O L e A
;C4 3 HEAVILY USED CONFIGURATION ; 0 ; 3c113 INSTALLATION EASE 3 0
O P S i I
;C5 3 TRANSACTION RATES ; 0 ; 3C123 OPERATIONAL EASE 3 0
O L i A
;CG 3 ON-LINE DATA ENTRY ; 0 ; 3C133 MULTIPLE SITES 3 0 3
O S e B I
;C7 3 END USER EFFICIENCY ; 0 ; 3C143 FACILITATE CHANGE 3 0
Rl R - e R t----t
TDI - TOTAL DEGREE OF INFLUENCE (Cl + C2 + + C14) ——=> }__5_}
(B)

FINAL CALCULATIONS

| DESCRIPTION | EQUATION \ RESULT
S S, [
| i |
VAF | VALUE ADJUSTMENT FACTOR 1 0.65 + (0.01 * TDI) | 0.65
S o Vol ___
| i i
FP | TOTAL ADJUSTED FUNCTION POINTS | UFP * VAF H 687

Report Field Descriptions

Field Description

(A) This table provides the general systems characteristics values used to
calculate the total degree of influence. The enter these values, select Edit
GSC on the Edit - Function Points pop-up or the FP Task Manager screen.
The total degree of influence equals the sum of these values.

Note:

For more information on entering general systems characteristics
information, see "Computing the Function Point Value Adjustment Factor

on page 41.

"

(B) This table is used to record the Total Adjusted Function Points.
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Program Metrics History Report

6 Report Descriptions

The Program Metrics History report provides a metric value versus time graph for these
metrics: Software Science Volume, Cyclomatic Complexity, Essential Complexity,
Control Variable Complexity, and Control Flow Knots. The last 20 versions of each
metric are retained for each program and included in the Programs Metrics History

report.

Figure 50 shows the graph for Software Science Volume Metrics and Cyclomatic

Complexity.

Figure 50 « Program Metrics History Report (1 of 3)

ASG-RECAP-0S (ESA) Rx.x LVLxxx

APPLICATION:

PROGRAM: CM431

SOFTWARE SCIENCE VOLUME

(R) APPLICATION AVERAGE = 42438
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SOFTWARE SCIENCE VOLUME METRIC IS DEFINED AS FOLLOWS:
VOLUME = (TOTAL OPERATORS + TOTAL OPERANDS)
LOG2
(DISTINCE OPERATORS + DISTINCT OPERANDS)

PROGRAM METRICS HISTORY

DD-MMM-YYYY HH:MM:SS PAGE 101
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CYCLOMATIC COMPLEXITY
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(J)
CYCLOMATIC COMPLEXITY METRIC IS DEFINED AS FOLLOWS
COMPLEXITY OF THE PROGRAM IS EQUAL TO THE NUMBER
OF CONTROL FLOW PATHS IN THE PROGRAM
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Program Metrics History Report Field Descriptions (1 of 3)

Field Description

(A) The average and standard deviation for Software Science Volume values,
based on the last Software Science Volume values for all programs in the
application.

(B) A histogram of the Software Science Volume metric. Each column on the

histogram represents one version of the program.

©) Application version number assigned after the program was analyzed.

(D) Date that each version of the program was analyzed.

(E) The Software Science Volume metric is briefly described.

(F) The average and standard deviation for Cyclomatic Complexity values, based

on the last cyclomatic complexity values for all programs in the application.

(G) A histogram of Cyclomatic Complexity values. Each column on the
histogram represents one version of the program.

(H) Application version number assigned after the program was analyzed.
D Date that each version of the program was analyzed.
) The Cyclomatic Complexity Metric is briefly described.
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Figure 51 shows the histograms for Essential Complexity and Volume Control.

Figure 51 « Program Metrics History Report (2 of 3)

6 Report Descriptions

ASG-RECAP-0S (ESA) Rx.x LVLxxX
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Program Metrics History Report Field Descriptions (2 of 3)

Field Description

(A) The average and standard deviation for Essential Complexity values, based
on the last essential complexity values for all programs in the application.

(B) A histogram of the Essential Complexity metric. Each column on the
histogram represents one version of the program.

©) Application version number assigned after the program was analyzed.

(D) Date that each version of the program was analyzed.

(E) The Essential Complexity metric is briefly described.

(F) The average and standard deviation for Control Variable Complexity metric

values based on the last control variable complexity metric values for all
programs in the application.

(G) A histogram of Control Variable Complexity metric values. Each column on
the histogram represents one version of the program.

(H) Application version number assigned after the program was analyzed.
D Date that each version of the program was analyzed.
) The Control Variable Complexity metric is briefly described.
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Figure 52 shows the histograms for Control Flow Knots metric.

Figure 52 « Program Metrics History Report (3 of 3)

ASG-RECAP-0S (ESA) Rx.x LVLxxx PROGRAM METRICS HISTORY DD-MMM-YYYY HH:MM:SS PAGE 103
APPLICATION: SALES
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CONTROL FLOW KNOWS ARE DEFINED AS FOLLOWS:
THE SUM OF ALL POSSIBLE CONTROL FLOW INTERSECTIONS
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Program Metrics History Report Field Descriptions (3 of 3)

Field Description

(A) The average and standard deviation for Control Flow Knots values, based on
the last control flow knots values for all programs in the application.

(B) A histogram of the Control Flow Knots values. Each column on the
histogram represents one version of the program.

©) Application version number assigned after the program was analyzed.
(D) Date that each version of the program was analyzed.
(E) The Control Flow Knots metric is briefly described.
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6 Report Descriptions

Program Comparison Report

The Program Comparison Report, shown in Figure 53, compares specific metrics values
for each program in the application to the average values for all programs in the
application. The report consists of this self-scaling graph:

. The structure versus complexity graph represents essential complexity versus
cyclomatic complexity.

The report also includes a table listing the programs found in each quadrant of the graph.
On the structure versus complexity graph, the center for the quadrants is marked by the
intersection between the average cyclomatic complexity value and the average essential
complexity value.

Figure 53 « Program Comparison Report - Structure versus Complexity Graph (1 of 2)

ASG-RECAP-0OS (ESA) Rx.x LVLxxx PROGRAM COMPARISON DD-MMM-YYYY HH:MM:SS PAGE 194
APPLICATION: SALES VERSION: 1
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Program Comparison Report Field Descriptions (1 of 2)

Field Description

(A) The cyclomatic complexity values are graphed on the vertical axis.

(B) This solid line represents the average essential complexity for all programs
compared.

©) The essential complexity values are graphed on the horizontal axis.

(D) This dashed line represents the average cyclomatic complexity for all

programs compared.

(E) The intersection of the cyclomatic complexity average and the essential
complexity average marks the center of the four quadrants.

(F) The standard deviation box with the corners marked by a plus sign (+)
represents the standard deviation from the average. The top and bottom of the
box represent plus and minus one standard deviation for cyclomatic
complexity. The right and left borders represent plus and minus one standard
deviation for essential complexity.

(G) A histogram of Control Variable Complexity metric values. Each column on
the histogram represents one version of the program.
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6 Report Descriptions

Figure 54 shows the Program Location table listing the programs found in each quadrant
of the structure versus complexity graph.

Figure 54 « Program Comparison Report (2 of 2)

ASG-RECAP-0S (ESA) Rx.x LVLxxx PROGRAM COMPARISON DD-MMM-YYYY HH:MM:SS PAGE 195
APPLICATION: SALES VERSION: 1
() (B) (©) (D)

QUADRANT I (UPPER RIGHT) QUADRANT II (UPPER LEFT) QUADRANT III (LOWER LEFT) QUADRANT IV (LOWER RIGHT)
UNSTRUCTURED - HI COMPLEX STRUCTURED - HI COMPLEX STRUCTURED - LO COMPLEX UNSTRUCTURED - LO COMPLEX
GENAMERL (3107, 10865) cM431 (1, 22)
KC601 (4121, 5535) DB204 ( 5, 31)

E02031 (8, 48)

IC110 « 1, 1)

1C120 « 1, 2)

1C207 ( s, 33)

1C217 « 1, 1)

1X203 ( 10, 52)

X214 ( 45,  147)

NC110 « 1, 2)

NC119 ( s, 82)

NC154 « 1, 43)

NC165 « 1, 46)

NC209 ( s, 54)

NC217 ( s, 63)

NC431 « 7, 70)

RL151 (3, 14)

RL431 « 7, 31)

5G203 ( 15, 66)

SQ110 ( 25, 54)

S0120 ( 13, 54)

50205 ( 13, 58)

50215 ( s, 24)

ST110 « 1, 1)

ST201 ( 9, 75)

ST211 ( 9, 49)

ST441 ( s, 23)

TH205 ( 5, 50)

TH215 ( 5, 50)

GRAPH COORDINATES = (ESSENTIAL COMPLEXITY, CYCLOMATIC COMPLEXITY)

Program Comparison Report Field Descriptions (2 of 2) Program Progress Report

Field Description

(A) Programs that are more unstructured and more complex than the average are
listed in Quadrant 1.

(B) Programs that are more structured and more complex than the average are
listed in the Quadrant 2.

©) Programs that are more structured but less complex than the average are listed
in Quadrant 3.

(D) Programs that are less structured and less complex than the average are listed
in Quadrant 4.

The Program Progress report shows how each program in the application has progressed
by calculating the difference between the current and last values for each metric and each
exception.
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The Program Progress report, shown in Figure 55, includes this information: Program
version number, Software Science Volume, Cyclomatic Complexity, Essential
Complexity, Control Variable Complexity and Control Flow Knots metrics, number of

lines

of code, and program exceptions. For each metric and exception, the initial

(baseline) values, current values, and values from the previous version are provided. The
report also lists the difference (D) between the current metric and exception values and
the values from the previous version.

Figure 55 » Program Progress Report

ASG-RECAP-0S (ESA) Rx.x LVLxx

X PROGRAM PROGRESS DD-MMM-YYYY HH:MM:SS PAGE 244
APPLICATION: SALES

(B)

(B) (C) PROGRAM: CM431 (E) | PROGRAM: DB204

INITIAL CURRENT (D) PREVIOUS DELTA $DELTA | INITIAL CURRENT PREVIOUS DELTA $DELTA
(F) |
VERSION 1 2 1 | 1 2 1
SOFTWARE SCIENCE VOLUME 7056 7602 7311 291 4% | 10089 14576 13731 845 6%
CYCLOMATIC COMPLEXITY 22 27 23 4 17% | 31 49 40 9 23%
ESSENTIAL COMPLEXITY 1 1 1 0 0 | 5 3 4 1 25%
CONTROL VARIABLE 41 39 43 (4) (9) | 61 89 72 16 24%
KNOTS 14 0 13 13 - | 10 3 13 10 77%
NUMBER OF LINES OF CODE 377 487 408 79 19 | 470 737 659 78 12%
GO TOS 19 0 5 5 - | 20 5 8 3 38%
ALTERS 0 0 6 6 - 0 0 0 0 0%
ANOMOLOUS ENTRIES 0 0 0 0 0 | 0 0 0 0 0%
ANOMOLOUS EXITS 0 0 0 0 0 | 0 0 0 0 0%
RECURSIONS 0 0 0 0 0 | 0 0 0 0 0%
OUT OF PERFORM RANGE JUMPS 0 0 0 0 [ 0 0 0 0 0%
LIVE EXITS 0 0 0 0 0 | 0 0 0 0 0%
DEAD CODE 11 11 11 0 0 9 9 9 0 0%
DEAD DATA 3 3 3 0 0 | 3 3 3 0 0%

(G) INITIAL : STRUCTURED, LO COMPLEXITY | INITIAL : STRUCTURED, LO COMPLEXITY
CURRENT : STRUCTURED, LO COMPLEXITY | CURRENT : STRUCTURED, LO COMPLEXITY
PREVIOUS: STRUCTURED, LO COMPLEXITY | PREVIOUS: STRUCTURED, LO COMPLEXITY

Report Field Descriptions

Field Description

(A)

The name of the program.

(B)

The initial (baseline) values for the program portfolio analysis data.

©)

The current values for the program portfolio analysis data. If the program has
only been analyzed once, these values are the same as the initial values.

(D)

The values from the previous version of the program.

(E)

DELTA represents the absolute value of the difference between the current
and last values. The %DELTA is calculated using this formula:

$DELTA = (DELTA/LAST) * 100
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Field Description

(F) The type of portfolio analysis data is listed in this column.

(G) A description of the overall condition of the initial, last and current versions
of the program. For example, the current version of program CM431 is
structured and has a low complexity.

Note:

There may be programs that become obsolete but have history in prior versions. Those
programs have an asterisk (*) next to the version numbers.

Application Metrics Report

The Application Metrics report shows metrics and statistical information for programs in
the application. This information is included for each program:

. Metrics information: Values for Software Science Volume, Cyclomatic and
Essential Complexity, Control Variable, Control Flow Knots, and lines of code are
provided. If a metrics value is higher or lower than the high and low bounds
calculated for all programs in the application, HI or LO is listed to the right of the
value.

. Overall program condition: Structure and complexity classifications are assigned to
each program based on the metrics information for the program and the averages for
all programs. The classifications are low or high.

. Comparative statistics: The total, average, standard deviation, low bound and high
bound for each metric in the application is also reported. The low bound value is
obtained by subtracting the standard deviation from the average; if the result is a
negative number, a zero displays. The high bound value is obtained by adding the
standard deviation to the average. The high bound and low bound values determine
whether a program's metric values are flagged HI or LO.

The Application Metrics report information (Figure 56 on page 114) is listed in table
format. The first table shows non-conformant programs, if any. These programs have at
least one metric value greater than one standard deviation from the application average.
The second table displays conformant programs that have values within or lower than one
standard deviation from the average for all metrics. The third table displays the
comparative statistics.
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Figure 56  Application

Metrics Report

ASG-RECAP-0S (ESA) Rx.x LVLxxx

APPLICATION METRICS

DD-MMM-YYYY HH:MM:SS PAGE 206

APPLICATION: SALES VERSION: 1
(2)
NON-CONFORMANT
(B) (©) (D)
PROGRAM VOLUME CYCLOMATIC ESSENTIAL CNTL VAR KNOTS LINES CODE STRUCT CMPLX
NAME VALUE VALUE VALUE VALUE VALUE VALUE
GENAMER1 262572 HI 10865 HI 3107 HI 12307 HI 661 7092 HI ow HIGH
KC601 635414 HI(E) 5535 HI 4121 HI 8084 HI 17797 HI 10899 HI ow HIGH
(F)
CONFORMANT
PROGRAM VOLUME CYCLOMATIC ESSENTIAL CNTL VAR KNOTS LINES CODE STRUCT CMPLX
NAME VALUE VALUE VALUE VALUE VALUE VALUE
CM431 7056 22 1 41 14 379 HIGH Low
DB204 10089 31 5 61 10 474 HIGH Low
E02031 14949 48 8 122 18 882 HIGH Low
IC110 200 1 1 1 0 63 HIGH Low
IC120 245 2 1 3 0 100 HIGH Low
IC207 9855 33 5 66 17 396 HIGH Low
ICc217 115 1 1 1 0 42 HIGH Low
IX203 13644 52 10 106 15 610 HIGH Low
IX214 54980 147 45 296 125 1702 HIGH Low
NC110 648 2 1 2 1 61 HIGH Low
NC119 33470 82 5 162 93 1034 HIGH Low
NC154 15039 43 1 106 46 707 HIGH LOW
NC165 19314 46 1 98 46 799 HIGH Low
NC209 20583 54 5 138 78 776 HIGH Low
NC217 24633 63 5 131 43 875 HIGH Low
NC431 35310 70 7 150 13 1137 HIGH Low
RL151 4656 14 3 27 8 293 HIGH Low
RL431 11376 31 7 58 8 567 HIGH Low
SG203 17397 66 15 109 48 601 HIGH Low
SQ110 12618 54 25 109 46 514 HIGH Low
SQ120 11880 54 13 109 19 599 HIGH Low
SQ205 15273 58 13 119 217 560 HIGH Low
SQ215 5464 24 5 47 7 314 HIGH Low
ST110 70 1 1 1 0 73 HIGH Low
ST201 20313 75 9 152 49 806 HIGH Low
ST211 17892 49 9 113 39 795 HIGH Low
ST441 9918 23 5 49 8 525 HIGH Low
TH205 16731 50 5 150 24 588 HIGH Low
TH215 13869 50 5 149 19 468 HIGH Low
(G)
LEGEND: LO = VALUE < AVG. - STD. DEV. LOW = VALUE <= AVG. LOW BOUND = AVG. - STD. DEV. STD. DEV.
HI = VALUE > AVG. + STD. DEV. HIGH = VALUE > AVG. HIGH BOUND = AVG. + STD. DEV.
(H)
APPLICATION TOTAL/SUMMARY (NUMBER OF PROGRAMS = 31)
METRICS TOTAL AVERAGE STD. DEV. LOW BOUND HIGH BOUND
SOFTWARE SCIENCE VOLUME 1315573 42438 117345 0 159783
CYCLOMATIC COMPLEXITY 17646 569 2115 0 2684
ESSENTIAL COMPLEXITY 7445 240 895 0 1135
CONTROL VARIABLE 23067 744 2540 0 3284
KNOTS 19279 622 3138 0 3760
NUMBER OF LINES OF CODE 34731 1120 2152 0 3272
LEGEND: LO = VALUE < AVG. - STD. DEV. LOW = VALUE <= AVG. LOW BOUND = AVG. - STD. DEV. STD. DEV.

HI = VALUE > AVG. + STD

. DEV.

HIGH = VALUE > AVG.

HIGH BOUND = AVG. + STD. DEV.

= STANDARD DEVIATION

= STANDARD DEVIATION
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Report Field Descriptions

Field Description

(A) The first table presented in the Application Metrics report lists the metrics
and program condition for non-conformant programs. Non-conformant
programs are programs with one or more metrics values that are more than
one standard deviation higher than the application average.

(B) The program name is listed in this column.

©) The metrics values for each program are listed in columns two through seven.

(D) The overall condition of the program in terms of structure’ and complexityi
is listed in the last two columns. The values for each condition can be low or
high.

(E) If HI or LO displays to the right of a metrics value, that value is outside of the

high bound or low bound for the application.

(F) The metrics values and program condition for conformant programs are
presented in this table. Conformant programs are defined as programs whose
metrics values are within one standard deviation of the application average or
whose values are lower than the application average which indicates good
structure, and complexity.

(G) The legend that displays defines the formulas used to calculate the high and
low bounds for metrics values. The low bound is calculated using this
formula:

LOW BOUND = AVERAGE - STANDARD DEVIATION

The AVERAGE and STANDARD DEVIATION values are the values
calculated for the application. If a program metric has a value less than LOW
BOUND, that metric is marked LO.

The high bound is calculated using this formula:
HIGH BOUND = AVERAGE + STANDARD DEVIATION
If a program metric has a value greater than HIGH BOUND, it is marked HI.

(H) The Application Total/Summary table provides a list of application totals,
averages, standard deviations, low bounds, and high bounds calculated for
each metric. The number of programs listed is the number of programs
successfully analyzed.

T Calculated using the Essential value column. The Program Essential Value is compared to the Application
Average. If the program value is less than or equal to the application, the structure is marked high. Otherwise it is
marked low. Therefore, the lower the Essential Value, the higher the structure.

i Calculated using the Cyclomatic value column. The Program Cyclomatic value is compared to the Application
Average. If the program value is greater than the Application Average, the complexity is marked high. Otherwise it
is marked low. Therefore, the higher the Cyclomatic value, the more complex the program.
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Application Exceptions Report

The Application Exceptions report (Figure 57 on page 117) shows code exceptions
affecting the quality of programs in the application.

Note:

If programs within an application have a high number of exceptions, run a SmartDoc
analysis to locate and correct the exceptions. See the ASG-SmartDoc User’s Guide for
more information.

These items are reported on the Application Exceptions report:

Item Description

GO TOS The number of GOTOs and ALTERS in the application.

ALTERS The number of ALTERS in the application.

ANOMOLOUS  The number of ENTRY statements in the application.
ENTRIES

ANOMOLOUS  The number of STOP RUN, GOBACK, or EXIT PROGRAM verbs
EXITS and CALL statements that are indicated as NORET (non-returning).

RECURSION The number of occurrences of recursion in the application. Recursion
generally occurs when a paragraph or perform range performs itself.
This type of programming technique can lead to endless loops.

JUMPS (OUT OF = The number of out of perform range jumps in the application. An exit

PERFORM is made from a perform range, due to the use of a GOTO, bypassing

RANGE JUMPS)  the normal perform range return to the line following the perform
statement.

LIVE EXITS The number of live exits in the application. Live exits are exits from

perform ranges that are left dangling by overlapping PERFORMs and
GOTOs in the original performed paragraphs. Internally, the COBOL
compiler creates a jump statement to return to the caller at the end of
a perform range. When the jump is actually performed, the jump
statement is cleared. If an exit is made from the perform range before
the jump statement is cleared (the normal flow is changed), the
internal jump statement is left live. If an overlapping perform range is
subsequently executed, the jump statement set by the original perform
range is still live and causes the program to jump back to the location
of the first caller to that perform range. This results in the program not
executing as expected.
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Description

DEADCODE The number of lines of dead code in the application. Dead code
statements are PROCEDURE DIVISION statements that never
execute.

DEADDATA The number of dead data occurrences in the application. Dead data
occurrences are unreferenced data items or data items only referenced
in DEADCODE.

Figure 57 « Application Exceptions Report

ASG-RECAP-0S (ESA) Rx.x LVLxxx APPLICATION EXCEPTIONS DD-MMM-YYYY HH:MM:SS PAGE 208
APPLICATION: SALES VERSION: 1
(B) (B)
PROGRAM NUMBER OF NUMBER OF NUMBER OF NUMBER OF NUMBER OF NUMBER OF NUMBER OF LINES OF LINES OF
NAME GO TOS ALTERS A-ENTRIES A-EXITS RECURSION JUMPS LIVE EXIT DEAD CODE DEAD DATA
CM431 19 0 0 0 0 0 0 11 0
DB204 20 0 0 0 0 0 0 9 0
E02031 14 0 0 1 0 0 0 1 0
GENAMER1 497 0 1 2 3793 6077 565 104 0
IC110 0 0 0 0 0 0 0 0 1
IC120 0 0 0 0 0 0 0 8 0
IC207 19 0 0 0 0 0 0 7 0
IX203 24 0 0 0 0 0 0 7 0
IX214 122 0 0 0 0 0 0 18 0
KC601 2179 0 0 2 1 4135 3 44 0
NC110 4 1 0 0 0 0 0 3 0
NC119 158 0 0 0 0 0 0 156 0
NC154 77 0 0 0 0 0 0 82 0
NC165 85 0 0 0 0 0 0 109 0
NC209 117 0 0 0 0 0 0 138 0
NC217 60 0 0 0 0 0 0 100 0
NC431 19 2 0 0 0 0 0 8 0
RL151 13 0 0 0 0 0 0 12 0
RL431 11 0 0 0 0 0 0 7 1
5G203 103 17 0 0 0 1 0 53 0
SQ110 47 0 0 0 0 0 0 5 0
SQ120 28 0 0 0 0 15 0 5 0
50205 49 0 0 0 0 0 0 11 0
SQ215 8 0 0 0 0 0 0 7 0
ST110 0 0 0 0 0 0 0 0 1
ST201 73 0 0 0 0 28 3 99 0
ST211 46 0 0 1 0 0 0 38 0
ST441 9 0 0 0 0 0 0 44 0
TH205 40 0 0 0 0 0 0 7 0
TH215 23 0 0 0 0 0 0 7 0
(C)

APPLICATION TOTAL/SUMMARY (NUMBER OF PROGRAMS = 30)

EXCEPTIONS TOTAL

GO TOsS 3864

ALTERS 20

ANOMALOUS ENTRIES 1

ANOMALOUS EXITS 6

RECURSIONS 3794

OUT OF PERFORM RANGE JUMPS 10256

LIVE EXITS 571

DEAD CODE 1100

DEAD DATA 3

LEGEND: JUMPS = OUT OF PERFORM RANGE JUMPS A-ENTRIES = ANOMALOUS ENTRIES A-EXITS = ANOMALOUS EXITS
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Report Field Descriptions

Field Description

(A) The names of the programs in the application.

(B) These columns list the number and type of exceptions found in the program.

©) The Application Total/Summary table lists the application totals for each
type of exception. The number of programs is the number of successfully
analyzed programs.

Application Comparison Report

The Application Comparison report compares specific metrics values for each application
in the AKR to the average values for all applications in the AKR. The report consists of
two self-scaling graphs:

. The structure versus complexity graph represents essential complexity versus
cyclomatic complexity.

. The business value versus complexity graph represents the number of function
points versus cyclomatic complexity.

The report also includes a table listing the applications found in each quadrant of the
graph. On the structure versus complexity graph, the center for the quadrants is marked
by the intersection between the average cyclomatic complexity value and the average
essential complexity value. On the business value versus complexity graph, the center is
marked by the intersection between the average function point value and the average
cyclomatic complexity value.
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Figure 58 shows the structure versus complexity graph provided in the Application
Comparison report.

Figure 58 « Application Comparison Report (1 of 4)

ASG- RECAP-OS(ESA) Rx.x LVLxxx APPLICATION COMPARISON DD-MMM-YYYY HH:MM:SS PAGE 209
AKR NAME: ASG.RCPSAMP.AKR
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Application Comparison Report Field Descriptions (1 of 4)

Field Description

(A) The cyclomatic complexity values are graphed on the vertical axis.

(B) This solid line represents the average essential complexity for all applications
compared.

©) The essential complexity values are graphed on the horizontal axis.

(D) This dashed line represents the average cyclomatic complexity for all

applications compared.

(E) The intersection of the cyclomatic complexity average and the essential
complexity average marks the center of the four quadrants.

(F) This box, with the corners marked by a plus sign (+), represents one standard
deviation from the average. The top and bottom of the box represent plus and
minus one standard deviation for cyclomatic complexity. The right and left
borders represent plus and minus one standard deviation for essential
complexity.

(G) Represents one or more applications that have metrics at the coordinate
marked.
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Figure 59 shows the Application Location table listing the applications found in each
quadrant of the structure versus complexity graph.

Figure 59 » Application Comparison Report (2 of 4)

ASG-RECAP-0S (ESA) Rx.x LVLxxx APPLICATION COMPARISON DD-MMM-YYYY HH:MM:SS PAGE 210
AKR NAME: ASG.RCPSAMP.AKR
(B) (B) (©) (D)

QUADRANT I (UPPER RIGHT) QUADRANT II (UPPER LEEFT) QUADRANT III (LOWER LEFT) QUADRANT IV (LOWER RIGHT)
UNSTRUCTURED - HI COMPLEX STRUCTURED - HI COMPLEX STRUCTURED - LO COMPLEX UNSTRUCTURED - LO COMPLEX
MANF-CNTL (2317, 4729) ACCT-PAYBL ( 225, 1542)

SALES (7445, 17646) ACCT-RCVBL ( 495, 1917)

CUST-BILL ( 474, 1853)
CUSTOMER (266, 1568)

EMPL-INFO ( 342, 1858)
INVENTORY ( 546, 1946)
PAYROLL (453, 2021)
TELEPHONE ( 63, 474)

GRAPH COORDINATES = (ESSENTIAL COMPLEXITY, CYCLOMATIC COMPLEXITY)

Application Comparison Report Field Descriptions (2 of 4)

Field Description

(A) Applications that are more unstructured and more complex than the average
are listed in Quadrant 1.

(B) Applications that are more structured and more complex than the average are
listed in the Quadrant 2.

©) Applications that are more structured but less complex than the average are
listed in Quadrant 3.

(D) Applications that are more unstructured and less complex than the average
are listed in Quadrant 4.
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Figure 60 shows the business value versus complexity graph provided in the Application
Comparison Report.

Figure 60 « Application Comparison Report (3 of 4)

ASG-RECAP-0S (ESA) Rx.x LVLxXxx APPLICATION COMPARISON DD-MMM-YYYY HH:MM:SS PAGE 211
AKR NAME: ASG.RCPSAMP.AKR
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Application Comparison Report Field Descriptions (3 of 4)

Field Description

(A) The cyclomatic complexity values are graphed on the vertical axis.

(B) This solid line represents the average function point value for all applications
compared.

©) The function point values (business value) are graphed on the horizontal axis.

(D) This dashed line represents the average cyclomatic complexity value for all

applications compared.

(E) The intersection of the cyclomatic complexity average and the function
points average marks the center of the four quadrants.

(F) This box, with the corners marked by a plus (+), represents one standard
deviation from the average. The top and bottom of the box represent plus and
minus one

(G) Represents one or more applications that have metrics at the coordinate
marked.

Figure 61 shows the Application Location table listing the applications in each quadrant
of the business value versus complexity graph.

Figure 61 » Application Comparison Report (4 of 4)

ASG-RECAP-0S (ESA) Rx.x LVLxXxx APPLICATION COMPARISON DD-MMM-YYYY HH:MM:SS PAGE 212
AKR NAME: ASG.RCPSAMP.AKR
(2) (B) (€) (D)
QUADRANT I (UPPER RIGHT) QUADRANT II (UPPER LEFT) QUADRANT III (LOWER LEFT) QUADRANT IV (LOWER RIGHT)
HI BUSINESS VAL - HI COMPLEX LO BUSINESS VAL - HI COMPLEX LO BUSINESS VAL - LO COMPLEX HI BUSINESS VAL - LO COMPLEX
MANF-CNTL (310, 4729) ACCT-PAYBL (188, 1542) CUST-BILL (337, 1853)
SALES (514, 17646) ACCT-RCVBL (288, 1917) PAYROLL (383, 2021)

CUSTOMER (266, 1568)
EMPL-INFO (250, 1858)
INVENTORY (221, 1946)
TELEPHONE (171, 474)

GRAPH COORDINATES = (FUNCTION POINTS, CYCLOMATIC COMPLEXITY)
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Field Descriptions (4 of 4)

Field Description

(A) Applications that have a higher than average business value and a higher than
average complexity are listed in Quadrant 1.

(B) Applications that have a business value equal to or lower than average and a
higher than average complexity are listed in Quadrant 2.

©) Applications that have a business value equal to or lower than the average
business value and a complexity equal to or lower than average complexity
are listed in Quadrant 3.

(D) Applications that have a higher than average business value and a complexity
equal to or lower than the average complexity are listed in Quadrant 4.
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Application Progress Report

The Application Progress report, shown in Figure 62, shows how each application in the
enterprise has progressed by calculating the difference between the current and last
values for each metric and each exception.The Application Progress report includes this
information:

»  Application version number

. Number of programs

. Adjusted Function Points

. Enhancement Function Points

. Software Science Volume

. Cyclomatic Complexity

. Essential Complexity

. Control Variable Complexity and Control Flow Knots metrics

. Number of lines of code, and application exceptions

For each metric and exception, the initial (baseline) values, current values, and values
from the previous version are provided. The report also lists the difference (D) between
the current metric and exception values and the values from the previous version.

Figure 62 « Application Progress Report

ASG-RECAP-0S (ESA) Rx.x LVLXXX APPLICATION PROGRESS

AKR NAME: ASG.RCPSAMP.AKR

DD-MMM-YYYY HH:MM:SS PAGE 213

(A) APPLICATION: ACCT-PAYBL (E) i APPLICATION: ACCT-RCVBL
(B) INITIAL (C)CURRENT (D)PREVIOUS DELTA $DELTA | INITIAL CURRENT PREVIOUS DELTA $DELTA
i
VERSION 1 1 H 1 1
NUMBER OF PROGRAMS 36 36 H 43 43
ADJUSTED FUNCTION POINTS 188 188 i 288 288
ENHANCEMENT FUNCTION POINTS 0 0 i 0 0
SOFTWARE SCIENCE VOLUME 511021 511021 1 605906 605906
CYCLOMATIC COMPLEXITY 1542 1542 1 1917 1917
ESSENTIAL COMPLEXITY 225 225 i 495 495
CONTROL VARIABLE 3245 3245 i 4035 4035
KNOTS 1070 1070 H 1241 1241
NUMBER OF LINES OF CODE 19048 19048 i 23493 23493
GO TOS 1510 1510 H 1602 1602
ALTERS 19 19 H 29 29
ANOMALOUS ENTRIES 0 0 H 0 0
ANOMALOUS EXITS 2 2 i 3 3
RECURSIONS 0 0 H 0 0
OUT OF PERFORM RANGE JUMPS 5 5 ! 88 88
LIVE EXITS 0 0 i 3 3
DEAD CODE 1235 1235 H 1050 1050
DEAD DATA 2 2 | 3 3
INITIAL : STRUCTURED, LO COMPLEXITY, LO BUS VALUE } INITIAL : STRUCTURED, LO COMPLEXITY, LO BUS VALUE
(F) CURRENT : STRUCTURED, LO COMPLEXITY, LO BUS VALUE } CURRENT : STRUCTURED, LO COMPLEXITY, LO BUS VALUE
PREVIOUS: INFO NOT AVAILABLE | PREVIOUS: INFO NOT AVAILABLE
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Report Field Descriptions

Field Description

(A) The name of the application.

(B) The baseline portfolio analysis data for the application.

© The current values for the portfolio analysis data.

(D) The portfolio analysis data from the previous version. If the application has

only been analyzed one time, these values are not available.

(E) DELTA represents the absolute value of the difference between the current
and last values. The %DELTA is calculated using this formula:
$DELTA = (DELTA/LAST) * 100
(F) A description of the overall condition of the initial, last and current versions

of the application. For example, the current version of application
ACCT-PAYBL is structured, has a low complexity and a low business value
(low business value = low function point).
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Enterprise Metrics Report

The Enterprise Metrics report (Figure 63 on page 128) shows metrics and statistical
information for applications in the Enterprise (AKR). This information is included for

each application:

Information Description

Metrics
information

Values for this information is provided:

. Program total

. Adjusted Function Points

. Enhancement Function Points

. Software Science Volume

. Cyclomatic and Essential Complexity
. Control Variable

. Control Flow Knots

. Lines of code

If a metrics value, other than Function Points, is higher or lower than the
high or low bounds calculated for all applications in the enterprise, HI or
LO is listed to the right of the value.

Overall program
condition

These classifications are assigned to each application based on the
metrics information for the application and the averages of all
applications in the AKR:

o Structure
. Complexity

. Business value
The classifications are low or high.

Comparative
statistics

This information for each metric in the application is reported:
. Total

. Average
. Standard deviation
. Low bound

. High bound

The low bound value is obtained by subtracting the standard deviation
from the average; if the result is a negative number a zero displays. The
high bound value is obtained by adding the standard deviation to the
average. The high bound and low bound values determine whether a
program's metric values are flagged HI or LO.
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The Enterprise Metrics Report information is listed in table format. The first table shows
non-conformant applications, if any exist. These applications have at least one metric
value, other than Function Points, greater than one standard deviation from the enterprise
average. The second table displays conformant applications that have values within or
lower than one standard deviation from the average for all metrics. The third table
displays the comparative statistics.

Figure 63 » Enterprise Metrics Report

ASG-RECAP-0S (ESA) Rx.x LVLxXxx ENTERPRISE METRICS DD-MMM-YYYY HH:MM:SS PAGE 216
AKR NAME: ASG.RCPSAMP.AKR
(B)
NON-CONFORMANT
(B) () (D) (E) (F) (G)
APPLICATION  PGM ADJ FP  ENH FP VOLUME CYCLOMATIC  ESSENTIAL CNTL VAR KNOTS LINES CODE STRUCT CMPLX BUSNS
NAME TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL VALUE
MANEF-CNTL 36 310 0 882297 4729 2317 8524 7272 31698 HI Low HIGH HIGH
SALES 31 514 0 1315573 HI 17646 HI(H) 7445 HI 23067 HI 19279 HI 34731 HI Low HIGH  HIGH

(I)

CONFORMANT
APPLICATION PGM ADJ FP  ENH FP VOLUME CYCLOMATIC  ESSENTIAL CNTL VAR KNOTS LINES CODE STRUCT CMPLX BUSNS
NAME TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL TOTAL VALUE
ACCT-PAYBL 36 188 0 511021 1542 225 3245 1070 19048 HIGH ow Low
ACCT-RCVBL 43 288 0 605906 1917 495 4035 1241 23493 HIGH ow Low
CUST-BILL 43 337 0 601125 1853 474 3891 1226 23289 HIGH Low HIGH
CUSTOMER 33 266 0 536930 1568 266 3320 1097 20566 HIGH Low Low
EMPL-INFO 35 250 0 558657 1858 342 3622 1092 21325 HIGH Low Low
INVENTORY 34 221 0 531911 1946 546 4623 1502 22985 HIGH ow Low
PAYROLL 36 383 0 614351 2021 453 4109 1223 22804 HIGH Low HIGH
TELEPHONE 6 171 0 146795 LO 474 63 1241 28 6579 LO  HIGH Low ow
(J)
ENTERPRISE TOTAL/SUMMARY (NUMBER OF APPLICATIONS = 10, NUMBER OF PROGRAMS = 333)
METRICS TOTAL AVERAGE STD. DEV. LOW BOUND  HIGH BOUND
ADJUSTED FUNCTION POINTS 2928 293 96 197 389
ENHANCEMENT FUNCTION POINTS 0 0 0 0 0
SOFTWARE SCIENCE VOLUME 6304566 630457 283961 346496 914418
CYCLOMATIC COMPLEXITY 35554 3555 4804 0 8359
ESSENTIAL COMPLEXITY 12626 1263 2146 0 3409
CONTROL VARIABLE 59677 5968 5954 14 11922
KNOTS 35030 3503 5587 0 9090
NUMBER OF LINES OF CODE 226518 22652 7116 15536 29768
(K)

LEGEND: LO = VALUE < AVG. - STD. DEV. LOW = VALUE <= AVG. LOW BOUND = AVG. - STD. DEV. STD. DEV. = STANDARD DEVIATION

HI = VALUE > AVG. + STD. DEV. HIGH = VALUE > AVG. HIGH BOUND = AVG. + STD. DEV.
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Report Field Descriptions

Field Description

(A)

The first table presented in the Enterprise Metrics report lists the metrics and
application condition for non-conformant applications. Non-conformant
applications have one or more metrics values that are more than one standard
deviation higher than the enterprise average.

(B)

The application name is listed in this column.

©

The total number of programs in the application is listed in this column.

(D)

The function point total for the application.

(E)

The enhancement function point total for the application.

(F)

The metrics values for each application are listed in columns five through ten.

G

The overall condition of the application in terms of structure, complexity, and
business value is listed in the last three columns. The values for each

condition can be low or high. (See the footnotes in "Report Field
Descriptions" on page 115 for an explanation of these columns.)

(H)

If HI or LO displays to the right of a metrics value, that value is outside of the
high bound or low bound for the enterprise.

@

The metrics values and application condition for conformant applications are
presented in this table. Conformant applications have metrics values that are
within one standard deviation of the enterprise average or values that are
lower than the enterprise average which indicates good structure and
complexity.

Q)

The Enterprise Total/Summary table provides a list of enterprise totals,
averages, standard deviations, low bounds, and high bounds calculated for
each metric.
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Field Description

(K) The legend that displays defines the formulas used to calculate the high and
low bounds for metrics values. The low bound is calculated using this
formula:

LOW BOUND = AVERAGE - STANDARD DEVIATION

The AVERAGE and STANDARD DEVIATION values are the values
calculated for the enterprise. If an application metric has a value less than
LOW BOUND, that metric is marked LO.

The high bound is calculated using this formula:
HIGH BOUND = AVERAGE + STANDARD DEVIATION

If an application metric has a value greater than HIGH BOUND, it is marked
HI.

(A) The first table presented in the Enterprise Metrics report lists the metrics and
application condition for non-conformant applications. Non-conformant
applications have one or more metrics values that are more than one standard
deviation higher than the enterprise average.

B) The application name is listed in this column.

Enterprise Exceptions Report
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The Enterprise Exceptions report (Figure 64 on page 132) summarizes code exceptions
affecting the quality of the applications in the enterprise.

Note:

If an application within the enterprise has a high number of exceptions, run a SmartDoc
analysis on each of the programs within the application to locate and correct the
exceptions. See the ASG-SmartDoc User’s Guide for more information.

These items are reported on the Enterprise Exceptions Report:

Item Description

NUMBER OF  The number of programs in each application within the enterprise.
PROGRAMS

GO TOS The number of GOTOs and ALTER GO TOs in the enterprise.

ALTERS The number of ALTER GO TOs in the enterprise.




6 Report Descriptions

Item Description

ANOMOLOUS The number of ENTRY statements in the enterprise.
ENTRIES

ANOMOLOUS The number of statements containing a STOP RUN, GOBACK, or
EXITS EXIT PROGRAM verb, and CALL statements that are indicated as
NORET (non-returning).

RECURSION  The number of occurrences of recursion in the enterprise. Recursion
generally occurs when a paragraph or perform range performs itself.
This type of programming technique can lead to endless loops.

JUMPS (OUT  The number of out of perform range jumps in the enterprise. An exit
OF PERFORM  is made from a perform range, due to the use of a GOTO, bypassing

RANGE the normal perform range return to the line following the perform
JUMPS) statement.
LIVE EXITS The number of live exits in the enterprise. Live exits are exits from

perform ranges that are left dangling by overlapping PERFORMSs and
GOTOs in the original Performed paragraphs. Internally, the COBOL
compiler creates a jump statement to return to the caller at the end of
a perform range. When the jump is actually performed, the jump
statement is cleared. If an exit is made from the perform range before
the jump statement is cleared (the normal flow is changed), the
internal jump statement is left live. If an overlapping perform range is
subsequently executed, the jump statement set by the original perform
range is still live and causes the program to jump back to the location
of the first caller to that perform range. This results in the program not
executing as expected.

DEADCODE The number of dead code occurrences in the application within the
enterprise. Dead code statements are PROCEDURE DIVISION
statements that never execute under any conditions.

DEADDATA The number of dead data occurrences in the application within the
enterprise. Dead data occurrences are unreferenced data items or data
items only referenced in DEADCODE.
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Figure 64 » Enterprise Exceptions Report

ASG-RECAP-0S (ESA) Rx.x LVLxxx ENTERPRISE EXCEPTIONS DD-MMM-YYYY HH:MM:SS PAGE 217
AKR NAME: ASG.RCPSAMP.AKR
(&) (B)
APPLICATION NUMBER OF NUMBER OF NUMBER OF NUMBER OF NUMBER OF NUMBER OF NUMBER OF NUMBER OF LINES OF LINES OF
NAME PROGRAMS GO TOs ALTERS A-ENTRIES A-EXITS RECURSION JUMPS LIVE EXIT DEAD CODE DEAD DATA
ACCT-PAYBL 36 1510 19 0 2 0 5 0 1235 2
ACCT-RCVBL 43 1602 29 0 3 0 88 3 1050 3
CUST-BILL 43 1621 5 0 2 0 12 0 1191 4
CUSTOMER 33 1675 49 0 1 0 54 3 1398 7
EMPL-INFO 35 1437 5 0 7 0 177 0 1244 2
INVENTORY 34 1551 3 1 2 0 0 0 897 7
MANF-CNTL 36 2665 145 1 2 14 1496 0 997 3
PAYROLL 36 1723 0 0 2 0 139 3 1460 0
SALES 31 3864 20 1 6 3794 10256 571 1100 3
TELEPHONE 6 45 0 2 31 8 2 23 0
()
ENTERPRISE TOTAL/SUMMARY (NUMBER OF APPLICATIONS = 10, NUMBER OF PROGRAMS = 333)
EXCEPTIONS TOTAL
GO TOS 17693
ALTERS 275
ANOMALOUS ENTRIES 5
ANOMALOUS EXITS 58
RECURSIONS 3809
OUT OF PERFORM RANGE JUMPS 12235
LIVE EXITS 582
DEAD CODE 10595
DEAD DATA 31
LEGEND: JUMPS = OUT OF PERFORM RANGE JUMPS A-ENTRIES = ANOMALOUS ENTRIES A-EXITS = ANOMALOUS EXITS

Report Field Descriptions

Description

(A) The names of the applications in the AKR.

(B) These columns list the number and type of exceptions found in the
application.

©) The Enterprise Total/Summary table lists the enterprise totals for each type

of exception. The total number of applications and programs in the enterprise
is also provided.
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Master Index

6 Report Descriptions

The Master Index, shown in Figure 65, is an alphabetical listing of all named entities in
the Recap reports. This report provides a quick reference to determine where a particular
entity is located within the Recap reports.

Figure 65 « Master Index

ASG-RECAP-0S (ESA) Rx.x LVLxxx

()
ENTITY NAME

(B)
DEFINITION

MASTER INDEX
APPLICATION: SALES
()
LOCATION (REPORT-PAGE NUMBER)

DD-MMM-YYYY HH:MM:SS PAGE 218

ACCT-PAYBL
ACCT-RCVBL
CM431
CUST-BILL
CUSTOMER
DB204
EMPL-INFO
E02031
GENAMER1
IC110
IC120
IC207
Ic217
INVENTORY
IX203
IX214
KC601
MANF-CNTL
NC110
NC119
NC154
NC165
NC209
NC217
NC431
PAYROLL
RL151
RL431
SALES
5G203
SQ110
SQ120
50205
SQ215
ST110
ST201
ST211
ST441
TELEPHONE
TH205
TH215

(D)
LEGEND: AC = APPLICATION COMPARISON
AD = APPLICATION DEFINITION
AE = APPLICATION EXCEPTIONS
AM = APPLICATION METRICS

APPLICATION NAME
APPLICATION NAME
PROGRAM NAME
APPLICATION NAME
APPLICATION NAME
PROGRAM NAME
APPLICATION NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
APPLICATION NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
APPLICATION NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
APPLICATION NAME
PROGRAM NAME
PROGRAM NAME
APPLICATION NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
PROGRAM NAME
APPLICATION NAME
PROGRAM NAME
PROGRAM NAME

AP = APPLICATI
EE = ENTERPRIS
= ENTERPRIS

]
=
I

FP = PROGRAM FUNCTION POINT

AC-210,AC-212,AP-213,EM-216, EE-217
AC-210,AC-212,AP-213,EM-216, EE-217

AD-2, FP-3,FS-99,ME-101, PC-195, PC-197, PP-198, AM-206, AE-208
AC-210,AC-212,AP-213,EM-216, EE-217
AC-210,AC-212,AP-213,EM-216, EE-217

AD-2, FP-6,FS-99, MH-104, PC-195, PC-197, PP-198, AM-206, AE-208
AC-210,AC-212,AP-214,EM-216, EE-217

AD-2, FP-10, FS-99,MH-107, PC-195, PC-197, PP-198, AM-206, AE-208
AD-2, FP-13,FS-99,MH-110, PC-195, PC-197, PP-198, AM-206, AE-208
AD-2, FP-16, FS-99,MH-113, PC-195, PC-197, PP-199, AM-206, AE-208
AD-2,FP-19, FS-99,MH-116, PC-195, PC-197, PP-199, AM-206, AE-208
AD-2, FP-22,FS-99,MH-119, PC-195, PC-197, PP-199, AM-206, AE-208
AD-2, FP-25, FS-99, MH-122, PC-195, PC-197, PP-199, AM-206
AC-210,AC-212,AP-214,EM-216, EE-217

AD-2, FP-28, FS-99, MH-125, PC-195, PC-197, PP-200, AM-206, AE-208
AD-2, FP-31, FS-99,MH-128, PC-195, PC-197, PP-200, AM-206, AE-208
AD-2, FP-34, FS-99,MH-131, PC-195, PC-197, PP-200, AM-206, AE-208
AC-210,AC-212,AP-214,EM-216, EE-217

AD-2, FP-39, FS-99, MH-134, PC-195, PC-197, PP-200, AM-206, AE-208
AD-2, FP-42, FS-99,MH-137, PC-195, PC-197, PP-201, AM-206, AE-208
AD-2, FP-45, FS-99, MH-140, PC-195, PC-197, PP-201, AM-206, AE-208
AD-2, FP-48, FS-99, MH-143, PC-195, PC-197, PP-201, AM-206, AE-208
AD-2, FP-51, FS-99,MH-146, PC-195, PC-197, PP-201, AM-206, AE-208
AD-2, FP-54, FS-99,MH-149, PC-195, PC-197, PP-202, AM-206, AE-208
AD-2, FP-57, FS-99,MH-152, PC-195, PC-197, PP-202, AM-206, AE-208
AC-210,AC-212,AP-214,EM-216, EE-217

AD-2, FP-60, FS-99, MH-155, PC-195, PC-197, PP-202, AM-206, AE-208
AD-2, FP-63, FS-99, MH-158, PC-195, PC-197, PP-202, AM-206, AE-208
AD-2,AC-210,AC-212,AP-215,EM-216,EE-217

AD-2, FP-66, FS-99,MH-161, PC-195, PC-197, PP-203, AM-206, AE-208
AD-2, FP-69, FS-99, MH-164, PC-195, PC-197, PP-203, AM-206, AE-208
AD-2, FP-72,FS-99,MH-167, PC-195, PC-197, PP-203, AM-206, AE-208
AD-2, FP-75, FS-99,MH-170, PC-195, PC-197, PP-203, AM-206, AE-208
AD-2, FP-78, FS-99,MH-173, PC-195, PC-197, PP-204, AM-206, AE-208
AD-2, FP-81, FS-99,MH-176, PC-195, PC-197, PP-204, AM-206, AE-208
AD-2, FP-84, FS-99,MH-179, PC-195, PC-197, PP-204, AM-206, AE-208
AD-2, FP-87, FS-99, MH-182, PC-195, PC-197, PP-204, AM-206, AE-208
AD-2, FP-90, FS-99, MH-185, PC-195, PC-197, PP-205, AM-206, AE-208
AC-210,AC-212,AP-215,EM-216, EE-217

AD-2, FP-93, FS-99, MH-188, PC-195, PC-197, PP-205, AM-206, AE-208
AD-2, FP-96, FS-99, MH-191, PC-195, PC-197, PP-205, AM-206, AE-208

ON PROGRESS FS = APPLICATION FUNCTION POINT ANALYSIS
E EXCEPTIONS MH = PROGRAM METRICS HISTORY

E METRICS PC PROGRAM COMPARISON

PP = PROGRAM PROGRESS

ANALYSIS
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Report Field Descriptions

Field Description

(A) Each entity in the enterprise is listed.
(B) Indicates whether the entity is a program or application.
©) Lists the report names and report page numbers where references to the

entities can be found.

(D) Legend of the symbols used to identify the report on which the entity is
referenced.
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Report Generator Language

This chapter provides ways to adjust or change report content and format to meet your
organization’s requirements using Recap’s Report Generator Language, and contains
these sections:

Section Page

Description of Programming Language 137
Site Specific Configuration 137
Data Structures 138
Language Constructs 139
Data Flements - Table and Field Descriptions 145

The Executive Summary report summarizes the portfolio analysis information provided
in the Recap reports and provides recommendations based on this information. Initially,
the Executive Summary report is generated from a preprogrammed file shipped with
Recap. (See the ASG-Recap Installation Guide for more information about this file.) This
file uses the Report Generator programming language that is also included with the
product.

If necessary, the report contents and format can be adjusted or changed to meet the
requirements of your organization by using the Report Generator programming language
described in this chapter.

The Executive Summary report is printed in mixed case letters by default. If you want to
print the report in upper case only, see "Generating Recap Reports" on page 43.

135



ASG-Recap User’s Guide

Figure 66 shows the Executive Summary Report generated from the preprogrammed file.

Figure 66 » Executive Summary Report

ASG-RECAP-0S (ESA) Rx.x LVLxxx EXECUTIVE SUMMARY DD-MMM-YY HH:MM:SS PAGE 1
APPLICATION: SALES

GENERAL INFORMATION

The SALES (SALES INFORMATION) application inventory analysis was performed on 27-MAR-95 at 10:34:32. There
is one historical version of the application. It consists of 37 analyzed programs. For additional details
refer to the Application Definition Report.

APPLICATION COMPARATIVE ANALYSIS

For comparison purposes, the SALES application was compared against 9 other applications (see Enterprise
Metrics or Enterprise Exception for the names of other applications).

Of the 10 applications in this assessment, SALES's Function Points metric is high (3271 FPs), at the same

time it has above average number of Lines Of Code (56173 LOC), which should be minimized. For the average
program size measurement, this application is among those which have a large number of lines of code per program
(1518 LOC/PGM) . Of the 10 applications assessed, SALES is high in Functional Complexity (6 Cyclomatic
Complexity/Function Point) and high technical complexity (Cyclomatic Complexity Value 18656), indicating a
conceptually difficult application. The Essential Complexity metric (value 7840) indicates that SALES has a
poor logical structure and a poor physical structure as shown by Knots metric (value 19664). Of the 10
applications assessed, SALES has relatively high Code Exception Conditions. See Function Point Analysis
Enterprise Metrics, and Enterprise Exceptions for additional details.

Due to the poor physical structure for an application with a high business value, we recommend that you
restructure the application. Besides the option of restructuring, the application could benefit from
re-engineering since it has high technical complexity, poor physical structure, but provides good business value.
One thing that is noticeable is the high number of exceptions. We strongly recommend that you analyze and fix
them so that the application does not give unexpected flow (see PROGRAM COMPARATIVE ANALYSIS below) .

PROGRAM COMPARATIVE ANALYSIS

As noted above, SALES consists of 37 programs. Of the 37 programs, all programs have code exceptions which
may cause the programs to function differently than expected. Analyze the programs and correct the exceptions.
See the Application Exceptions for additional information.

Of the 37 programs, 4 programs are more than 1 standard deviation greater than average for Software science
volume, 2 programs are more than 1 standard deviation greater than average for Cyclomatic Complexity, 2 programs
are more than 1 standard deviation greater than average for Control Variable Complexity, and 5 programs are more
than 1 standard deviation greater than average for Lines Of Code. If these programs provide important business
functions you may wish to consider them candidates for re-engineering or decomposition. See the Application
Metrics, Program Metrics History, or Program Comparison for additional details.

Of the 37 programs, 2 programs are more than 1 standard deviation greater than average for Essential
Complexity, and 1 program is more than 1 standard deviation greater than average for Knots Count. If these
programs show a history of difficult maintenance and they perform important business functions, you may wish to
consider them as candidates for re-structuring.

Of all the programs in the application, none have changed more than 10%.
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7 Report Generator Language

Description of Programming Language

The Report Generator programming language has limited functionality, yet provides the
root capabilities found in all high level languages. It is interpretive and intermingled with
the input data. The key components are a tokenizer, instruction parser, and syntax
checker driven from a single layer controller. The language parser distinguishes
instruction tokens from text tokens. Input is considered as a constant stream of tokens,
with comment lines denoted by an asterisk in the first column. The instructions are fixed
format but positionally independent.

Site Specific Configuration

The data files VIAXESUM and VIAXESUU contain a section clearly labeled Site
Specific Configuration. This section is used to set up site specific configuration for the
data file. The Site Specific Configuration section is located at the beginning of the data
file and may optionally be preceded by an unlimited number of comment records. The
end of the Site Specific Configuration section is denoted by the words end Site Specific
Configuration.

These instructions are located inside the Site Specific Configuration section:

Instruction Description

Standard Deviation If any metrics or exception counts for a program or

Difference application differs from the average by more than the
specified statistical standard deviation, then the data for
that program or application is computed and ranked
accordingly. The default value is 1 standard deviation
from the average. You may want to increment this
number if the standards requirements of your
organization are less stringent. Setting the Standard
Deviation Difference to a higher number, 2 for example,
changes the ranking of a particular metric or exception to
out of norm when the value differs by 2 or more standard
deviations.
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Instruction Description

Percent Change The Percentage Change is a threshold value used to
determine which programs have changed significantly
since the last analysis. If Percent Change is greater than
the threshold Percent Change, the program is marked as
changed significantly. Initially, the threshold is set at
10% and all programs with metrics or exception values
that have changed more than 10% are counted as changed
significantly. You may want to change this number to
reflect the standards of your organization.

Identifier Character The Identifier Character is a single character used to
differentiate data fields and keywords from text. The
identifier must be the first character of the data field or
instruction. The character used as the identifier must not
be used anywhere else in the data file. The default is an
ampersand (&). If you need to use an ampersand (&) in
the data file, you can change the default. Be sure that the
new identifier you choose is not used for any other
purpose in the data file.

Data Structures

Primary input to the Executive Summary Report Generator System is a free-format data
file containing language text. The programming and formatting instructions are
embedded in this file. Secondary input is all data collections that are used as input to the
metrics report programs.

Data Element Syntax

138

Data elements are differentiated from text by the first character: all data elements must
start with an identifier. Because data element names are differentiated by the identifier,
the identifier (default = &) cannot be used as a printable word in the output file. See "Site
Specific Configuration" on page 137 for information about the identifier.

Each data element has a variable data type. If the value assigned to an element is a string,
the data type is a string. If the value assigned is numeric, the data type is numeric. The
data type is automatically changed to correspond to the value assigned to the element.
For example, if &appl total has the value 8, the data type is numeric. If you reassign
&appl total avalue of 'eight', the data type automatically changes to string. The data
element names are limited to 40 characters in length; the values are limited to the width of
a printed page (132 characters).



7 Report Generator Language

Primary and Subsidiary Tables

The data collections used as input to the programming language are available as
individual elements in a primary table or as elements in subsidiary tables. Elements in
subsidiary tables are accessed by indexing elements in the primary table. Each element of
every table is available for inspection or modification at any time.

Each table contains 100 elements. The programmer may overwrite the default or
pre-computed value of any element. Elements can be added to a table, but new tables
cannot be created. The value of an element is retrieved from this table by specifying its
name. For example, to retrieve the name of the application, you would enter the

&appl name data element as a token in the data file.

Accessing Elements in Subsidiary Tables

The elements of subsidiary tables are accessed through dereferencing. Table
dereferencing or subscripting is achieved by specifying an index or offset, as is done in
all generic programming languages. The index follows the data element name and is
enclosed in brackets ({}). The index can be a numeric constant or another data item,
either numeric or alphanumeric. For example, smetric history {&essential}
is a reference to the table named &metric history, with an offset or index to the
entry denoted by sessential. If you know that sessential is the tenth element in
the table, the same results could be achieved by coding &metric history {10}.

Embedded spaces between table names and the offset notational characters are optional
and are used for improved readability only.

Note:

See “‘Data Elements - Table and Field Descriptions” on page 145 for descriptions of the
individual tables and elements.

Language Constructs

The programming language intermixes the English text and the programming
instructions. Therefore, data and programming elements must be differentiated from text
elements using the identifier specified in the site specific configuration section. The
default identifier is an ampersand (&).
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The language consists of four distinct components:

. Text Substitution.

. Data Manipulation.

. “Control and Text Selection” on page 141.

. “Output Formatting” on page 143.

Text Substitution

When a data element is used as a token, the value of the element is automatically
substituted. Therefore, to print the value of a data element you only have to specify the
data element name. For example, assume the name of an application is Payroll, and that
this application has 12 defined programs.
To output the text:

The Payroll application consists of 12 programs

The input file contains:

The &appl name application consists of &pgm total programs

Data Manipulation

&assign

140

The data manipulation instructions allow the programmer to set the values of elements in
the data domain using these keywords:

The &assign instruction assigns a value to a data item. If the data item is defined, its
value is overwritten. If it is undefined, an instance is created. An element can be created
or stored in a subsidiary table; in that case the primary entry must be a reference to a
pre-defined subsidiary table since tables cannot be created. The type of data can be
changed from numeric to string or vice versa. This is the syntax for the sassign
instruction:

&assign item = value &endassign
where item is the name of the data element to receive value. The = operator and
sendassign keyword are mandatory. String values are represented as single (' ') or

double quote (" ") delimited values, such as "this is a string".

These examples illustrate the format for §assign instructions:

&assign &user metric index = 8 &endassign
&assign &temp string = "User defined metric" &endassign
&assign &metric name {&user metric index}=&temp string &endassign
&assign é&metric current {&user metric index} = 0 &endassign



&compute

7 Report Generator Language

The &compute instruction computes values of numeric instances. If the data item is
undefined, an instance is created as with &assign. If it is defined, its value is
overwritten. The type of data is numeric after the computation is made, regardless of its
original type. This is the format of the instruction:

&compute item = operandl operator operand?2 &endcompute
where:

1tem is the name of the data element to receive the value of the computation.

The = operator is mandatory.

Operandl and operandZ are both existing data elements; either may be a
numeric constant. Each of these operands may be a dereferenced data element
(table lookup). The item field itself may be a dereferenced data element.

The operator must be one of the primitive numeric operators +, -, *, or /, for
addition, subtraction, multiplication or division respectively. This example
illustrates the format for an & compute instruction to compute the complexity
density metric.
&compute &complexity density =
&gmetric cuf}ent {&cyclomatic}/&metric current{&volume}
&endcompute B B

&compute &metric current {&user metric_ index} =
&complexity density * &metric current {&fpa}
&endcompute

Control and Text Selection

&if

The control and text selection constructs allow the programmer to selectively output text.
Programming instructions must also start with a character identifier. The format of these
instructions is fixed, but they can display anywhere in the text file. The tokens in the
instruction may be specified on one line, but we recommend that you follow standard
programming format guidelines to improve program readability.

The &1 f instruction allows the programmer to test the values of two data elements and
conditionally select text based upon the result. This example illustrates the format for
&1f instructions.

&1f condition &then ... &else ... &endif
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142

where condition is further defined as:

operandl operator operandZ2

Operandl and operand?Z2 are both existing data elements; either may be a numeric or
alphanumeric constant. The ordinal type of the operands must be the same. The
operator depicts the type of operation to perform on the two operands. Supported
operators are:

Operator Corresponding Definition

=or EQ EQUAL

<orLT LESS THAN

>or GT GREATER THAN

<=or LE LESS THAN OR EQUAL TO
>=or GE GREATER THAN OR EQUAL TO
<>, ~=, =, 7, or NE NOT EQUAL

The operator has the standard programming language interpretation. The keyword
&then is optional. The &e1se portion of the instruction is optional as it is with all
generic programming languages. The sendi f keyword is mandatory. &1 f instructions
can be nested to indefinite levels.

This example illustrates how the &1 f instruction can be used to control the report's
output:

Assume you want to output the text "The complexity density is
acceptable" if the programmatic complexity density value is less than some
computed average value, otherwise you want to output the text "The
complexity density is higher than the norm". The input data file
may then contain instructions such as:

&compute &complexity density =
&metric current{&cyclomatic} / &metric current{&volume}
&endcompute

The complexity density is

&if &complexity density < &average complexity &then
acceptable

&else
higher than the norm

&endif
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&while

The &while instruction allows the programmer to test the values of two data elements
and conditionally repeat a section of the input file based upon the result of the
comparison. The &while instruction serves the same purpose as while or loop
instructions in regular programming languages. This is the format for the swhile
instruction:

&while condition ... &endwhile
where condition has the same interpretation as for the &1if instruction.

The sendwhile keyword is mandatory. If condition yields true, the text following
the condition up to the corresponding &endwhile token is interpreted, otherwise
parsing is resumed at the token following the §endwhile. &while instructions can be
nested up to 30 levels deep, and may contain or be contained inside &1 f instructions.

This example illustrates use of the &whi 1e instruction:

Assume you want to output, in tabular format, the names and values of the software
metrics. The metric name is 20 characters long and the metric value is 5 characters
wide. You know that there are 7 different metrics. The programming code may then
contain this code:

&assign &loop_index = 1 &endassign

&while &loop_index <= 7
émetric_name {&loop index}:20 &metric_current
{loop index}:5
&compute &loop index = &loop index + 1
&endcompute
&endwhile

Output Formatting

The programming language also controls the formatting of the output to ensure
readability. It handles word spacing, tabular output, line overflow and, page breaks.
Periods, question marks, and exclamation marks are always followed by two spaces.
Embedded spaces before periods, commas, question marks, exclamation marks, colons,
and semi-colons are suppressed. In addition, there are several instructions available to
assist in formatting the output.
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Output Length Control and Occurrence Count (:n)

&newline

&paragraph

&space

The length of output tokens is controllable. The length is specified by placing a colon and
a numeric value representing the length after the data element name. Spaces are not
allowed between the data element name and the colon. This numeric value may be a
constant or a numeric data element. For example, to format the output of a data item to 10
characters, code it as §data name:10. The value of the sdata name token is
padded with as many spaces as required to make the total length 10 characters. Usage
such as &data name:&length is accepted.

Text strings are left justified and numeric values are right justified within the specified
width. If the actual length of the substituted element is more than the specified length,
then the length is ignored. This means that substituted values may exceed the specified
length. These modes of operation are in conformance with standard programming
practice.

The same functionality is available to some of the formatting instructions described
below. Use the notation :n following the instruction or control name to indicate that a
length or occurrence n can be specified. This length override is optional unless explicitly
documented to the contrary.

The snewline instruction forces the next output token to display on the next line in the
output file or report.

The &paragraph instruction is the equivalent of two &newline instructions and is
provided for ease of formatting only.

The &space :n instruction is used to output a specified number of spaces. This
instruction is required since multiple embedded spaces in the input file are collapsed to a
single space. Moreover, this instruction accepts 0 as a length. This causes the prior token
to be followed by 0 spaces, that is, the prior and following tokens are output without any
spaces in between. The 0 length parameter is seldom used. An occurrence count is
mandatory; a descriptive error message is produced if the : n parameter is omitted.

&Imargin and &rmargin
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The left and right margins of the output are controlled by the & lmargin:n and
&rmargin:n instructions respectively. The parameter : n is required and indicates the
column at which the next line must start or may not exceed. You can use these
instructions to force the margins to the specified columns. The default values are 3 for the
left margin, and the width of a printed page for the right margin (132).



&col
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The &col :n instruction causes a tab to the specified column number. The value of : n
can range from a number larger than the left margin to a number less than the right
margin. The next token is output starting at column number n. A &newline instruction
is internally issued if the current line in the output buffer is already longer than the
specified column number. The &col instruction is required to produce tabular output.

Data Elements - Table and Field Descriptions

The elements used as input to the programming language are available in a primary table
and subsidiary tables. The elements in subsidiary tables are accessed by indexing
elements in the primary table.

These tables show the relationship between elements in the primary table and elements in
the subsidiary table. Descriptions of the elements in the tables are provided in the section
that follows each table.

The elements in the primary table are grouped into these categories: General, Other
Applications, Metrics Values and Names, Application Ranking, Non-Conformance, and
Exceptions.

Primary Table

Data Elements

General:

&anlz_date none
&anlz_time none
&appl_desc none
&appl_name none
&appl_total none
&changed pgm ct none
&exception_pgm_ct none
&exception_rank none
&pgm_total none
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Primary Table

Data Elements

&percent_change none
&unchanged pgm_ct none
&std_dev_diff none
&version none
Other Applications:

&other_appl names (A)
&other_appl_descs (A)
Metrics Values and Names:

&metric_current (B1 - B10)

&metric_history

(B1-B7,and B10)

&metric_name

(B1 - B7, and B10)

Application Ranking:

&metric_rank

(B1 - B10)

Non-Conformance:

&non_conform_ct

(Bl - B4, B6 - BY)

Exceptions Values and Names:

&exception_current

©

&exception_name

©

The sections in the subsidiary tables are grouped into these categories: Other Application
Names and Descriptions, Metrics, and Exceptions.

Subsidiary Tables

Table A - Other Application Names and Descriptions
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Subsidiary Tables

There are (&appl_total - 1) names and (&appl_total - 1) descriptions.

Use numeric indexing to access individual elements.

Table B - Metrics

1 &volume

2 &cyclomatic
3 &essential

4 &control var
5 &fpa

6 &knots

7 &appl_line_tot

8 &avg_lines-pgm

9 &cyc per-fpa

10 &fpe

Table C - Exceptions

&gotos

&alters

&entriesl

&exits

&recursions

&perf jumps

&live_exits

&dead _code

&dead data
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The index listed after each primary element represents the subsidiary table(s) used to
index the primary element. For example, the smetric current element has an index
of {B}. To obtain current metric values, index &émetric current using elements
from the Metrics Table. To print the current metrics value for cyclomatic complexity, the
input file would contain this "The application has a cyclomatic
complexity of &metric current{&cyclomatic}." General elements are
not indexed.

Primary Table Elements

General
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To get the value of a general element specify the element name. If it displays as part of
the text to output, its value is substituted. If it displays as part of a conditional expression
its value is used during the comparison.

Data Element Description

&appl_name Application name

&appl_desc Application description

&anlz_date Date of last analysis

&anlz_time Time of last analysis

&pgm_total Number of programs in the application successfully analyzed
&appl_total Number of applications in the enterprise
&exception_pgm_ct Number of programs that have at least one exception

&unchanged pgm_ct Number of programs that differ less than n% from the last
analysis (n is set in the site specific configuration section of
the program.)

&changed pgm_ct Number of programs that differ more than n% from the last
analysis (n is set in the site specific configuration section of
the program.)

&std_dev_diff Standard deviation difference read from the site specific
configuration.

&percent _change The percentage change read from the site specific
configuration.
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Data Element Description
&version Number of historical application versions.
&exception_rank Application exception rank by the total number of exceptions

compared with other applications within the enterprise.

Other Application Names and Descriptions

The names and descriptions of the other applications in the enterprise definition are
available by numeric indexing. There are (8appl total - 1)names and descriptions
for other applications. The current application name and description are available in
&appl name and &appl desc respectively, and the number of applications is
available in &appl total.

Data Element Description

&other_appl names Table with names of other applications in the enterprise.

&other_appl descs  Table with descriptions of other applications in the enterprise.

Metric Values and Names

These elements are indexed by the elements in the Metrics Table. To get the value, you
must specify the name of the table along with the index offset into the table. For example,
to print the name and current value of the Essential Complexity metric, you need this
code:

Metric name: émetric name {&essential}

Current value: émetric current {&essential}.

Data Element Description

émetric current Table of current metric values.

émetric history Table of previous metric values (last history).

émetric namk Table of metrics names.
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Application Ranking

The comparative ranking of applications in an enterprise returns a value that indicates
how that application ranks when compared against the others in the enterprise. The values
returned are 1 (high), 2 (average), and 3 (low). The smetrics_ rank element ranks the
metrics values and is indexed by the Metrics Table. The sexception rank element
ranks the count of all exceptions.

Data Element Description

émetric rank Comparative ranking of all applications in the enterprise by
individual metric values.

Non-Conformance

The number of programs that are non-conformant indicates how many programs exceed
the standard deviation for their metric values. For example, to print the number of
programs with Control Flow Knots metric value farther from the average than the
standard deviation boundary specified in the site specific configuration section in its
Knots metric, you may code:

"There are &non_conform ct {&knots} programs with a Knots count
greater than

&std _dev_diff from the average."

Data Element Description

&non_conform ct Number of programs that are non-conformant.

Exception Values and Names

These elements are indexed by elements in the exceptions table. To get the value, you
must specify the name of the table along with the index offset into the table. For example,
to print the name and current value of the 1ive exits exception, you need this code:

Exception name: ¢exception name {&live exits}
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Current value: sexception current {&live exits}

Data Element Description

&exception current Table that contains the current exception values.

&exception name Table that contains the names of exception conditions.

Subsidiary Tables

Metrics Table

The elements in this table are accessed by indexing an element in one of these primary
tables: Metrics Values and Names, Application Ranking, and Non-Conformance.

Data Element Description

&volume Software Science value

&cyclomatic Cyclomatic Complexity value

&essential Essential Complexity value

&control_var Control Variable Complexity value

&fpa Function Points value

&knots Control Flow Knots count

&appl_line_tot Total number of lines of code in the application
&avg_lines_pgm Average lines of code per program

&cyc _per_fpa Cyclomatic Complexity value/Function Point value
&fpe Function Point enhancement value
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Exceptions Table

The elements in this table are accessed by indexing an element in the Exception Values

and Names Table.
&gotos The number of GO TO statements
&alters The number of ALTER statements
&entries The number of entry points
&exits The number of program exits
&recursions The number of recursive code occurrences
&perf jumps The number of perform range jumps (perform range
violations)
&live_exits The number of live exit occurrences
&dead code The number of lines of dead code
&dead data The number of unreferenced data definitions

Other Application Names and Other Application Descriptions Table

These elements are used to index the Other Application Names and Descriptions
elements. The values for the other application names and other application descriptions
are defined when the other applications have been analyzed successfully. The number of
elements in the table is one less than the total number of applications (&sappl total).
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This chapter gives detailed information about the Import Facility and how it allows you to
import an application definition into the AKR, and contains these sections:

Section Page

Importing an Application Definition 153
Import Language Reference 154
Import Language Keywords 172

The Import Facility allows you to import an Application definition into the AKR. To
prepare the application definition to be imported, you must edit an existing file or create a
new file, inserting keywords from the Import Language described in this chapter. These
keywords identify the components and attributes for each library and member included in
the file and to convert the application definition to the structure required by the AAE. To
import the Application definition you create, select File » Import/Export.

Importing an Application Definition

To import an application definition into the AKR.

1 Using the Import Language described in "Import Language Reference" on page 154,
create a file containing the keywords to identify the application information,
defaults, and the components and attributes of the application definition.

2 Save the file.

3 Start the product using the procedure defined for your site (see "Initiating a Recap
Session" on page 29).

4 Select File » Import/Export from the Recap Primary screen and press Enter to
display the File - Import/Export pop-up.
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5  Select Import Definition and press Enter to display the File - Import Definition
pop-up.

6  In the Data set name field, enter the name of the dataset that contains the import file
you created in step 1 on page 153. If the high-level qualifier for the dataset name is
different than the TSO user ID, enter the name in single quotes
('"USER.TEST.APPLDEF").

7 In the Member Name field, enter the name of the member containing the import
information. Press Enter to display this message:

APPLICATION <application name> IMPORTED SUCCESSFULLY.
If the import does not complete successfully, verify the dataset and member name
for the import file. If the names are correct, review the structure and syntax of the
import file to locate any errors or invalid data input.

8 Select File » Open application from the Recap Primary screen and press Enter to
display the File - Open Application pop-up. The name of the AKR and application
specified in the import file automatically displays.

9  Press Enter to open the application.

Import Language Reference

Import Language Syntax
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Import statements may start anywhere on the line. Keywords are enclosed by the tags <>.
Each keyword must be coded on a separate line. Each item associated with a keyword
must also be coded on a separate line as shown in Figure 67:

Figure 67  Import Data Item Syntax

<AKER>
T3ER.TE3T. LER
<APPLICATICON WAME?
MNY-APPL
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Import File Structure

The Import File for the application definition contains these major sections:

. Application Information (see Application Information).

. Default information (see "Default Dataset and Attribute Information" on page 156).

. Definition (see "Definition" on page 161).

Application Information

This section specifies the name of the AKR where the application is stored along with the
application name and application description. Figure 68 shows the code for the
Application Information section of an import file.

Figure 68 » Application Information Example

< AKR>

T3ER.TE3T. LAER
<PRODUCT>

RECAFP
<APPLICATICH NAME

INP-FULL
<APPLICATICHN DESCREIFPTICH=
COMPLETE APPLICATION TEST

Field Description

AKR Required. Identifies the dataset name of the AKR
where the application is stored.

PRODUCT Indicates whether the application definition is used
in Recap, Alliance, or both. If both products are
specified, separate the entries by a comma. Valid
entries: ALLIANCE, RECAP.

APPLICATION NAME Required. Specify a one to ten character name for
the application you are defining.

APPLICATION DESCRIPTION Optional. Specify a one to forty character
description.
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Default Dataset and Attribute Information

156

This section specifies the default information for the libraries defined to the application.
All defaults are optional. The defaults specified in the import file override any
corresponding site defaults that were specified during the installation of Recap or
Alliance. The default section must begin with the keyword DEFAULT START and end
with the keyword DEFAULT END.

This is the default information that can be specified:

FILEORG

Identifies the default source manager that is used for all COBOL, JCL, CICS, and
IMS datasets included in the application definition. Only one source manager can
be specified. Valid Entries: PDS, PAN, LIB, VSAM, SEQ, or ENDV.

COBOL VERSION

Identifies the default COBOL version for COBOL libraries and members defined to
the application. Only one version can be specified. If the COBOL version is not
specified, the COBOL version specified during product installation is used by

default. Valid Entries: COB68, COB74, COB2, COB2R3, COB2R4, COB370,
COBMVSVM, COBOS390, ENTCOB31.

COMPILE EXECUTION PARM

Identifies the default compile batch execution parameters used for COBOL libraries
defined to the application.

COBOL SOURCE EXTRACTION EXECUTION PARM

Identifies the default source library manager batch execution parameters used for
COBOL libraries defined to the application.

JCL SOURCE EXTRACTION EXECUTION PARM

Identifies the default source library manager batch execution parameters used for
JCL libraries defined to the application.

CICS SOURCE EXTRACTION EXECUTION PARM

Identifies the default source library manager batch execution parameters used for
CICS libraries defined to the application.
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IMS SOURCE EXTRACTION EXECUTION PARM

Identifies the default source library manager batch execution parameters used for
IMS libraries defined to the application.

STDSQL(86)

Identifies the default SQL usage found in the JCL. If the DB2 STDSQL(86) parm is
found in the compile/link JCL, the default is YES. Valid entries: YES, NO.

With STDSQL(86) or STDSQL(YES), the SQLCA is expanded where the
definition of SQLCODE is found in the program and SQLCADE replaces the
SQLCODE field in the SQLCA structure.

01 SQLCODE PIC X9(9) COMP.
01 SQLCA.

05 SQLCAID PIC X(8).
05 SQLCABC PIC S9(9) COMPUTATIONAL.
05 SQLCADE PIC S9(9) COMPUTATIONAL.

With STDSQL(NO) EXEC SQL SQLCA END-EXEC. Expands the SQLCA and
SQLCODE is field in the SQLCA.

EXEC SQL INCLUDE END-EXEC.
01 SQLCA

05 SQLCAID PIC X(8).
05 SQLCABC PIC S9(9) COMPUTATIONAL.
05 SQLCADE PIC S9(9) COMPUTATIONAL.

COPYLIB
Identifies the default copy library attributes for COBOL libraries and members

defined to the application. Valid entries: Names of valid copy libraries; each library
name must display on a separate line.
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These are attributes of the default copylib. Each attribute must display on a separate
line after the valid default copy library entry.

Attribute Description

COPY FILEORG Identifies the source manager that is used for the
specified copy library. Only one source manager
can be specified. Valid Entries: PDS, PAN, or
LIB.

COPY SUBSYSTEM Indicates whether the SYSLIB DD statement in
the compile JCL makes use of the SUBSYS
parameter. Valid Entries: YES or NO.

COPY PASSWORD Identifies the password for the specified copy
library. If the library is password protected, enter
the password.

COPY VOLSER Identifies the volume serial number for the
specified copy. If the library or member is not
cataloged, enter the volume serial number.

COPY USAGE

Identifies the location of the SYSLIB dataset in the compile JCL. Usage
information is used to determine when the AAE needs to use the copy libraries
defined to the application: during COBOL library processing, during DB2 include
processing, or during both types of processing. Only one COPY USAGE can be
specified. Valid entries: COB, DB2, BOTH.

CA-LIBRARIAN MEMBER COPYDD
Indicates whether the CA-Librarian master file for CA-Librarian members in the

application definition requires the CopyDD feature. If this value is not specified, the
default value is NO. Valid entries: YES, NO.

CA-LIBRARIAN MEMBER PSWD EXISTS
Indicates whether the CA-Librarian members in the application are

password-protected. If this value is not specified, the default value is NO. Valid
entries: YES, NO.
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IMS MACLIB

Identifies the default maclibs for IMS libraries included in the application
definition. Valid entries: Names of valid maclibs; each library name must display
on a separate line.

These are attributes of the default maclib for IMS members. Each attribute must
display on a separate line after the entry for the valid default maclib.

Attribute Description

IMS MACLIB FILEORG Identifies the source manager that is used for the
specified maclib. Only one source manager can be
specified. Valid Entries: PDS, PAN, or LIB.

IMS MACLIB Indicates whether the SYSLIB DD statement in the

SUBSYSTEM compile JCL makes use of the SUBSYS parameter.
Valid Entries: YES or NO.

IMS MACLIB Identifies the password for the specified macro

PASSWORD library. If the library is password protected, enter

the password.

IMS MACLIB VOLSER Identifies the volume serial number for the
specified macro library. If the library or member is
not cataloged, enter the volume serial number.

CICS MACLIB
Identifies the default maclibs for CICS libraries included in the application

definition. Valid entries: Names of valid maclibs; each library name must display
on a separate line.
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These are attributes of the default maclib for CICS members. Each attribute must
display on a separate line after the entry for the valid default maclib.

Attribute Description

CICS MACLIB FILEORG Identifies the source manager that is used for the
specified maclib. Only one source manager can be
specified. Valid Entries: PDS, PAN, or LIB.

CICS MACLIB Indicates whether the SYSLIB DD statement in the

SUBSYSTEM compile JCL makes use of the SUBSYS parameter.
Valid Entries: YES or NO.

CICS MACLIB Identifies the password for the specified macro

PASSWORD library. If the library is password protected, enter

the password.

CICS MACLIB VOLSER Identifies the volume serial number for the
specified macro library. If the library or member is
not cataloged, enter the volume serial number.

Note:
For more information on specifying maclibs in the application definition, see
"Analyzing the Application" on page 43.

. PROCLIB
Identifies the default procedure libraries for JCL libraries and members included in

the application definition. Valid entries: Names of valid procedure libraries; each
library name must display on a separate line.
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Figure 69 shows the code for the Default section of an Import file.

Figure 69 » Default Section Example:

=DEFATLT START=
=FILEQORG=
s
<COBOL WERSION-

2Y31. COELIE

=IMS MACLIE=
IMZESA. MACLIE

<CICE MACLIE:
CIC2330 _MACLIE

<PROCLIE >
2Yel. PROCLIE
2Yez . PROCLIE

<COMPILE EXECUTION PARM-
LIE,QUOTE

<CA-LIBPARIAN MEMEER PSUD EXISTS=
o]

<CA-LIBRADRTAN MEMEER COPFYDD =
N0

=DEFAITLT ENI:=-

The Definition section specifies these application components:

. COBOL

e Load Module

. JCL

. CICS CSD files

. CICS PPT, PCT, and FCT tables

. CICS BMS maps

. IMS DBD, PDB, DFSMDA, MFS, and Stage 1 libraries

Each library must be defined separately and any members defined for that library must be

specified immediately following the library definition. These keywords are used to define
the various components of the library definitions:

. LIBRARY
Identifies the dataset name for the COBOL, Load, JCL, CICS, IMS library or CICS

CSD file being defined. This keyword must precede each library definition. Only
one library can be defined at a time. Valid entries: a valid dataset name.
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FILEORG

Identifies the source manager that is used for all COBOL, JCL, CICS, and IMS
datasets included in the application definition. Only one source manager can be
specified. If not specified, the FILEORG defined in the default section is used.

Valid Entries: PDS, PAN, LIB, VSAM, SEQ, or ENDV.

OBJECT KIND (required)
Identifies the library type for the dataset specified. This entry is required for each

library defined to the application. Only one library type can be specified at a time.
Valid entries: CICS, COBOL, IMS, JCL, LOAD, or CSD.

COBOL VERSION
Identifies the COBOL version for the COBOL library and members defined to the

application. Only one version can be specified. Valid Entries: COB68, COB74,
COB2, COB2R3, COB2R4, COB370, COBMVSVM, COBOS390, ENTCOB31.

COMPILE EXECUTION PARM
Identifies the default compile batch execution parameters used for COBOL libraries
defined to the application. Compile execution arms can only be specified within a

COBOL library definition or in the MEMBER OVERRIDE information for
COBOL member(s).

COBOL SOURCE EXTRACTION EXECUTION PARM

Identifies the source library manager batch execution parameters used for COBOL
libraries defined to the application.

JCL SOURCE EXTRACTION EXECUTION PARM

Identifies the source library manager batch execution parameters used for JCL
libraries defined to the application.

CICS SOURCE EXTRACTION EXECUTION PARM

Identifies the source library manager batch execution parameters used for CICS
libraries defined to the application.

IMS SOURCE EXTRACTION EXECUTION PARM

Identifies the source library manager batch execution parameters used for IMS
libraries defined to the application.
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STDSQL(86)

Identifies the SQL usage found in the JCL. If the DB2 STDSQL(86) parm is found
in the compile/link JCL, the default is YES. Valid entries: YES or NO.

With STDSQL(86) or STDSQL(YES), the SQLCA is expanded where the
definition of SQLCODE is found in the program and SQLCADE replaces the
SQLCODE field in the SQLCA structure.

01 SQLCODE PIC X9(9) COMP.
01 SQLCA.

05 SQLCAID PIC X(8).
05 SQLCABC  PIC S9(9) COMPUTATIONAL.
05 SQLCADE  PIC S9(9) COMPUTATIONAL.

With STDSQL(NO) EXEC SQL SQLCA END-EXEC. Expands the SQLCA and
SQLCODE is field in the SQLCA.

EXEC SQL INCLUDE END-EXEC.
01 SQLCA

05 SQLCAID  PIC X(8).
05 SQLCABC  PIC S9(9) COMPUTATIONAL.
05 SQLCADE  PIC S9(9) COMPUTATIONAL.

PASSWORD

Identifies the password for the specified COBOL, JCL, CICS, or IMS library or
member if the library or member(s) is password protected. Enter the password.

VOLSER
Identifies the volume serial number for the specified COBOL, JCL, CICS, or IMS

library or member(s) if the library or member is not cataloged. Enter the volume
serial number.
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CA-LIBRARIAN MEMBER PASSWORD

Identifies the password for a CA-Librarian member if that member in the
application is password protected. The member is password protected if the
<CA-LIBRARIAN MEMBER PSWD EXISTS> is set to YES.

COPYLIB

Identifies the copy library for the specified COBOL library or member(s). Each
copy library must display on a separate line. Copy library information can only be
specified within a library definition or in the MEMBER OVERRIDE information.

For each copy library, this information can be specified.

Attribute Description

COPY FILEORG Identifies the source manager that is used for the
specified copy library. Only one source manager
can be specified. Valid Entries: PDS, PAN, or
LIB

COPY SUBSYSTEM Indicates whether the SYSLIB DD statement in
the compile JCL makes use of the SUBSYS
parameter. Valid Entries: YES or NO

COPY USAGE Identifies the location of the SYSLIB dataset in
the compile JCL. Usage information is used to
determine when the AAE needs to use the copy
libraries defined to the application: during
COBOL library processing, during DB2 include
processing, or during both types of processing.
Only one COPY USAGE can be specified. Valid
entries: COB, DB2, BOTH

COPY PASSWORD Identifies the password for the specified copy
library. If the library is password protected, enter
the password.

COPY VOLSER Identifies the volume serial number for the
specified copy. If the library or member is not
cataloged, enter the volume serial number.
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Figure 70 shows the code to define copy library information for

MY .FIRST.COBOL.LIB:

Figure 70 « Copy Library Attribute Definition

<LIBRAET =
My, FIRST.COBOL. LIE
<0EJECT EIMD=
COEOL
“COBOL VWEREIOMN=
COE&E
<PASSTIORD=
SRCPEL
“VOLEER~
SRCOOL
=COFYLIE=
My FIRST. COFY. LIE
=COPYT FILEORG=
PD3
=COPY PASETIOERD =
CETPETD
=COPFYT VOLSER=
SRCO0OL
=COPYT USAGE=
COe

. IMS MACLIB

Identifies the maclib attributes for IMS libraries and members included in the
application definition. Valid entries: Names of valid macro libraries; each library
name must display on a separate line.

Attribute Description

IMS MACLIB FILEORG  Identifies the source manager that is used for the
specified maclib. Only one source manager can be
specified. Valid Entries: PDS, PAN, or LIB.

IMS MACLIB Indicates whether the SYSLIB DD statement in the

SUBSYSTEM compile JCL makes use of the SUBSY'S parameter.
Valid Entries: YES or NO.

IMS MACLIB Identifies the password for the specified macro

PASSWORD library. If the library is password protected, enter
the password.

IMS MACLIB VOLSER Identifies the volume serial number for the

specified macro library. If the library or member is
not cataloged, enter the volume serial number.
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CICS MACLIB
Identifies the maclib attributes for CICS libraries and members included in the

application definition. Valid entries: Names of valid macro libraries; each library
name must display on a separate line.

Attribute Description

CICS MACLIB FILEORG  Identifies the source manager that is used for the
specified maclib. Only one source manager can be
specified. Valid Entries: PDS, PAN, or LIB.

CICS MACLIB Indicates whether the SYSLIB DD statement in the

SUBSYSTEM compile JCL makes use of the SUBSY'S parameter.
Valid Entries: YES or NO.

CICS MACLIB Identifies the password for the specified macro

PASSWORD library. If the library is password protected, enter

the password.

CICS MACLIB VOLSER  Identifies the volume serial number for the
specified macro library. If the library or member is
not cataloged, enter the volume serial number.

PROCLIB

Identifies the procedure library attributes for the specified JCL library or member.
Each procedure library must be entered on a separate line.

IDMS INFORMATION START and IDMS INFORMATION END

Marks the beginning and end of the IDMS attribute information. IDMS information
can only be specified in a COBOL library definition, or in the MEMBER
OVERRIDE information for COBOL members. For each IDMS attribute, the
information listed below can be specified. If an item is not specified, the default
specified in the Default section of the import file is used. If the default is not
specified in the import file, the site default specified at installation is used.

Attribute Description

IDMSDMLC EXECUTION If you are using IDMS release 10, enter the
PARM IDMSDMLC parameters for the IDMS
preprocessor.

IDMS DDNAME/dataset Enter the IDMS DD name and the dataset name
NAME used by the library or member.
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Figure 71 shows the code used to define IDMS information for MY.FIRST.COBOL.LIB.

Figure 71 « Example IDMS Attribute Definition

< LIBPATT =
MY_FIRST. COBOL.LIE
=0EJECT EIND=
COEBOL
=COBEOL WERSIOMN=
COB&S
=IDMS INFOFMATION START=
=IDMEDMLC EXECUTION PARIM-
PAFM COEZ HEDRE
=IDME DDMAMESDATA 2ET MAME-
STEPLIE IDM3.DEVL.STEPLIE
STEPLIE IDM:.PROD.STEPLIE
ETECTL IDME. PROD . STECTL
DLODDE IDMS. PROD .DLODDE
DICTDE IDMS.DEVL.DICTLE
DICTDE IDME. PROD .DICTLE

=IDMS INFOFMATION EHNL:=

. MEMBER LIST START and MEMBER LIST END

After a library and its attributes have been defined, these tags identify the beginning
and end of the list of members within the library that are to be included in the

definition.

Figure 72 shows the code required to include members in the library

COBOL.SOURCE.LIBRARY.

Figure 72 « Member Definition

=LIEPAFY =
COEOL. SOURCE. LIBRARY
=0BEJECT EIND=
COEOL
=MEMEEER LIST START>
Memhernsmel
Menb ernsmes
=MEMEEER LIZT END*
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. MEMBER OVERRIDE INFORMATION START and MEMBER OVERRIDE
INFORMATION END

If you want to specify member attributes that are different than those defined at the
library level, these keywords identify the beginning and end of the override
information. The keyword should be followed by the list of members that use the
specified attributes.

Figure 73 shows the code to define the member override information for Membernamel
and Membername?2.

Figure 73 « Member Override Definition

<MEMEEER. OVERRIDE INFOPMATTION START=
<MEMEER LIST START=
Membernemel
Menhername?
<MEMEEER. LIST END=

<FILEORG=
LIE
<COEOL VERSION=
COBSS
<COFYLIE=
SYE1. COPYLIBE

<MEMEEER OVERRIDE INFORMATION EMD=

. GROUP LIST START and GROUP LIST END

After a CSD file is defined, these tags identify the beginning and end of the list of
group names within the file that are to be included in the definition. Wildcard
characters (* and ?) are accepted. Each group name should be listed on a separate
line.
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8 Import Facility

Figure 74 shows the Application Information section and Default Information section of

an import file.

Figure 74 » Import File Example (1 of 3)

+* *
*  APPLICATION INTORMATION *
+* *
CAEE-

UZER. TEST . AIE,
<PEOIUCT >

BECEP
<APFLICATION WAME:

IMP-FULL

< APPLICATION DESCRIPTION>
COMFLETE APFLICAT ION TEST

* *
* LIEFAULT INFORMAT ION *
* *

<DEFATLT START >

< TILE(RG>
POE

< COEOL ERS IOH-
COEZ

< COFY USAGRE >
COE

< COFYLIE>
3T81. COFYL IE

<IM3 MACLIE=>
IMSES A MACLIE

<CICS MACLIEZ
CIC3220 MACLIE

<FROCLIE>
STE1.FROCLIE
SYEE.PROCLIE

< COMF ILE EXECUT ION FARM:-
LIE,QUOTE

<C&-L IERARI AN MEMEEE PSTD EX IST3:>
Ha

<C&-L IERARI AN MEMEEE COPWDD-
Ha

~DEFATLT END:
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170

Figure 75 and Figure 76 on page 171 show the Application Definition section of an
import file for Recap and Alliance.

Figure 75 « Import File Example (2 of 3)

* *
* DEFINITION INFOFMATION *
* *
<L IERARY>

MY _FIRST.COEOL .LIE
<0BJECT EIND>
COEOL
=COBEOL WERSIONZ-
COEGS
<COPYLIEZ-
Y. FIRST.COFY.LIE
<COFY FILEORE>
FDZ
<COFY UBAGE >
COE
<COPYLIEZ
Y. FIRST.DEZ. INCLUDE L IE
<COFY U3AFE >
DEZ
<COPYLIEZ-
Y. FIRST.DEZ. COFY.LIE
<COFY U3AFE >
EOTH
< IDMS IMPORMAT ION START -
= IDMSDML C EXECUT ION>-
FARM G0ES HERE
<IDMZ DDWAME/DAT2 SET WaME:
STEFLIE IIMS.IEVL.3TEFLIE
STEPLIE IDIME.FROD.STEPLIE
SYECTL IDME.PROD.SYWSCTL
DLODDE IDME .PROD .DLOLIDE
DICTDE IDME.DEVL.DICIDE
DICTDE IDME.FPROD.DICIDE
< IDME IMPORIAT I0M END >
<MEMEER. LIST STAFT >
EATHAN
ROEIM
HARTY
<MEMEEER. LIST EMD>
<MEMEEER. OERRIDE INFORMAT IOW 3T 2RT >
<MEMEEER. LIST STARTZ
0ZZIE
HARRIET
<MEMEEE. LIST END>
<COEOL UEERS IO
COE270
<COFYLIE>
T FIRST . COPY.L IEX
<MEMEEER. OVEFRIDE INFORMAT ION EWD:-




Figure 76  Import File Example (3 of 3)

8 Import Facility

<LIBRARY>
MY .SECOND.COBOL.LIB
<OBJECT KIND>
COBOL
<LIBRARY>
MY.FIRST.JCL.LIB
<OBJECT KIND>
JCL
<PROCLIB>
MY .FIRST.PROCLIB
MY .SECOND.PROCLIB
<MEMBER LIST START>
MJCLOO1
MJCL008
MJCL009
<MEMBER LIST END>
<LIBRARY>
MY.FIRST.LOAD.LIB
<OBJECT KIND>
LOAD
<MEMBER LIST START>
MLOADOO1
MLOADO002
<MEMBER LIST END>
<LIBRARY>
MY.FIRST.CICS.LIB
<OBJECT KIND>
CICs
<MEMBER LIST START>
MFCT001
MPPTO001
<MEMBER LIST END>
<LIBRARY>
MY.FIRST.CSD.DSN
<OBJECT KIND>
CICs
<FILEORG>
VSAM
<LIBRARY>
MY.FIRST.IMS.LIB
<OBJECT KIND>
IMS
<IMS MACLIB>
IMSESA.MACLIB
<MEMBER LIST START>
MDBDGEN1
MPSBGEN1
<MEMBER LIST END>
<MEMBER OVERRIDE INFORMATION START>
<MEMBER LIST START>
MSTG1
<MEMBER LIST END>
<IMS MACLIB>
IMSESA.SYSS.MACLIB
<MEMBER OVERRIDE INFORMATION END>
<LIBRARY>
MY.FIRST.SEQ.FILE
<OBJECT KIND>
COBOL
<FILEORG>
SEQ
<END DEFINITION>
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Import Language Keywords

Application Information

. AKR

. APPLICATION NAME

. APPLICATION DESCRIPTION
. PRODUCT

Default Section

DEFAULT START
DEFAULT END
FILEORG
COBOL VERSION
COMPILE EXECUTION PARM
COBOL SOURCE EXTRACTION EXECUTION PARM
JCL SOURCE EXTRACTION EXECUTION PARM
CICS SOURCE EXTRACTION EXECUTION PARM
IMS SOURCE EXTRACTION EXECUTION PARM
STDSQL (86)
COPYLIB
COPY FILEORG
COPY SUBSYSTEM
COPY PASSWORD
COPY VOLSER
COPY USAGE
IMS MACLIB
IMS MACLIB FILEORG
IMS MACLIB SUBSYSTEM
IMS MACLIB PASSWORD
IMS MACLIB VOLSER
CICS MACLIB
CICS MACLIB FILEORG
CICS MACLIB SUBSYSTEM
CICS MACLIB PASSWORD
CICS MACLIB VOLSER
PROCLIB
CA-LIBRARIAN MEMBER COPYDD
CA-LIBRARIAN MEMBER PSWD EXISTS
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Library and Member Definition Section

LIBRARY
OBJECT KIND
FILEORG
COBOL VERSION
COMPILE EXECUTION PARM
COBOL SOURCE EXTRACTION EXECUTION PARM
JCL SOURCE EXTRACTION EXECUTION PARM
CICS SOURCE EXTRACTION EXECUTION PARM
IMS SOURCE EXTRACTION EXECUTION PARM
STDSQL (86)
COPYLIB
COPY FILEORG
COPY USAGE
COPY SUBSYSTEM
COPY VOLSER
COPY PASSWORD
CA-LIBRARIAN MEMBER COPYDD
CA-LIBRARIAN MEMBER PSWD EXISTS
PASSWORD
VOLSER
IDMS INFORMATION START
IDMSDMLC EXECUTION PARM
IDMS DDNAME/DATA SET NAME
IDMS INFORMATION END
MEMBER LIST START (must display after library attributes)
MEMBER LIST END
MEMBER OVERRIDE INFORMATION START
MEMBER OVERRIDE INFORMATION END
IMS MACLIB
IMS MACLIB FILEORG
IMS MACLIB SUBSYSTEM
IMS MACLIB PASSWORD
IMS MACLIB VOLSER
CICS MACLIB
CICS MACLIB FILEORG
CICS MACLIB SUBSYSTEM
CICS MACLIB PASSWORD
CICS MACLIB VOLSER
PROCLIB
CA-LIBRARIAN MEMBER PASSWORD
GROUP LIST START
GROUP LIST END
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Export Metrics Facility

This chapter guides you through the creation of files for export and for output from export
and contains these sections:

Creating CDF Files for Export 175

Output from Export 177

Recap provides a feature that creates a file to export portfolio analysis data to
spreadsheets, PC database managers, and graphics presentation packages. First, you
create a comma delimited file. This file can then be downloaded to your PC for input into
spreadsheet, database manager, and graphics presentation software packages.

Creating CDF Files for Export

Assume that your organization uses Cyclomatic Complexity in determining if a program
is a candidate for re-engineering. That is, in order for a program to be re-engineered, it
must be complex in comparison to other programs within the application.

In a spreadsheet package, you want to list all the applications within an enterprise (AKR)
sorted by Function Points (primary sort) and Cyclomatic Complexity (secondary sort). In
addition, you also want to list each program's Essential Complexity (to indicate the
degree of structure in the program).

Because you want to list all the programs in an AKR, perform the steps outlined in this
section for each application.
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To create CDF files
1 Select File » Import/Export to display the File - Import/Export pop-up.

2 Select Export Metrics to initiate the File - Export Metrics pop-up, shown in
Figure 77.

Figure 77 « File - Export Metrics Pop-up

File - Export Metrics

Specify AKR data set name, application name, options, and DEWs to create
metrics andsor function points COF files. Then press Enter.

AKR data set name ‘USER.TEST.AKR’
Application name APPL-CZR3@

Options 1 1. HMetrics and function points
2. Metrics only
3. Function points only

Metrics (Partitioned or Sequential data szet)
Data set name

Function point summary {(Partitioned or Sequential data szet)
Data set name

Function point details (Partitioned or Sequential data zet)
Data set name

3 Enter the appropriate information on the File - Export Metrics pop-up.

a  Required. Enter the application name and the AKR dataset name where the
application resides.

b  Select the Metrics and function points option (type 1 in the Options field).
¢ Ifyouwantto have Recap generate the CDF files, press Enter. These CDF files

are created:

— USERID.XEMnnnnn.VIASCDFM contains program and application
metrics data.

— USERID.XEMnnnnn.VIASCDFP contains the application function
point data

— USERID.XEMnnnnn.VIASCDFS contains detail function point data
for the application.
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4  To specify a target dataset other than the generated export target dataset, choose one
of these options:

. To specify a Partitioned dataset, type in the dataset and member name.

— If the PDS does not exist, an error message displays indicating that the
dataset is not found.

— Ifthe member already exists and contains data, a screen displays to confirm
whether you want to overwrite the existing data. If the member is empty,
the exported data is loaded into the empty member. If the member does not
exist, it is created and the data loaded into the newly created member.

. To specify a Sequential Dataset, the dataset can exist but must be empty.

— If the existing dataset contains data, a screen displays to confirm whether
you want to overwrite the existing data.

— If the dataset does not exist, it is created.

After these steps are performed for all the applications, use your communication software
to download these files to your personal computer. Then, using a spreadsheet package,
use its Import Facility to retrieve the CDF files. After formatting the spreadsheet
appropriately, the programs are shown in comparison to each other in terms of
complexity and structure.

Output from Export

When the data is exported up to three files can be created. One file contains application
and program metric information (see Program and Application Metric Information). The
other two files contain detailed (see “Detailed Function Point Information” on page 178)

and summarized (see “Summarized Function Point Information” on page 179) function
point information.

Program and Application Metric Information

If the default name is used for the file collecting the exported metric data, this is the
format:

USERID.XEnnnnn.VIASCDFM
where nnnnn is a number assigned by Recap.
You can specify a file name if you do not want to use the default. This file provides one

row of heading information followed by an application metric total row. Each program in
the application follows with its respective metric information.
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Figure 78 shows the output for the program and application metric information.

Figure 78 » Application and Metric Information - Exported Data

"APPLICATION™,"PROGRAM®,"FPA"," FPE", "VOLUME",” CYCLOMATIC","ES SENTIAL", "CONTROL™, "ENOTS",
"GOTOS" ,“ALTERS™, “ENTRIES" , "EXITS", "RECURSIONS”,“PERFORM JUMPS”,”LIVE EXITS","DEAD CODE",
"DEAD DATA™,"LINES OF CODE","DATE", TIME", PHYS LOC™, VERSION®

"TELEPHONE ™, "*TOTALS*",171,0, 146539,474,63,1241,28,45,0,8,37,1,8,2,23,272 6579,
"14-MAR-19957,718:15: 177,9160,1

“TELEPHONE ™ ,"¥3101",,,12312,45,4,116,0,1,0,1,3,0,0,0,13,36, 556, " 14-MAR-1995",
"1g8:14:177,779,1

“TELEPHONE ™, “¥3201",,,37830,136,10,394,16,17,0,2,17,0,0,0,0,52, 2011, "14-MAR-1995",
"16:14:307,3123,1

"TELE PHONE " ,"¥$ 202" ,,,2436,15,1,43,0,0,0,1,2,0,0,0,0,0,205, "14-MAR-1 9957,
"16:14:387,275,1

“TELE PHONE " ,“¥3203",,,15111,42,14,110,8,9,0,2,5,0,0,0,0,89, 890, " 14-MAR-1995",
"18:14: 487, 1635,1

“TELEPHONE ™, “¥3204" ,,,39380,117,17,287,1,9,0,1,5,0,4,0,5,48,1459, " 14-MAR-1995",
"16:15:007,1676,1
"TELEPHONE™, "¥$205",, ,39460,119,17,291,1,9,0,1,5,1,4,2,5,47,1458, "14-MAR-1995",
"16:15:177,1672,1

Note:

The exported metric data heading information contains two references to lines of code.
The LINES OF CODE heading refers to the logical lines of code. The PHYS LOC
heading refers to the physical lines of code.

Detailed Function Point Information

If the default name is used for the file collecting the exported detailed function point
information, this is the format:

USERID.XEnnnnn.VIASCDFS
where nnnnn is a number assigned by Recap.

You can specify a file name if you do not want to use the default. This file provides one
row of heading information and a row of metric information for the application that
provides the name of the application, including these names:

. DET

. FTR

. RET counts

. USE (level of complexity, HIGH, AVG, LOW)
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Figure 79 shows the output for the detail function point information.

9 Export Metrics Facility

Figure 79 » Detail Function Point Information - Exported Data

" APPLICATION" ,"TYPE", "FTR","RET", "DET", "USE", "TEXT"

n SALES II’ IIEI II’ Ill:l_lll l.-"':l II’ Ill_4ll l.-" LI:"[']'II’ IIDELETE
"SALES","E0","0-1","0", "1-5" "LOW", "EEPORT
n SALES II’ IIEI:I II’ IIZ_SII l.-"':l II’ IIl_EII l.-" LI:"[']'II’ IIREPDRT
"SALES","E0","0-1","0", "1-5" "LOW", "EEPORT
n SALES II’ IIEI:I II’ IIZ_SII l.-"':l II’ IIl_EII l.-" LI:"[']'II’ IIREPDRT
"SALES","E0","0-1","0", "1-5" "LOW", "EEPORT
n SALES Ilf IIED Ilf "l:l_l" l.-"':' Ilf Ill_5ll l.-" LD‘D]'II( IIREPDRT
"SALES","E0","0-1","0", "1-5" "LOW", "EEPORT
n SALES Ilf IIED Ilf "l:l_l" l.-"':' Ilf Ill_5ll l.-" LD‘D]'II( IIREPDRT
"SALES","E0","0-1","0", "1-5" "LOW", "EEPORT
n SALES Ilf IIED Ilf "l:l_l" l.-"':' Ilf Ill_5ll l.-" LD‘D]'II( IIREPDRT
"SALES","E0","0-1","0", "1-5" "LOW", "EEPORT
n SALES Ilf IIED Ilf "l:l_l" l.-"':' Ilf Ill_5ll l.-" LD‘D]'II( IIREPDRT
"SALES","E0","Z-3","0","1-5", "LOW", "EEPORT
n SALES Ilf IIED Ilf "l:l_l" l.-"':' Ilf Ill_5ll l.-" LD‘D]'II( IIREPDRT
"SALES","E0","Z-3","0","1-5", "LOW", "EEPORT
n SALES Ilf IIED Ilf "l:l_l" l.-"':' Ilf Ill_5ll l.-" LD‘D]'II( IIREPDRT
"SALES","E0","0-1","0", "1-5§" "LOW", "EEPORT

{-FDr 1"
PRINT-FILE"
PRINT-FILE"
PRINT-FILE"
PRINT-FILE"
PRINT-FILE"
PRINT-FILE"
PRINT-FILE"
PRINT-FILE"
PRINT-FILE"
PRINT-FILE"
PRINT-FILE"
PRINT-FILE"
M3-FILE"
PRINT-FILE"
FILE1"
SQ-FIZE"
PRINT-FILE"

"SALES", "EO", "O-1", 0", "6-19", "LOW" , "REPORT SQ-FSz©

"ERLES", "EQ", "0-1","0", "1-5", "LOW", "REDORT

PRINT-FILE"

Summarized Function Point Information

If the default name is used for the file collecting the summarized function point

information, this is the format:

USERID.XEnnnnn.VIASCDEP

where nnnnn is a number assigned by Recap.

You can specify a file name if you do not want to use the default. This file provides one
row of heading information and a row for the application that contains the total for each
of these function point types:

. External Input (EI)

. External Output (EO)

. External Inquiry (EQ)

. Internal Logical File (ILF)

. External Interface File (EIF)

A total for all function point types for the application is also calculated.
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Figure 80 shows the output for the summary function point information.

Figure 80 « Summary Function Point Information - Exported Data

"EPPL ICETION"’ "EI"’ "EO"’ "EQ"’ r ILF "’ "E IF "’ "TOTEL r
"SALES™,,40,0,24,0, 87
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Exporting an Application Definition

This chapter provides information about copying the application definition, exporting it,
and creating one similar to the original one, and contains these sections:

Section Page

Exporting the Application Definition 18

—

Copying the Application Definition 183

Recap provides a feature that gives the ability to export an application definition from
Recap. The exported definition may be stored in a sequential file or a PDS member.

To export the application definition file, follow this step:

» Select File » Import/Export from the Recap Primary screen and press Enter.

Exporting the Application Definition

The exported application definition consists of a series of keyword control statements
whose syntax is consistent with the requirements of the Import Facility. The keyword
control cards identify the AKR, the application name and description, and the application
components and their associated attributes.

Note:

See "Import Facility" on page 153 for a description of the keyword control statement
syntax.

The exported application definition can be used to accomplish these tasks:
. Create a backup of the application definition for easy recovery.
. Copy an application definition from one AKR to another.

. Copy an application definition to use as a template in creating a similar definition.
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Export Procedure

To export the application definition

1 Identify or create a sequential file or a PDS library to contain the exported definition.
The file must have a record length of 80.

2 Select File » Import/Export from the Recap Primary screen and press Enter to
display the File - Import/Export pop-up.

3 Select Export Definition and press Enter to display the File - Export Definition
pop-up, shown in Figure 81.

Figure 81 ¢ File - Export Definition Pop-up

File - Export Definition
Command ===

Type BKR and Export information, then press enter.

Application Knowledge Repository (AKR):

Data set name . . . 'USER.TEST.AKR'
Application name . . USERAPPL
Export:

lata set name . . .
Hember . . . . . . . USERAFPL _

4  Enter this information:
a  The AKR Data set name.
b  The Application name.
¢ The Export Definition Data set name.

d  Ifthe Export Definition dataset is a PDS, specify the Export Definition
Member name.

5 Press Enter to execute the export request.
When the export of the application definition is complete, the message

"<application name>" EXPORTED displays in the short message area of the
File - Export Definition pop-up.
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10 Exporting an Application Definition

Copying the Application Definition

If you intend to use the exported application definition as input to the Import Definition
Facility to copy the application definition to another AKR, you must edit the exported
application definition.

To copy the application definition to another AKR

1

On the File - Export Definition pop-up, change the AKR dataset name to the target
dataset name.

Change the application name to the desired application name.

Note:
Within an AKR, application names must be unique.

Creating a Similar Application Definition

If you intend to use the exported application definition as input to the Import Facility to
create a template for a new application definition, you must edit the exported application
definition.

To create a template for a new application definition

1

On the File - Export Definition pop-up, change the AKR dataset name to the target
dataset name.

Change the application name to the desired application name.

Note:
Within an AKR, application names must be unique.

Update the application definition using one of these methods:

Edit the exported application definition file. Modify the keyword control
statements, and their associated attribute keyword control statements, to create the
new application definition.

Or

Import the application definition into the target AKR, then use the online
application definition function to modify the imported definition.
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AKR Utilities

This chapter explains both online and batch AKR utilities and contains these sections:

Section Page

Introduction to AKR Management 185
AKR Structure 185
Online AKR Utilities 186
Batch AKR Utilities 186
Batch AKR Reports 201
Allocating and Expanding AKRs without ISPF 209

Introduction to AKR Management

The AKR is the repository for all information used by the ESW family of components.
Analyzed programs are stored in the AKR for use by ESW. ESW provides both online
and batch utilities for managing the AKR.

AKR Structure

The AKR is a BDAM or VSAM file organization. You can define a single AKR to be
shared by all users, or multiple AKRs to be used by departments, groups, or individuals.

Note:
See the ASG-Center Installation Guide for more information about the AKR.
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Online AKR Utilities

The online AKR utilities includes these pop-ups:

. The File - AKR Utility pop-up used to rename or delete a program, or to display the
AKR Directory.

. The File - AKR Directory pop-up used to view all programs in an AKR. This
pop-up can be used to rename or delete a group of programs. Statistics about the
AKR are also shown on this pop-up.

. The File - AKR Allocate/Expand pop-up used to allocate a new AKR or to expand
an existing AKR.

Note:

When you use the Allocate/Expand utility, the default AKR organization type is applied.
For example, if your site's default AKR type is sequential, any new AKR allocated is
created as a sequential file, and any non-sequential AKR expanded is reorganized as a
sequential file. See the online help for examples of each of these pop-ups.

Batch AKR Utilities

186

The Batch AKR Utility is used to maintain the AKR without using ISPF. This table lists
the commands available in the batch utility.

Command Function

ANLZSTAT Produces the Analysis Status Report for one or more AKRs. This
(See page 190)  applies to Application level products only.

COMMENTS Includes comments with the command.
(See page 191)

CONVERT Converts selected members from a previous product release level to
(See page 192)  the current release level.

COPY Copies selected members from one AKR to another.
(See page 193)

DELETE Deletes selected members from the AKR.

(See page 194)

EXPORT Creates metrics and function point CDF files. This applies to Recap
(See 195) only.
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HELP
(See page 196)

Prints the AKR Utility Help Report.

INIT
(See page 197)

Formats a previously-defined dataset into an AKR format.

MOVE
(See page 198)

Copies selected members from one AKR to another and deletes them
from the original AKR.

PRINT
(See page 199)

Prints AKR directory information, or COBOL source listings for
selected AKR members.

PUNCH
(See page 200)

Produces a file that contains the AKR directory information, or the
COBOL source code for selected AKR members.

Job Control Statements

The Batch AKR Utility uses these JCL statements, shown in Figure 82. The VIAAKRIN
and VIAAKROT DD statements describe AKRs that are used for AKR Utility
processing. The VIASYSIN DD control cards consist of the necessary Batch AKR
commands described in "Command Format" on page 188 . See the description for each
command to determine which DD statements are affected.

Figure 82 « Batch AKR JCL Statements

AAUTILITY
AP3TEPLIE
AAVILRERTN
AAVTAREROT
AATTAPRINT
AATTAPUNCH
AAVIALOG
AAVTASYRTIN

£

EXEC PGM=VIASAKED,FEGION=3000EK,PARM=""

DI
DI
LD
DI
DI
DI
DI

<control cards>-

DISP=35HE,D3N=(A3G load library)
DISP=5HE,D5H0=(Input AKR)
DISP=5HE,D5N=(0utput AKR)
IW¥S0UT=4 [(Print file description)
I¥30U0T=E [(Punch file description)
STI0UT=4 (Log £ile)

+*
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Control Cards

Commands are passed to the Batch AKR Utility with the control cards following the
VIASYSIN DD statement. Control cards must conform to these standards:

. Command information must be contained in columns 1 through 72 of the control
card.

. Only one command can be entered on each control card.

. Only one control card can be used per command.

All control cards with command disposition and command summaries are printed to the
VIALOG AKR Utility Log file. Blank control cards are ignored.

Command Format

188

Commands that use member names accept special characters to signify generic names.
An asterisk (*) represents zero or more characters. A question mark (?) represents one
character. For example:

Command Description

DBA* Specifies all members that begin with DBA and end with any other
characters.

D?A* Specifies all members that begin with D followed by one character, followed
by an A, then followed by any other characters.

DBA???  Specifies all members that begin with DBA and end with any three
characters.

The LASTUSED parameter is used to provide the selection criteria for several
commands. The specified number represents the number of days since the member was
last referenced online, or the date the member was analyzed if it has not been referenced.

The REPLACE parameter is used to specify that members are to be replaced on the
output AKR. The NOREPLACE parameter is used to prevent members from being
replaced on the output AKR. NOREPLACE is the default value.
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Command Syntax

Each Batch AKR Utility command is described in this chapter. The descriptions include
the format and a brief explanation of the command parameters. These notational
conventions and symbols are used to describe command syntax:

Item Description

ABBREViations Command abbreviations are shown in uppercase letters;
lowercase letters in the command are optional.

lowercase Lowercase values indicate user-supplied variable information.
Underline The default value of an operand is underlined.
| Vertical Bar Vertical Bar - A vertical bar separates synonymous commands or
operands.
e Right and left ending arrows indicate the end of the command
syntax.

An operand or keyword displaying on the main command line is

—— required — |
required.

Coor I_I An operand or keyword displaying below the main command
optiona line is optional.

Stacked operands below the main line show a choice of one

choice1 : :
':choiceZ optional item.
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ANLZSTAT Command

Function

L 2
_~

AMLISTAT

Produces the Analysis Status Report for one or more AKRs submitted with the job. The
report provides this information:

. Analysis composition and status information for each AKR
. Analysis composition and status information for applications within each AKR

. Detailed analysis information on the components within each application

Operands
None. However, the ANLZSTAT statement must be followed by one or more AKR
dataset names, for example:
//VIAARKRU.VIASYSIN DD *
ANLZSTAT
VIAALXX.DEVL.SAMPAKR
ASG.VIACENXX.AKR
Usage Notes

190

The ANLZSTAT command is specified in the input card for the Batch AKR job,
VIASAKRU. The VIAAKRIN file is not referenced by this command. ANLZSTAT must
be followed by one or more AKR dataset names. Each AKR dataset name must be on a
separate line.

A report is written to the DD name, VIASARPT. In the default JCL, the DD name is
defined as a SYSOUT file. You can override this DD statement and make it a permanent
file. However, for each job run the permanent file must be deleted or a new file specified.
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The ANLZSTAT command looks at each component in the each AKR submitted in the
job. The Analysis Status Report is generated for application level components only (i.e.,
Alliance and Recap applications). An Analysis Status Report is not generated for
program level components (e.g., Encore, Insight programs).

See "Analysis Status Report" on page 204 for examples of the report and additional
information. Commands that use member names accept special characters to signify
generic names.

Command Description

DBA* Specifies all members that begin with DBA and end with any other
characters.

D?A* Specifies all members that begin with D followed by one character, followed
by an A, then followed by any other characters.

DBA???  Specifies all members that begin with DBA and end with any three
characters.

COMMENT Command

¥
A

l—CommentJ

Function

Includes a comment with the commands.

Operand Description

Comment User-supplied text.

Operands

Usage Notes

Blank control cards are ignored.
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CONVERT Batch AKR Command

Conwvert  —membet
LA&STUzed = nbrdays NOTINPIace_—‘

LAST U zed < nbrdays IMNPlace
LAZTzed = nbrdays

LASTUzed <= nbrdays

Function

Converts selected members that were analyzed by a prior release product to the current
release level.

Operand Description

member Can be a specific or generic name as described in "Command
Format" on page 188.

Operand

LASTUsed Used to select members based on the number of days since they
were last used, as described in "Command Format" on page 188.

NOREPIace Prevents existing members from being replaced by members
with the same name. This is the default.

REPlace Replaces members that have the same name on the receiving
AKR.

Usage Notes

Members are copied from the AKR specified in the VIAAKRIN DD statement to the
AKR specified in the VIAAKROT DD statement, as described in "Job Control
Statements" on page 187.
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COPY Batch AKR Command

Function

Operands

LASTUzed = nhbrdsys
LA&STU=ed = nbrdays

Copy  —member

LASTUzed = nbrosys NOREPIa-:e:‘

FEPlace
LASTUsed == nbrdays

Copies selected members from one AKR to another.

Operand Description

member Can be a specific or generic name as described in "Command
Format" on page 188.

LASTUsed Used to select members based on the number of days since they
were last used, as described in "Command Format" on page 188.

NOREPIace Prevents existing members from being replaced by members
with the same name. This is the default.

REPlace Replaces members that have the same name on the receiving
AKR.

Usage Notes

Members are copied from the AKR specified in the VIAAKRIN DD statement to the
AKR specified in the VIAAKROT DD statement.

If the installation option AKR-DSORG-VSAM is specified as NO, expanding an existing
VSAM AKR converts it to a BDAM AKR.

Note:

When you use the Allocate/Expand utility, the default AKR organization type is applied.
For example, if your site's default AKR type is sequential, any new AKR allocated is
created as a sequential file, and any non-sequential AKR expanded is reorganized as a
sequential file.
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DELETE Batch AKR Command

Function

Operands

¥
A

DELete ——member
LASTU=sed = nbrdays

LASTU=ed = nbrdays
LASTU=sed = nbrdays

LaSTUsed == nbrdays

Erases selected members from the AKR.

Operand Description

member Can be a specific or generic name as described in "Command
Format" on page 188.

LASTUsed Used to select members based on the number of days since they
were last used, as described in "Command Format" on page 188.

Usage Notes
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Note:
Members are deleted from the AKR specified in the VIAAKRIN DD statement.

Members that begin with VIA cannot be deleted using this command. All ESW test

members begin with VIA. If these members must be deleted, see "Online AKR Utilities"
on page 186.
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EXPORT Batch AKR Command

ExPort —application

L rpa— | -
Function
Creates metrics and function point CDF files.
Operands

Operand Description

application Can be a specific or generic name as described in "Command
Format" on page 188.

FPA Generates only function point information. If FPA is not
specified, both metrics and function point information are
generated.

Usage Notes
Note:

EXPORT is available only for Recap users.
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HELP Batch AKR Command

P

Help| ¢ ]

Function

Prints a description of the Batch AKR Ultility and the commands that can be used.

Operand

None

Usage Notes
. A question mark (?) can be used as an alternate command.

. The HELP command has no operands.

The Help Report is printed to the SYSOUT specified in the VIAPRINT DD statement.
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INIT Batch AKR Command

IMIT

¥
A

DSname

[H=sname)

Function

Initializes a new AKR. This internal command is used by the online AKR Utility
Allocation function. See "Online AKR Utilities" on page 186 for additional information.

Operand

Operand Description

DSname(dsname)  Used to specify the dataset name for the new AKR.

Usage Notes

The AKR dataset to be initialized must be created prior to the initialization. The AKR
that is initialized can be described in the VIAAKRIN DD statement. The VIAAKRIN DD
statement is ignored if the DSNAME parameter is specified.
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MOVE Batch AKR Command

hCve —member

LASTUsed > nbrdays NOREPIace:‘
LASTUsed < nbrdays REFlace

LASTUsed = nbrdays
LASTUsed <= nbrdays -

Function

Moves selected members from one AKR to another. Specified members are copied to the
receiving AKR and erased from the sending AKR.

Operand Description

member Can be a specific or generic name as described in "Command
Format" on page 188.

Operands

LASTUsed Used to select members based on the number of days since they

<

were last used, as described in “Command Format” on page 188.

NOREPIace Prevents existing members from being replaced by members
with the same name. This is the default.

REPlace Replaces members that have the same name on the receiving
AKR.

Usage Notes

Members are moved from the AKR specified in the VIAAKRIN DD statement to the
AKR specified in the VIAAKROT DD statement.
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PRINT Batch AKR Command
PRInt DIRectary —
I—member LASTUsed = nbrdays
rmember LASTUsed < nbrdays
L—pRogram—] LASTUsed = nbrdays
LASTUsed <= nbrdays
Function

Prints AKR directory information for the entire AKR or for a specified member, or the
source code for a specified member.

Operand Description

blank If the PRINT batch AKR command is entered with no operand,
the AKR directory information is printed.

Operands

DIRectory Prints AKR directory information. This is the default. If a
member is specified, the AKR directory information for that
member only is printed.

PROgram Prints the COBOL source for the specified AKR member. The
generated COBOL source listing contains expansions of all
COPYBOOKSs or INCLUDEs, as well as the results of any
source preprocessors such as CICS macro expansion.

member Can be a specific or generic name as described in "Command
Format" on page 188.

LASTUsed Used to select a member based on the number of days since it
was last used, as described in "Command Format" on page 188.

Usage Notes

Directory information or COBOL source is extracted from the AKR specified in the
VIAAKRIN DD statement and is printed to the SYSOUT specified in the VIAPRINT DD
statement (see "AKR Utility Directory Report" on page 202).
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PUNCH Batch AKR Command

PUMch DIRectol

UiEectary
I—memher:‘ LASTUsed = nbrdays —|
member LASTUsed < nbrdays —|
PROgram LASTUsed = nbrdays—|
LASTUsed <= nbrdays—

¥y
A

Function

Produces a file that contains AKR directory information for the entire AKR or a specified
member, or the source code for a specified member.

Operand Description

blank If the PUNCH batch AKR command is entered with no operand,
a file is produced containing the AKR directory information.

Operands

DIRectory Produces a file that contains directory information. This is the
default. If a member is specified, the AKR directory information
for that member only is printed.

PROgram Produces a file that contains COBOL source code for the
specified AKR member. The generated COBOL source contains
expansions of all COPYBOOKSs or INCLUDEs, as well as the
results of any source preprocessors such as CICS macro
expansion.

member Can be a specific or generic name as described in "Command
Format" on page 188.

LASTUsed Used to select a member based on the number of days since it

1

was last used, as described in "Command Format" on page 188.

Usage Notes

Directory information or COBOL source is extracted from the AKR specified in the
VIAAKRIN DD statement and is written to the file specified in the VIAPUNCH DD
statement. The file that is produced is in standard IBM IEBUPDTE Utility format. ADD
control cards are produced for each logical entity. The NAME parameter contains the
member name for COBOL source. The NAME parameter contains AKRDIRnn for
directory information, where nn is a consecutively assigned number (see "Punch
Directory File" on page 208).
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This table shows the format of the file produced by the PUNCH DIRECTORY command:

AKR Punch Directory File Format

Member name 10 Character
Number of source lines 6 Right justified
Days since last used 4 Right justified
Analyze date 9 DD MMM YY
Analyze job name 8 Character
Analyze CPU 4 Character
Analyze product level 8 Character

Last reference date 9 DD MMM YY
Last reference user ID 8 Character

Last reference CPU 4 Character

Batch AKR Reports

Examples of these reports are provided in this chapter:

. AKR Utility Directory Report, shown in Figure 83 on page 202.

. AKR Utility Log (see Figure 84 on page 203).

. Analysis Status Report (see Figure 85 on page 205, Figure 86 on page 206,
Figure 87 on page 207, and Figure 88 on page 208).

. File produced by the PUNCH DIRECTORY command (see Figure 89 on page
208).
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AKR Utility Directory Report

The AKR Utility Directory report, shown in Figure 83, lists the results of a PRINT
DIRECTORY command and is written to the VIAPRINT DD file. The title line contains
the ASG component level information, title, date and time the job was executed. The
report lists this information:

. AKR dataset used
. Command used to produce the report

. Directory information for the selected members.

Figure 83 « AKR Ultility Directory Report

ASG-CENTER-03 Px._x LWLnrm AKER UTILITY - DIRECTORY DD MMM ¥Y HH:MM:SE
Page 1

AFR: REG_ ASCCEMan. AER
Commamnd: PEINT DIRECTOEY * LASTUSE = 7

Member Lasz -—-—--—-——————--—-—— Analyzed ---———————---—— —————-— La=st
Befereniced —--
Name Line=s TUse Date Time Johb CP1T Lewel Date Time
Jaoh CP1I
ACTGOO1S 40 18 LD MMM ¥Y HH-MM:S5S5 SRENFEEL CPUL TNOZ0000 DD MMM ¥¥ HH:MM:- =5
SPENCTY CPUA
PYRLOOSE 17 18 LD MMM ¥Y HH-MM:S5S5 SRENFEEL CPUL TNOZ0000 DD MMM ¥¥ HH:MM:- =5
SPENDEM CPUA
PYRLOLOS 17 2 DD MMM ¥Y HH-MM:S5S5 SRENDEMA CPUAL THNO30000
SROO0SA 493 =] LD MO ¥Y HH:MMI:S55 SRENJIDER CPUC INO30000
WEEOO4 4 g5 12 LD MMM ¥Y HH-MM:S5S5 SRENFEEA CPUC INOI0000 DD MMM ¥7 HH:MM:- 55
SRENCTY CPUA
XRSCLO?0 1714 12 LD MMM ¥Y HH-MM:S5S5 SRENDEMA CPUA TNOZ0000 DD MMM ¥7 HH:MM:- 55
SRENCTY CPUA
XRSCL100 15 9 DD MMM ¥Y HH:MM:S5S5 SRENFEEZ CPUC INO30000
HERSCLz00 41 10 LD M ¥Y HH:MM:S5S5 SRENCTYZ CPUC INOI0000 DD MIPDT ¥1 HH:MIM:- =55

SEEMCTY CPUL

**%* End of Directory Peport *+*
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AKR Utility Log

The VIALOG AKR Utility Log, shown in Figure 84, provides a summary of the
commands issued to the Batch AKR Utility, and contains this information:

. Comments
. Commands
. Completion messages

. Short summary of commands processed

The heading includes the ESW component level information, and the date and time the
job was executed. Comments are enclosed in a box comprised of asterisks. The second
page contains the log summary.

Figure 84 « AKR Utility Log

AZG-CENTER-05 Px.x LVLmum AKER UTILITY LOG DD MM ¥ HH:MM:S2
Page 1

e o o e b o o e o o o e o e e e o i o o e g o e e o e o o e o e e i e o i o e e o e o e e e o |:||:| 14 |:||:||:| |:|

* PRODTTCE & PEPORT CONTATMNING DIBECTORY INFORMATICON FOR ALL * o0150000

*  MEMEERS OF A5G BENATSSLZ AFE (VILZAFRIN) THAT HAWVE * o0ls0000

* MOT BEEN PEFEREMCEDL IN THE LAST 7 DATS. * oo17a000

e o o e b o o e o o o e o e e e o i o o e g o e e o e o o e o e e i e o i o e e o e o e e e o |:||:| 18 |:||:||:| |:|

* ool1s0000

PRINT LIBECTORY * LASTUSE = 7 oozaoooo0

VIA1259T & DIBRECTORY ENTEIES SUCCESSFULLYT PRINTELD.

O0z10000
e o o e b o o e o o o e o e e e o i o o e g o e e o e o o e o e e i e o i o e e o e o e e e o |:||:| 22 |:||:||:| |:|
* PRODUCE A FILE COMTATNING DIRECTORY IMFORMATICH FOR ALL * o0zz0000
*  MEMEERS OF ASCG.RENATSSAZ AR (VILAFRIN) THAT HRWVE * oo0z40000
* MOT BEEN PEFEREMNCED IMN THE LAST 7 DAYS. * O0Z500an0
e o o e b o o e o o o e o e e e o i o o e g o e e o e o o e o e e i e o i o e e o e o e e e o |:||:| 26 |:||:||:| |:|
* O0Z7a0an0
PUMNCH LIBECTORY * LASTUSE = 7 oozs0000
TIAlZ20T & DIBECTORY ENTRIES SUCCESSFULLY PUNCHED.
TIA1314T ***+ END OF VWIASYSIN ***
AZG-CENTER-03 Bx.x LVLrmn AR UTILITY LOG - STPIMARY D MMM Y¥Y HH: MM: S8
Page 2
TIAl301T 2 DIRECTORY ENTRIES PRINTED 0 FAILED.
TIALZ0ZT 2 DIRECTORY ENTRIES FPUNCHED 0 FAILED.

VIALl31EI *** END OF SUMMALRY REPORT *++*
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Analysis Status Report

204

The Analysis Status Report provides a list of AKR names and statistics about the
applications in each AKR, as the result of submitting an ANLZSTAT command. The
report is written to the VIASARPT file and provides these levels of information:

. AKR summary and detail
. Application summary and detail

. Library summary and detail

At each reporting level, information is given on:
. The number of members.

. The number of members successfully analyzed, unsuccessfully analyzed, and not
analyzed.

. The number of lines of source code in analyzed COBOL programs.

At the library level, additional detailed information is provided for each member:
. Application component type (i.e., COBOL, JCL, LOADMODULE, etc.).

. Detailed analysis (e.g., time and date, return code).
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Analysis Status Report - AKR Summary

The Analysis Status Report, shown in Figure 85, begins with a cover page that lists the
AKRs input for the report. The first section of the report provides this information:

. AKR Summary (i.e., the AKR(s) input for analysis and the number of applications
and members in each AKR)

. Member analysis

Figure 85 » Analysis Status Report - AKR Summary

AMALYETS ETATUZ DEPOLRT FACE: 1
DDMINIYYET HH-MM-SS

AMALYEIS REPORT STUMMATRY
AFE COMPOSITION STRMMARY

COONT % OF TOTAL)

# AFDL APPLICATIONS MEMEEDRE
(A)1 VWIAALxx. DEVL. SAMPAER 10100} Z2 (100}
TOTAL 11000 ZEZ¢100)

AKER AMALTYETE STTMMARY

MEMEET. COUNT (3 OF TOTAL IN AER)

i STCCESZFUL M EUC CESEFUL HOT AMALYZEDr LINEZ OF CODE(% OF TOTAL)
Bl Z1( 3% 1 5 of 17,087 (100
TOTAL Z1§ 2L 1lf L af 0 17,067 {100)

Field Description

(A) Each AKR is identified with a number and name.

(B) The number used to reference that AKR.
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Analysis Status Report - AKR Detail

The second section of the Analysis Status Report, shown in Figure 86, provides this

information:

. AKR Detail (i.e., a breakdown of the applications within each AKR)

. Member analysis

Figure 86 » Analysis Status Report - AKR Detail

AMALYETS STATTE REPORT FAGE:

DLIDOCETTy  HHECMM-EE

AFER DETAIL INFORMATION

AFD:  VIALLxx DEVL.SAMPRET

NUMEER OF APPLICATIONS: 1
NUMEED. OF LIEPARTES: ]
NUMEER. OF MEMEEREZ: ZZ
LINES OF CODE: 17,0567

AFR COMPOSITION DETATL

# LPPLICATION DEZCRIPTION

{4 1 ACCTE-PYEL

UIAALxx SAMPLE ACCTS-PAYEL APPLT

TOTAL

AFP ANALTSIS DETATL

MEMEER COUNT (% OF TOTAL IN APPLICATION)

# SCCESSFUL UMNSUCCESSFUOL  NOT ANALTEED
(B} 1 Z1{ 95) 1l 5 of o
TOTAL Z1g 25 1i & of o

z

COTINT (%

OF TOTAL)

LIEDAPIES

24100}

24100}

MEMEERS

ZE{100)

ZZ 4100}

LINEZ OF CODE(% OF TOTAL}

17,087(100)

17,087¢100)
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(A) Each application is identified by number and name.

(B)

The number used to reference the application.
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Analysis Status Report - Application Detail

The last section of the Analysis Status Report provides this information:

Application Detail (i.e., a breakdown of the composition of each application)
Members per library analysis information, shown in Figure 87.

Analysis/Composition Detail information for each member analyzed (see Figure 88
on page 208).

Figure 87 « Analysis Status Report - Application Detail

AMALYSTS STATUS REPORT PAGE: 3
DDMMIMTEYYY HH:MM:E58

APPLICATION DETATL INFORMATTION

APPLICATION: ACCTE-IYEL
DESCRIPTION: VIAATxx SAMPLE ACCTE-PAYEL APPLICATION
LED: VIAALxx DEVL . SAMDALED
TOTAL LIELARTES: 2
TOTAL MEMEERS: ZE
LIMNES 0OF CODE: 17, 0&87
MEMEER AMALTEIZS SUMMALY - MEMEERS (3 OF TOTAL IN APDPLICATION)
SICCESSFUL - 21§ 25
TNSTICCESSFUL: 1 Ei
THMAMALYZED : af o)

APPLICATION COMPOSITICH STMMARY

COUMT(: OF TOTAL)

# LIBRARTY MEMEERZ LINES OF CODE

(A) 1 WIAALxx. SAMPADPDL . CHTL i &) of o
£ VIAALxx. SAMPAPPL.COEOL 150 &8) 17,067 (100}
3 WIAALx:x SAMPAPPL . LOADLIE ai 27 o) 0l

TOTAL EZ (100} 17,057 ¢100)

(A)

Each library is identified by number and name.
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Figure 88 « Analysis Status Report - Composition Detail

APPLICATION AMALYETIS,COMPOSITION DETATL
LAST ANBLYSIS
LTERARY LIMES OF CODE e ket
MEMEER NUMEEER i3 OF TOTAL) TYPE TIME DATE RC
CooL (By 3 0f 0} LOAD MOD IMM:22 1EFEEL23E O
CDOSAPGH z Zz,5ZE{ 1&5) COBOL MM:25 1EFEEL29E 4
CDOEE PEM z2 Lez( 3 COBOL MM:-22 1ZFEEL22E5 0
CLOSCPGEM z 5321 4) COBOL MM-25 1EFEE129E 0O
Co 10 3 0f 0} LOAD MOD IMM:22 1EFEEL23E O
CD LOAPGH z 1,651( 10} COBOL MM:-55 1ZFEEL22E O
CI LOE P Z2 &20( 4) COBOL MM:-55 12FEEL225 0
o1l 3 0f 0} LOAD MOD MM-22 1EFEE123E5 O
CD110PGEM z 1,z48({ 7)) COBOL MM:-25 1EFEEL23E O
[WEN R ] 0f{ 0 LOAD MOD MM:22 1ZFEEL29E5 O
CD LEA PG Z2 2,597 15) COBOL MM:-55 1ZFEBL295 4
CD 1LEE PGEM z 1,447({ &) COBOL MM-22 1EFEE123E O
Chlz ] 0f{ 0 LOAD MOD MM:22 1ZFEEL29E5 O
(T B0 PGH z 1,295( 8) COBOL  PM:% 1PFEEL995 O
ChE0 3 0f 0} LOAD MOD MM-22 1EFEE123E5 O
CDEQAPGH z 735 4) COBOL MM:-25 1EFEEL23E O
CDZ0E P z2 924( L) COBOL MM:-22 1ZFEEL22E5 0
ChEOCPGEM z 983 &) COBOL MM-55 1EFEE199E 4
Ch 20D PEM z 883 &) COBOL MM-25 1EFEE129E5 4
CDEQEPGEM z EEg( 2 COBOL MM:-25 1EFEEL23E O
CDLZ00 PG z2 242( Z) COBOL MM:-Z2 1ZFEEL29E 2
DATLY 1 i 0} JCL MM-25 1EFEE129E 0O
TOTAL 17,0&87(100)
(B) The number is then used to reference the library.

Punch Directory File

The Punch Directory, shown in Figure 89, is written to the VIAPUNCH DD file when the
PUNCH DIRECTORY command is processed. The file is formatted in standard IBM
IEBUPDTE Utility format. The first card, . /ADD. . ., is an IEBUPDTE control card
that indicates the following cards are to be added to a PDS in the NAME parameter. The
cards that follow are in the format described in the PUNCH DIRECTORY command
description. The last card is an IEBUPDTE control card that indicates the end of the
control cards. See "PUNCH Batch AKR Command" on page 200 for the format of the
AKR Punch Directory File.

Figure 89 « AKR Punch Directory File

./ ADD MAME=AFFDIR] LIZT=ALL

ACTCOOLE 40 1Dl MMM TYSDENFEEACTUATNOZOO00DD MMM YYSDEMCTY CIUL
IYRLOOSE 17  1elD MMM TYSRENFEEACTUATHNOZOOOODD MMM YYSRENDEM CIUA
FYRLO1OS 17 S0 MMM TV SREND EMACPUATHO20000

SRO005A 433 80D MMM TY3RENIDERALCPUICTIMOZ0000

WEEQD 4 &€ 1ZIDD MMM TYSDENFEEACTUCINOZOO00DD MMM YYSDEMCTY CIPUL
HRECLO70 1714 1Z00 MMM TVSREMD EMACPTIRTMOZ0000DT MMM VTS RENCTY CITUTA
HBECL 100 iR S0D MM TYERENFEEZ CPUCTHOZ0000

HBECLZOO 41l 100D MMM TYSDENCTTZCPUCINOZOO00DD MMM YYSDEMCTY CIUL
./ ENDTID
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The Batch AKR Utility can allocate and expand VSAM AKRs without using ISPF. ESW
provides the VIASAKRA JCL to allocate an AKR, and the VIASAKRX JCL to expand

an AKR. Figure 90 and Figure 91 on page 210 show the VIASAKRA JCL. Figure 92 on
page 211, and Figure 93 on page 212, and show the VIASAKRX JCL.

Figure 90 » VIASAKRA JCL for a VSAM AKR (1 of 2)

)CM LR R RS R RS S SRS SRS SRR E SRS SRS SRR R R R RS SRR EEEEEEEE]
)CM * ASG, INC. ASG-CENTER Rx.x MONTH YYYY *
)CM * *
)CM * SKELETON JCL FOR SUBMITTING A BATCH JOB TO ALLOCATE AND *
)CM * INITIALIZE A ASG APPLICATION KNOWLEDGE REPOSITORY (AKR) . *
)CM hhkkhkhkhkhkhhkhkhkhkhkhkhkhkhkhhkhkhkhkhhkhhkhhhkhkhkhkhkhkhkhkrhkhkhkrkhkhhkhkhhkrhkhkhkhkkhkhkhhkhkkxkhhkhkkx
) CM

) CM

)CM LR R SRR R R RS SRS SRR EEEEEEEESS

)CM * JOB STATEMENT INFORMATION *

)CM hkkhkhkhkkhkhkhkhkhhkhkhkkhkhkhkkhkhkhkxhkhkhkhhhkhkxhkhkxx

) CM

&VSV11JB1

&VSV11JB2

&VSV11JB3

&VSV11JB4

) CM

)CM hkkhkhkhkkhkhkhkhkhkhkhkhkkhkhkhkkhkhkxhkhkhkrhhkhkkhkkhkkxx

)CM * IN-STREAM JCL PROCEDURE *

)CM LRSS R R R RS SRS SRR SR EEEEEEE]

) CM

) IM VIASAKAP OPT

// PEND

//*

) CM

)CM hkkhkhkhkkhkhkhkhkhhkhkhkkhkhkhkkhkhkhkrhkhkhkrkhkhkhkxhkkhkkhx

)CM * EXECUTE JCL STATEMENTS *

)CM LR SRR R RS RS E SRS SRR EEEEEEEESS

) CM

//VIASAKRA EXEC VIASAKAP

/7%

) SEL &VSV32VAC = YES

00010000
00020003
00030000
00040000
00050003
00060000
00070000
00080000
00090000
00100000
00110000
00120000
00130000
00140000
00150000
00160000
00170000
00180000
00190000
00200000
00210000
00220000
00230000
00240000
00250000
00260000
00270000
00280000
00290000
00300000
00310000
00320000

To allocate an AKR

1 Replace XX in the NAME (XX), NAME (XX.DATA), and the DSNAME (XX)

parameters with the name of the AKR to be allocated.

2 Replace XX (xX) with the allocation units values and quantities for your site.
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Figure 91 « VIASAKRA JCL for a VSAM AKR (2 of 2)

//DEFAKR.SYSIN DD *
DEFINE CLUSTER -

(NAME (&VSVIDB) -

) SEL &VSV32SPU = CYLINDERS

CYLINDERS (&VSV32SPA) -

) ENDSEL
) SEL &VSV32SPU = RECORDS

RECORDS (&VSV32SPA) -

) ENDSEL
) SEL &VSV32SPU = TRACKS

TRACKS (&VSV32SPA) -

) ENDSEL
) SEL &VSV32DCL 2= &Z

DATACLAS (&VSV32DCL) -

) ENDSEL
) SEL &VSV32MCL 2= &Z

MGMTCLAS (&VSV32MCL) -

) ENDSEL
) SEL &VSV32VOL 2= &Z

VOLUME (&VSV32VOL) -

) ENDSEL
) SEL &VSV32SCL %= &Z

STORCLAS (&VSV32SCL) -

) ENDSEL

CONTROLINTERVALSIZE (4096) -
NUMBERED -

RECORDSIZE (4089 4089) -
RECOVERY -

) SEL &VSV32UNQ 2= NO

UNIQUE -

) ENDSEL

SHAREOPTIONS (3 3)) -

) SEL &VSV32CAT %= &Z && &VSV32PSW = &2

CATALOG (&VSV32CAT) -

) ENDSEL
) SEL &VSV32CAT 2®= &Z && &VSV32PSW %= &Z

CATALOG (&VSV32CAT/&VSV32PSW) -

) ENDSEL
DATA -
(NAME (&VSVIDB. .DATA))
) ENDSEL
//*

//INITAKR.STEPLIB DD DSN=VIASH46.PROD.XALOAD,DISP=SHR ** IN-HOUSE**
//INITAKR.VIASYSIN DD *
INIT DSNAME (&VSVIDB)

//*

) SEL &VSV32CAT 2= &Z
//INITAKR.STEPCAT DD DSN=&VSV32CAT,

//
//*

DISP=SHR

) ENDSEL
//DELETE.SYSIN DD *
DELETE &VSVIDB PURGE

//*

) SEL &VSV32CAT 2= &Z
//DELETE.STEPCAT DD DSN=&VSV32CAT,

// DISP=SHR

//*

) ENDSEL

) CM

)CM *** END OF VIASAKRA ***
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Figure 92 « VIASAKRX JCL for a VSAM AKR (1 of 2)

11 AKR Utilities

CM & & o ok ok ok ok ok ok ok ok K o K ok K K ok ok ok ok ok ok kK ok ok ok K ok K ok K ok K ok K R K kK kK K kK K ok ok ok ok ok Kk K ok K kK

CM * ASG, INC. ASG-CENTER Rx.x MONTH YYYY *
cM * *
CM * SKELETON JCL FOR SUBMITTING A BATCH JOB TO EXPAND A *

)

)

)

)

)CM * ASG APPLICATION KNOWLEDGE REPOSITORY
) Ok ko ok ok ok ok ok ko ok ok ok ok ok ko ok ok ok Kk ok Kk ok ok Kk ok ok ok ok K ok ok S Kk ok K K ok ok Kk ok ok ko ok Kk ok ok KR ok K K
)

)

)

)

)

)

cM
cM

CM LEEE RS SRR SRR EEEEEEEEEEEEEEEEEEEEES
CM * JOB STATEMENT INFORMATION *

CM  FFF ok kk kokkok ok ok kA k ok kA ok k ok ok ok ko Kk ko kK Rk

&VSV11JB1

&VSV11JB2

&VSV11JB3

&VSV11JB4

) CM

)CM LR R SRR R R RS RS E SRS SRR EEEEEEEES
)CM * IN-STREAM JCL PROCEDURE *
)CM hkkhkhkhkkhkhhkhkhhkhkhkkhkhkhkkhkhkrhkhkhkrhhkhkkhkhkx
) CM

) IM VIASAKXP OPT

// PEND

/7%

) CM

)CM LRSS SRR R RS RS EE RS SRR EEEEEEEESS
)CM * EXECUTE JCL STATEMENTS *

) CM % %o ok ko ok ok ko ok ok ok ok Xk ok ok Kk ok Kk Rk Kk K
) CM
//VIASAKRX EXEC VIASAKXP
/1%
) SEL &VSV32VAC = YES
//DEFAKR.SYSIN DD *
DEFINE CLUSTER -
(NAME (&VSVIDB. .EX) -
) SEL &VSV32SPU = CYLINDERS
CYLINDERS (&VSV32SPA) -
) ENDSEL
) SEL &VSV32SPU = RECORDS
RECORDS (&VSV32SPA) -
) ENDSEL
) SEL &VSV32SPU = TRACKS
TRACKS (&VSV32SPA) -
) ENDSEL
) SEL &VSV32DCL %= &Z
DATACLAS (&VSV32DCL) -
) ENDSEL
) SEL &VSV32MCL 2= &Z
MGMTCLAS (&VSV32MCL) -
) ENDSEL
) SEL &VSV32VOL 2= &Z
VOLUME (&VSV32VOL) -
) ENDSEL
) SEL &VSV32SCL %= &Z
STORCLAS (&VSV32SCL) -

) ENDSEL
CONTROLINTERVALSIZE (4096) -
NUMBERED -
RECORDSIZE (4089 4089) -
RECOVERY -

) SEL &VSV32UNQ 2= NO
UNIQUE -

) ENDSEL

SHAREOPTIONS (3 3)) -
) SEL &VSV32CAT %= &Z && &VSV32PSW = &2
CATALOG (&VSV32CAT) -
) ENDSEL
) SEL &VSV32CAT ®= &Z && &VSV32PSW %= &Z
CATALOG (&VSV32CAT/&VSV32PSW) -

(AKR) .

*

00010000
00020003
00030000
00040000
00050003
00060000
00070000
00080000
00090000
00100000
00110000
00120000
00130000
00140000
00150000
00160000
00170000
00180000
00190000
00200000
00210000
00220000
00230000
00240000
00250000
00260000
00270000
00280000
00290000
00300000
00310000
00320000
00330000
00340000
00350000
00360000
00370000
00380000
00390000
00400000
00410000
00420000
00430000
00440000
00450000
00460000
00470000
00480000
00490000
00500000
00510000
00520000
00530000
00540000
00550000
00560000
00570000
00580000
00590000
00600000
00610000
00620000
00630000
00640000
00650000
00660000
00670000
00680000
00690000
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Figure 93 « VIASAKRX JCL for a VSAM AKR (2 of 2)

) ENDSEL
DATA -
(NAME (&VSVIDB. .EX.DATA))
) ENDSEL
//*

//INITAKR.STEPLIB DD DSN=VIASH46.PROD.XALOAD,DISP=SHR ** IN-HOUSE**
//INITAKR.VIASYSIN DD *

INIT DSNAME (&VSVIDB..EX)

//*

) SEL &VSV32CAT °= &Z
//INITAKR.STEPCAT DD DSN=&VSV32CAT,
// DISP=SHR

) ENDSEL

//*

) SEL &VSV32EXD 2= MIX
//REPRO.SYSIN DD *

REPRO INDATASET (&VSVIDB) -
OUTDATASET (&VSVIDB..EX) -
REPLACE

/7%

) SEL &VSV32CAT 2= &Z
//REPRO.STEPCAT DD DSN=&VSV32CAT,
// DISP=SHR

) ENDSEL

//*

//RESIZE.STEPLIB DD DSN=VIASH46.PROD.XALOAD,DISP=SHR ** IN-HOUSE **
//RESIZE.VIASYSIN DD *

RESIZE DSNAME (&VSVIDB. .EX)

/1%

) SEL &VSV32CAT 2= &Z
//RESIZE.STEPCAT DD DSN=&VSV32CAT,
// DISP=SHR

) ENDSEL

) ENDSEL

//*

) SEL &VSV32EXD = MIX
//COPY.VIASYSIN DD *

COPY * NOREPLACE

) ENDSEL

//RENAME.SYSIN DD *

DELETE &VSVIDB PURGE

ALTER &VSVIDB..EX -
NEWNAME (&VSVIDB)
) SEL &VSV32VAC = YES
ALTER &VSVIDB..EX.DATA -
NEWNAME (&VSVIDB. .DATA)
) ENDSEL
//*
) SEL &VSV32CAT 2= &%
//RENAME . STEPCAT DD DSN=&VSV32CAT,
// DISP=SHR
) ENDSEL
/7%
//DELETE.SYSIN DD *
DELETE &VSVIDB..EX PURGE
//*
) SEL &VSV32CAT 2= &2
//DELETE.STEPCAT DD DSN=&VSV32CAT,
// DISP=SHR
) ENDSEL
/7%
) CM
)CM *** END OF VIASAKRX ***
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11 AKR Utilities

To expand an AKR

1 Replace XX in the NAME (XX.EX), NAME (XX.EX.DATA), DSNAME (XX.EX),
INDATASET (XX), and the OUTDATASET (XX.EX) parameters with the name of
the AKR to be expanded.

2 Replace XX (xX) with the allocation units values and quantities for your site.

To rename an AKR

1 Replace the XX in the DELETE statement with the AKR to be renamed.

2 Enter the new AKR name in the NEWNAME (XX) parameter.

213



ASG-Recap User’s Guide

214



1 2 Application Conversion

Converting Recap Applications to Recap 3.2 and later

To take advantage of the more accurate function point values calculated in the 3.2 or
higher release of Recap, ASG recommends that you do a full analyze of your applications
from Recap.

Note:

You must reanalyze all COBOL programs from versions of Recap prior to 3.2 to convert
them to a version of Recap 3.2 and later.
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Report Options

This Chapter contains report options used to control report generation and to specify
various report formats. Each report option is summarized in this section. The options may
be set during installation but you may override the defaults by changing the JCL when
you generate the reports. (See "Generating Recap Reports" on page 43.)

In this table, the product default for each option is underlined and abbreviations are
shown in uppercase (e.g., AplCmp abbreviates to AC, and NOAplCmp abbreviates to
NOAC). These defaults reflect the information on the installation tape. See "Report
Descriptions" on page 81 for a list of the actual reports that were selected to be generated.

Report Options

Descriptions

AplCmp Generates the Application Comparison report. The default is
NOApICmp APLCMP.

AplDef Generates the Application Definition report. The default is
NOAplDef APLDEF.

AplExc Generates the Application Exceptions report. The default is
NOAplExc APLEXC.

AplFpa Generates the Application Function Point Analysis report. The
NOAplFpa default is APLFPA.

AplMtc Generates the Application Metrics report. The default is
NOApIMtc APLMTC.

AplPrg Generates the Application Progress report. The default is
NOApl!Prg APLPRG.

BaNner Produces a banner page that precedes the Table of Contents for
NOBaNner the generated reports. The default is BANNER.

CoLon=; (colon)

Specifies the substitution character to be used in place of colons
on the reports. The default is : (colon).

EntMtc
NOEntMtc

Generates the Enterprise Metrics report. The default is
ENTMTC.
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Report Options Descriptions

EntExc Generates the Enterprise Exceptions report. The default is
NOEntExc ENTEXC.

ExcSum Generates the Executive Summary report. The default is
NOExcSum EXCSUM.

LiNesperpage=60 LINESPERPAGE is used to specify the number of lines to be
printed on each page of the reports. The default is 60.

PgmCmp Generates the Program Comparison report. The default is
NOPgmCmp PGMCMP.

PgmHst Generates the Program History report. The default is
NOPgmHst NOPGMHST.

PgmPrg Generates the Program Progress report. The default is
NOPgmPrg PGMPRG.

VCHAR=[- Specifies the substitution character to use in place of vertical bars
VE=[- on the reports. The default is | (vertical bar).

MasterIndex Generates the report master index. The default is
NOMasterIndex MASTERINDEX.

The Report Options Table lists the default report options as defined on the installation
tape and their corresponding names.

Report Options Execution JCL. PARM Values

1. Report-Appl-Comparison=YES (Default) APLCMP or AC

Report-Appl-Comparison=NO NOAPLCMP or NOAC
2. Report-Appl-Definition=YES (Default) APLDEF or AD

Report-Appl-Definition=NO NOAPLDEF or NOAD
3. Report-Appl-Exception=YES (Default) APLEXC or AE

Report-Appl-Exception=NO NOAPLEXC or NOAE

4. Report-Appl-FunctionPoint=YES (Default) = APLFPA or AF

Report-Appl-FunctionPoint=NO NOAPLFPA or NOAF
5. Report-Appl-Metrics=YES (Default) APLMTC or AM
Report-Appl-Metrics=NO NOAPLMTC or NOAM




13 Report Options

6. Report-Appl-Progress=YES (Default) APLPRG or AP
Report-Appl-Progress=NO NOAPLPRG or NOAP
7. Report-Banner-Page=YES (Default) BANNER or BN
Report-Banner-Page=NO NOBANNER or NOBN
8. Character-Colon=: COLON or CL
9. Report-Enterprise-Metrics=YES (Default) ENTMTC or EM
Report-Enterprise-Metrics=NO NOENTMTC or NOEM
10. Report-Enterprise-Exception=YES (Default) ENTEXC or EE
Report-Enterprise-Exception=NO NOENTEXC or NOEE
11. Report-Executive-Summary=YES (Default) EXCSUM or ES
Report-Executive-Summary=NO NOEXCSUM or NOES
12. Report-Lines-Per-Page=60 LINESPERPAGE or LN
13. Report-Pgm-Comparison=YES (Default) PGMCMP or PC
Report-Pgm-Comparison=NO NOPGMCMP or NOPC
14. Report-Pgm-Metric-History=YES PGMHST or PH
Report-Pgm-Metric-History=NO (Default) = NOPGMHST or NOPH
15. Report-Program-Progress=YES (Default) PGMPRG or PP
Report-Program-Progress=NO NOPGMPRG or NOPP
17. Character-Vertical-Bar=| (Default) VE
VCHAR
18. Report-Master-Index=YES (Default) MASTERINDEX OR MI
Report-Master-Index=NO NOMASTERINDEX OR NOMI
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Help Facility

This chapter describes the various online Help facilities available and methods to access
them, and contains these sections:

Section Page

Help Navigational Commands 223
Screen and Pop-up Help 224
Report Help 225
General Information 226
Specific Information 227
Help Abends 228
Help Messages 229
Printing Messages 231

Comprehensive and context sensitive Help facilities are provided that answer most
questions online. The Help Tutorial contains help information for several subjects, such
as screens, pop-ups, reports, messages, and abends. The Help Tutorial also includes a
Table of Contents that describes each major Recap function, and a comprehensive Index
for viewing specific information.
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To request Help, follow this step:

» Choose one of these options:
. Select Help on the action bar and press Enter.
. Press PF1/13.

. Type HELP in the command input area on any screen or pop-up and press
Enter.

Or

Type a question mark (?) in the command input area on any screen or pop-up
and press Enter.

This table lists the various online help information provided by Recap, and how to access

them.
Screen and pop-up help Request help for the current screen or pop-up by

Typing HELP, pressing PF1/13, or by selecting Help »

(See "Screen and Pop-up Help Current Screen. No messages can display on the

on page 224.) screen or pop-up at the time this help is requested.
Report help Request help for Recap reports typing HELP

REPORTS, typing REPORTS and pressing PF1/13, or

(See "Report Help” on by selecting Help » All reports. Help for specific

page225) reports may also be requested through the Help
Tutorial Index.
General information Request general help information by typing TOC from
(See "General Information” on within the Help Tutorial, or by selecting Help P Table
age 226) of contents.
Specific information Request help for specific subjects by typing INDEX

from within the Help Tutorial, by selecting option 5 on
the Help Table of Contents, or by selecting Help »
Index. Help for a specific topic can be viewed by
selecting the appropriate index entry.

(See "Specific Information" on
page 227.)
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Help Topic How to Access

Abends

(See "Help Abends" on

Request help for ESW user abends by typing HELP
ABENDS, or selecting Help » Common Abends. The

page 228.)

Abends screen displays. Select topic 2 on this screen
to display the ESW Abend Codes screen, which lists
all the ESW user abends, and explanations for each
abend.

Messages

(See "Help Messages" on

Request help for a short message, displayed in the
upper right corner of the screen, by typing HELP or

page 229.)

pressing PF1/13. The corresponding long message
displays. Display help for a specific long message by
typing HELP with the msg# operand, selecting Help »
Current Message, or by selecting Help » Specific
Message.

Help Navigational Commands

All of the online help subjects listed in the previous table are contained in the Help
Tutorial. Each online help topic can be reached from anywhere within the Help Tutorial
by going through the Help Table of Contents or Index. After the Help Tutorial is
accessed, these are the commands available for navigating within the Help Tutorial:

Help Command Purpose

BACK Redisplays the previous Help Tutorial screen.

END Exits the Help Tutorial.

ENTER Displays the next screen in a continuation series.

INDEX Displays the first screen of the Help Index.

SKIP Goes directly to the next subject.

TOC Displays the Help Table of Contents.

UP Displays the next higher-level subject.

alpha character On an Index screen, entering an alphabetic character displays the

Index screen corresponding to that character.
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To request help for the current screen or pop-up, follow this step:

» Choose one of these options:

. Type HELP and press Enter.

. Press PF1/13 with no messages displaying on the screen.

. Type HELP SCREEN and press Enter.

. Select Help P Current Screen and press Enter.

The Help Tutorial for the current screen or pop-up displays.
The Help Tutorial for each screen or pop-up describes all the options available on that
screen or pop-up, lists descriptions of all the fields, and notes any special processing

considerations.

Figure 94 shows the Help Tutorial for the Enterprise Metrics View screen.

Figure 94 « Screen Help Example

AXG-Recap -------—- Wiew - Enterprise Metrics -------—---—--————--—- HELP
===
The View - Enterprise Metrics screen is used to view the most current metrics
data calculated for an enterprise. This screen is displayed by selecting
Enterprise Metrics... from the View pull-down and entering the AKR data set
name oh the Wiew - Open Metrics Repository pop-up.

Then this pop-up is first displayed, metrics are sorted alphabetically by

application name. To change the sort order, select Sort... from the Options
pull-dovm to display the Options - Sort Metrics pop-up to specify the new sort
order.

HOTE: The Wiew - Enterprise Metrics screen has a shortened action bar. The
following section describes the action bar choices on this screen.

4otion Bar Descriptions

File The File pull-dowm contains the following actions:
Print
Prints the metrics data for the enterprise. To release
the print, select the Options pull-dowm and then choose
Process list file...
(More...press ENTER to continue.)




Report Help

To request help for Recap reports

1 Choose one of these options:
. Type HELP REPORTS and press Enter.

. Type REPORTS and press PF1/13.

. Select Help » All reports and press Enter.

14 Help Facility

The ASG-Recap Reports help table of contents screen displays, as shown in

Figure 95.

2 Select a report and press Enter for more information about that report.

You can also request help for specific reports through the Help Index.

Figure 95 » Recap Report Help Screen

===

- Application Comparison

- Application Definition

- Application Exceptions

- Application Function Point Analysis
Application Metrics

- Application Progress

- Application Summary

- Enterprise Exceptions

9 - Enterprise Metrics

10 - Executive Summary

11 - Master Index

12 - Program Comparison

13 - Program Metrics History

14 - Program Progress

15 - Table of Contents for Reports

0 -~JOU b WK -
'

ASG-Recap R7.0 ------------- ASG-Recap Reports -------------

The following will be presented in sequence, or may be selected by number
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General Information

To request general help information, follow this step:

» Choose one of these options:
. From the Help Tutorial type TOC and press Enter.
. Select Help P Table of contents and press Enter.

Figure 96 shows the Help Table of Contents.

Figure 96 « Help Table of Contents

ASG-Recap R7.0 ----------- HELP TRBLE OF CONTENTS =--=-=====-===c==comoo HELP

===>

The topics below represent general categories of information about the ASG-ESW
Portfolio Analysis component, ASG-Recap. To get help for a pull-down, select
the Action Bar topic. This Help Table of Contents may be redisplayed from

any Help screen by entering the TOC command.

The following topics will be presented only if explicitly selected by number:

1 Overview of ASG-Recap 6 Customer Support

2 Introduction to CUA 7 Index for ASG-Recap Help

3 The Action Bar 8 Conversion from R2.2 to R3.0
4 Release 7.0 Summary of Revisions 9 Analyze Restart Recovery

5 Required Components when Defining an
Application for Correct Function Point
Analysis
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Specific Information

To request help for specific topics

1 Choose one of these options:
. In the Help Tutorial type INDEX and press Enter.
. Select option 6 on the Help Table of Contents and press Enter.

. Select Help P Index and press Enter.
2 To view help for a specific topic, select the appropriate Index entry.

Type an alphabetic character on any Index screen and press Enter to display the Index
screen corresponding to that character.

Figure 97 shows a Help Index screen.

Figure 97  Help Index Example

ASG-Recap R7.0 ----------------- Index A ---------------------—-m- oo HELP

===> _
To select a topic, enter the two-character identifier.

Al - Action Bar

A2 - Action Bar for Yiew screens

A3 - Add Copylib pop-up

A4 - Add CICS CSD Dataset

A5 - Add CICS Library

A6 - Add Function Points - External Input Type pop-up

A7 - Add Function Points - External Interface File Type pop-up
A8 - Add Function Points - External Inquiry Type pop-up

A9 - Add Function Points - External Output Type pop-up

Al0 - Add Function Points - Internal Logical File Type pop-up
All - Add IMS Library

Al2 - Add JCL Library

Al3 - Add Library - Librarian pop-up

Al4 - Add Load Library pop-up

Al5 - Add Source Library pop-up

Al6 - Add Proclib pop-up

(More...press ENTER to continue.)
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Help Abends

To request help for ESW user abends

1 Choose one of these options:
. Type HELP ABENDS and press Enter.
. Type ABENDS and press PF1/13.

. Select Help » Common Abends and press Enter.
The ABENDS screen displays, as shown in Figure 98.

2 Select Topic 2 to display the ESW Abend Codes screen, which lists all the ESW user
abend messages and explanations for each message.

Figure 98 « ASG Abend Codes Screen

ASG-Recap R7.0 ---------------- ASG ABEND CODES ---------==-=-=---------- HELP
===)

Abend codes in the range 900 - 999 (X'384 - ¥X'3E7’') bypass ASG error

recovery, causing the abend to be handled by ISPF or by the system. If the
problem cannot be resolved, call Customer Support.

965 X'3C5° Unable to intercept program.

967 X'3C7’ The ASG-Center AUTHORIZE password was not specified during
installation.

968 X'3C8’ An internal error occurred during initialization.

970 X'3CA’ A package load module was called directly.

972 X'3cC’ The ASG Edit Monitor encountered a severe error.

974 X' 3CE’ An invalid VIASBASE module was found. The current product

expects a level of CEO50 or greater. Enter HELP 4988 for more
information.
[continued)
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Help Messages

Recap messages display in the long message area, which is the third line on a pop-up or
the fifth line on a screen. This is the format for messages:

VIAnnnnx text
where:
nnnn is the message number.
x is one of the severity levels listed below.

text is the long or short message text.

Level Description

I Informational - no required action.

w Warning - an error condition exists that is not critical.

E Error - a critical error condition exists.

D Disaster - a serious error condition exists; the product is unable to continue.
T Termination - the product terminated with the specified error.

Short messages display when available. Long messages display if a short message does
not exist, or when help is requested immediately following a displayed short message.
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To request help for a specific message, follow this step:

» Choose one of these options:
. Type HELP followed by the message number and press Enter.
. Select Help » Current Message and press Enter.

. Select Help P Specific Message and press Enter.

The Help Explanation and Action Panel for that message displays (see Figure 99).

Figure 99 « Help Explanation and Action Panel

HELF Explanation and Action Panel
Command === Scroll === CSR

Additional support may be found at our Web Site: support.asg.com
ASGRSEY  "#1" I5 YALID OWNLY AFTER AW APFLICATION HAS BEEW OPENED.

EXPLANATION:
The specified command is valid only after an application has been
opened from the Open Application action or selected from the AKR
directory.

ACTION:
Go to the Open Application action and select an application.
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Printing Messages

All Recap messages or a range of messages can be printed using the VIASMPRT
program. The VIASMPRT program produces a listing of the specified messages that
includes:

. Message number

. Short message (if available)
. Long message

. Explanation of the message
. Action (if any)

JCL to execute the VIASMPRT program is in ASG.VIACENxx.CNTL(VIASMPRT).
The entire message file prints unless a specific range is specified in the PRM parameter.
For example, PRM="'START=300, END=499"' would print messages 300 through 499.

The ALL keyword can be specified in the PRM parameter to print all messages.

The default value for START is 1; the default value for END is 5000. If only the START
value is entered, messages print starting at the message number specified and ending with
5000. If only the END value is entered, messages print starting with 1 and ending with the
message number specified.

The NOTES keyword specifies that any notes associated with a message print. The
default is NONOTES. Typically, notes are provided to illustrate Center primary
commands.
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Figure 100 shows the VIASMPRT JCL. Figure 101 on page 233 shows the output from
the job.

Figure 100 « VIASMPRT JCL

//BASG JOB ( ),'ASG-CENTER VIASMPRT'
//* INSERT '/*ROUTE PRINT NODE.USER' HERE IF NEEDED.

*
;;* LRSS SRR SRR R R SRR ERE RS S SR RS R RS S S SRS SR EREEEEEREEEEEEEES
//* * ASG, INC. ASG-CENTER RX.X MMM, YYYY *
//* * *
//* * UTILITY TO PRINT ASG MESSAGES *
//* * *
//* LRSS SR RS SRR SRS RS SRS S SRS R RS SE SRS RS EEEEEEEREEEEEEEES
/1%
//VIASMPRT PROC VIASOFT='ASG', HIGH LEVEL NODE OF ASG DATA SETS
// CENTER='VIACENXX', MIDDLE NODE OF ASG DATA SETS
// SYSOUT="*", PRINT OUTPUT MESSAGE CLASS
// PRM=""' PARM FOR MESSAGES TO BE PRINTED

*
;;* LRSS SRS SRR RS SRS E RS S SR EE R RS S S SRS RS EEEEEEEREEEEEEEES
//* * *
//* * MESSAGE PRINT UTILITY *
//* * *
//* * THIS PROGRAM WILL PRINT ALL OF THE MESSAGES IN THE ASG *
//* * MESSAGE FILE AND THE HELP TEXT ASSOCIATED WITH EACH *
//* * MESSAGE IT WILL PRINT THE ENTIRE FILE BY DEFAULT. YOU MAY *
//* * SELECT A GIVEN RANGE OF MESSAGES BY SPECIFYING THE OPTION- *
//* * AL PARAMETER KEYWORDS: START AND END. FOR EXAMPLE: *
//* * PRM="'START=300,END=499" *
/7% * WILL PRINT MESSAGES NUMBER 300 THROUGH 499, INCLUSIVE. *
//* * THE DEFAULT VALUES FOR START AND END ARE 1 AND 99999 *
//* * RESPECTIVELY. CONSEQUENTLY THE PRM VALUE 'END=300' WILL  *
//* * PRINT MESSAGES 1 THROUGH 300, AND THE PRM VALUE *
//* * 'START=4000' WILL PRINT MESSAGES 4000 THROUGH 99999. *
//* * *
//* * AN OPTIONAL KEYWORD, NOTES, WILL ALSO PRINT ANY NOTES *
//* * ASSOCIATED WITH A MESSAGE. *
//* * *
/7% * ADDITIONALLY, THE KEYWORD 'ALL' WILL EXPLICITLY PRINT ALL *
//* * MESSAGES. *
//* LRSS SRR SRR R RS SRR E RS S SR RS R RS S S SRS RS EEEEEEEREEEEEEEES
//*
//*
//VIAMPRT EXEC PGM=VIASMPRT,REGION=4096K,
// PARM="'§&PRM'

//STEPLIB DD DSN=&ASG..&CENTER..LOADLIB, DISP=SHR
//VIRMSGS DD DSN=&ASG..&CENTER..VIAMSGS, DISP=SHR
//SYSPRINT DD SYSOUT=&SYSOUT
//VIAPRINT DD SYSOUT=&SYSOUT

//VIALOG DD SYSOUT=&SYSOUT

//SYSUDUMP DD SYSOUT=&SYSOUT

//*

// PEND

//*

//VIASMPRT EXEC VIASMPRT PRINT MESSAGES
//*
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Figure 101 = VIASMPRT Output

Help Facility

PRINTING MESSAGES FROM 0771 TO 0772.

2 MESSAGES PRINTED.

END OF MESSAGE PRINT PROCESSING.

VIA0771 SUBSET 'COBOLII' IS NOT VALID IN A LANGLVL 1 OR 2 EDIT SESSION.

EXPLANATION:
The COBOL Edit session was selected to view a program as COBOL
LANGLVL1 (COBOL68) or LANGLVL2 (COBOL74), and the command entered
requested a target of SUBSET COBOLII.

ACTION:
If the program is COBOLII, then re-enter the Edit screen with COBOLII
selected; then you may enter commands for SUBSET COBOLII.

VIAO0772 THE EDITOR PARAMETER 'l' IS UNKNOWN.

EXPLANATION:
An invalid parameter was entered in the Editor Parms field of the
Edit Options panel.

ACTION:
Refer to the Reference Manual or the Reference Card for a list of
valid editor parameters.
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Sample AKR

An AKR with sample applications is provided with Recap. All applications contain
metrics, function point analysis, and program quality data. The sample AKR should be
used as a training tool to help the first-time user learn the online portion of the product as
well as the reports generated by Recap. Because the original COBOL source is not
available, an analyze cannot be executed on any of the sample applications.

The sample AKR is stored on the Recap installation tape. For installation information, see
the ASG-Recap Installation Guide.
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Glossary

action bar

The line of keywords at the top of a screen. Each keyword represents a category of
actions that may be performed on that screen. An action is selected by moving the cursor
to the desired keyword and pressing Enter. See "Introduction" on page 1 for more
information.

AKR
See "Application Knowledge Repository (AKR)" on page 238.

Alias Of

A field on a pop-up listing entries in the AKR. If the analyzed program contains an
ENTRY point, Alias Of is the name of the program that contains the ENTRY point. If the
name in the PROGRAM-ID statement was overridden at the time the analyze job was
submitted, Alias Of is the name that was entered in the AKR program name field on the
Analyze - Submit Application pop-up.

analyze

A batch process to gather portfolio analysis information, including organization, data
relationships, and execution paths, Function Point analysis, and software metrics. This
process stores the portfolio analysis information in the specified host Application
Knowledge Repository (AKR). See the 4ASG-Application Definition and Analysis User’s
Guide for more information.

analyze options

Run-time options, similar to COBOL compiler options, used to control the Analyzer

processing. Default values are established at installation time and can be overridden by
'

editing the Analyzer JCL or by using the Analyze screens. "Building and Analyzing an
Application" on page 23 contains a complete description of each Analyze option.

analyze summary report
A summary of the run-time statistics and diagnostic messages that are produced when an
Analyze job completes.

application

An application is any group of programs that you want to analyze/view as a whole. These
programs would all be defined within the same application. See "Building and Analyzing
an Application" on page 23 for more information on defining an application.
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Application Analytical Engine (AAE)
Analyzes all components of an application to allow portfolio analysis.

Application Definition
The COBOL, Load Module, JCL, CICS, and IMS components and attributes associated
with an application.

Application Definition Facility

Provides the ability to define application attributes used to conduct an automated
inventory analysis. See "Building and Analyzing an Application" on page 23 for more
information on using the application definition facility.

Application Knowledge Repository (AKR)

A BDAM or VSAM file organization that contains all analysis information produced by
the Analyze job. Multiple AKRs can be defined. See "AKR Utilities" on page 185 for
more information.

attributes
The analysis parameters, copy libraries, IDMS information, maclibs, and procedure
libraries used by a specific library or member.

command input area
The field on Recap screens where primary commands are entered, indicated by ===> on
the fourth line of the screen.

complex processing
The general system characteristic used to assess the degree to which the processing logic
influences the development of the application.

CUA (Common User Area)
Recap features Common User Access (CUA) screens, action bars, pull-downs and
pop-ups that are designed to provide easy access to all of the product features.

data communication
The general system characteristic used to assess the degree to which an application
communicates directly with the processor.

Data Element Type

User recognizable, non-recurring fields residing in an Internal Logical File or External
Interface File and used by an External Input, External Output, or External Inquiry. The
Data Element Type is used as one of the factors to determine functional complexity.

data name
A standard COBOL term for fields defined in the DATA DIVISION of a COBOL
program. Variable names, files, groups, array elements, and fully qualified datanames.



Glossary

DBCS
See Double Byte Character Set (DBCS).

Degree of Influence (DI)
A measurement, assigned to each General System Characteristic, that is used in a
calculation to determine the Value Adjustment Factor.

DDL
DB2 SQL Data Definition Language, a subset of SQL.

diagnostic message

An informational or error message generated by the online and batch components.
Online, a short message displays in the upper right corner of the screen (if available). A
long message displays on line three when PF1/PF13 is pressed or HELP is entered for a
short message. Batch - Messages are included in the Analyzer Summary.

discovered component

Components discovered while processing JCL members during the analyze process that
are not included in the application definition, but that appear to be needed by components
that are defined. For example, the analyze may discover a source library in a COBOL
compile JCL member that is not included in the application definition.

Discovered components may be resolvable or unresolvable. Resolvable components can
be added to the application definition by Recap. Unresolvable components must be
manually added to the application definition because Recap is unable to determine where
they should be added.

distributed processing
The general system characteristic used to assess the degree to which the application
transfers data among components of the application.

DL/I| DL/
The database (DB) portion of the IMS system.

DML
DB2 SQL Data Manipulation Language, a subset of SQL.

Double Byte Character Set (DBCS)

A character set that uses two bytes to represent each character. Various Double Byte
Character Sets are used with languages such as Chinese and Japanese that cannot be
represented with single byte codes.

end-user efficiency

The general system characteristic used to assess degree of consideration for human
factors and ease of use for the user of the application measured.
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Enhancement Function Points

The Enhancement Function Point count for an application is a measure of the
modifications to an existing application that add, change, or delete user function within
the scope of the project. This measurement can be used to calculate the effort used to
enhance an application.

enterprise
All applications defined in the same Application Knowledge Repository (AKR).

Export Facility

Provides the ability to export the application definition using keyword control statements.
The export facility also provides the ability to export application analysis data from the
AKR in CDF format. This data can then be used to build DB2 relational tables or to
transfer to a workstation for loading into database applications.

external input

A component that maintains (add, changes, or deletes) data on an Internal Logical File.
For example, if a screen within the application contains actions that add, change, and
delete information, the screen counts for three External Inputs.

External Inquiry (EQ)
Represents the functionality provided for queries of Internal Logical Files and External
Interface Files.

External Interface File (EIF)
Logical group of data that is utilized by the application but maintained by another
application.

External Output (EO)

Processes that send data or control information outside the application's boundary.
Examples of External Outputs include reports generated by the application and data that
is formatted and processed for use by another application.

facilitate change
The general systems characteristic used to assess the degree to which an application was
developed for easy modification of processing logic or data structure.

File Types Referenced (FTR)

Counted for each Internal Logical File maintained (for an External Input only) or each
External Interface File or Internal Logical File referenced during the processing of an
External Input, External Output, or External Inquiry. The File Types Referenced is one of
the factors used to determine the functional complexity of an External Input, External
Output, and External Inquiry.
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general systems characteristics

A set of 14 characteristics used to assess the influence of environmental, physical, or
logistical problems that may be encountered while implementing, operating, or
maintaining a system. These characteristics are used to calculate an adjusted function
point number for a particular application.

heavily used configuration
The general system characteristic used to assess the degree to which computer resource
restrictions influenced the development of the application.

help

Recap has three levels of Help: Long messages, notes, and tutorial screens. Specific
command information is available by entering a command, then pressing PF1/13. The
Help facility can also be accessed from the Help pull-down or any Recap screen. See the
online help or "Help Facility" on page 221 for more information.

Import Facility

Provides the ability to import an application definition that was defined using keyword
control statements. Usually, the input file is produced by the Export Facility. The input
file must be a sequential file containing 80 byte records.

installation ease
The general systems characteristic used to assess the degree to which conversion from
previous environments influenced the development of the application.

Label Name
Any PROCEDURE DIVISION paragraph or section name and the PROCEDURE and
PROC literals.

live exit
An abnormality in program control caused by out of perform range GO TOs and
overlapping perform ranges.

log file
A file that is allocated by Recap and used for error messages and log commands.

logical lines of code

The value for counting logical lines of code in a program is derived by adding the
physical line counts of the Identification and Environment divisions, the number of
statements in the Data Division (where a statement ends in a period), and the number of
statements in the Procedure Division.

long message

A diagnostic or error message that displays on line five of Recap screens or line 3 of
pop-ups. Long messages are sometimes preceded by short messages that are displayed in
the upper right corner of the screen. Pressing PF1/PF13 after receiving a short message
displays the corresponding long message.
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member
A member in a PDS or source manager such as Panvalet or Librarian. This can be the
alias name found in the Application Knowledge Repository (AKR).

metrics
A measure of program quality or complexity.

missing component

A component that is expected but not found during the analyze. This could be a
component that was found in the previous analyze and is now deleted or a component that
is referred to by another component, but that is not in the application definition.

multiple sites
The general systems characteristic used to assess the degree to which an application was
developed for multiple locations and user organizations.

online data entry
The general systems characteristic used to assess the degree to which an application was
developed for interactive transactions.

online update
The general systems characteristic used to assess the degree to which data is entered
through interactive transactions.

operational ease
The general systems characteristic used to asses the degree to which the application
attends to operational aspects such as start-up, back-up, and recovery processes.

performance
The general systems characteristic used to assess the degree to which response time and
throughput performance considerations influenced the application development.

perform range

A perform range consists of the source code contained in a PERFORM statement, and
includes all code that is or could be executed as a result of GO TOs, PERFORMs, etc.,
within that PERFORM.

physical lines of code

The value for counting physical lines of code in a program is derived by adding all of the
statements in the program, including comments, blank lines, and expanded copy/include
statements.

pop-up

A window that displays as the result of selecting an item on a pull-down or pop-up, or as
the result of entering certain commands. It is superimposed on the screen to allow entry
of information for the requested action. See "Introduction" on page 1 for more
information.
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portfolio analysis

A portfolio analysis consists of: inventory of all application components, functional
priority of applications with respect to your business, complexity and quality
measurements and degree/frequency of change.

primary command
An instruction entered in the command input area of the screen.

program
Program source member name, the name specified in the IDENTIFICATION DIVISION
of a COBOL program, or the CSECT name of a program that is not COBOL.

pull-down

The list that displays when an action is selected on the action bar. On a pull-down, actions
followed by ... display a pop-up when selected. Actions not followed by ... immediately
activate internal commands. See "Introduction" on page 1 for more information.

Record Element Type (RET)

Logical subsets of Internal Logical Files and External Interface Files. The Record
Element Type is one of the factors used to determine the functional complexity of
Internal Logical Files and External Interface Files.

recursion
A perform range or paragraph that performs itself.

reusability
The general systems characteristic used to assess the degree to which the creation or use
of standardized software specifications influenced the development of the application.

reports
Hard copy reports of the results of the inventory analysis.

resolvable discovered components

Discovered components that Recap can add to the application definition. For resolvable
discovered components, Recap can determine where to add the component within the
application definition.

SBCS
See "Single Byte Character Set (SBCS)" on page 244.

screen

A full-width display of information containing an action bar as the first line. Recap
screens are modeled after TSO/ISPF screens. See "Introduction" on page 1 for more
information.
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short message

A diagnostic or error message that displays in the upper right corner of Recap screens.
Pressing PF1/PF13 after receiving a short message displays the corresponding long
message.

Single Byte Character Set (SBCS)

(SBCS) - A character set that uses one byte to represent each character. Single Byte
Character Sets are used with languages such as English where the characters can be
represented with a one-byte code.

software metrics
Measurements that provide an objective, quantitative, and practical way to determine the
quality (in terms of size, structure, complexity) of software applications.

SQL
DB2 Structured Query Language, including DML and DDL.

transaction rates
The general systems characteristic used to assess the degree to which the rate of business
transaction influenced the development of the application.

unresolvable discovered components

Discovered components whose location within the application definition cannot be
determined by Recap. Unresolvable discovered components must be added manually to
the application definition if they are needed.

version

A set of values for metrics and exceptions (i.e., missing and dead components) related to
a specific time. These values are created by a full or updated during an incremental
analysis.

VIAXESUM

A file included with Recap that contains the Report Generator Programming Language.
This file provides information needed to generate the Executive Summary Report. If you
want to print the Executive Summary Report in mixed case letters, specify this file as the
member name in the Report - Executive Summary pop-up.

VIAXESUU

A file included with Recap that contains the Report Generator Programming Language
identical to VIAXESUM. If you want to print the Executive Summary Report upper case
letters, specify this file as the member name in the Report - Executive Summary pop-up.
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work file

The work file is used for intermediate storage during an online session. The DD name
assigned to the work file is VIAUT3. The file is allocated upon entry into Recap. If the
analyze abends, the work file is retained and used during restart of the analyze job. The
work file is deleted when you exit the product or when Recap completes a successful
analyze. See the Analyze Resource Estimate table in the ASG-Application Definition and
Analysis User’s Guide for more information.
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Symbols
&assign
description 140
example 140
&col 145
&col, description 145
&compute
description 141
example 141
&lmargin and &rmargin, description 144
&newline
description 144
example 144
&paragraph
example 144
&paragraph, example 144
&space, description 144
&while
description 143
example 143

A
adjusting function points
reclassifying EO/EI pairs as EQ
element 76

reclassifying ILF and EIF elements 75

AKR
allocate without ISPF 209
definition 7
expand without ISPF 209
management 185
relationship to applications 39
VIASAKRX JCL example 213
AKR batch utility

DELETE Batch AKR command 194

EXPORT batch AKR command 195

HELP batch AKR command 196

INIT batch AKR command 197

MOVE batch AKR command 198

PRINT batch AKR command 199

PUNCH batch AKR command 200
AKR utility directory report 202

Index

AKR utility log 203
AKR with sample applications 235
alarm settings, specifying in Recap 30
Alliance
accessing from ESW screen xvi
description xiii
linking xvi
analysis status report
AKR detail 206
AKR summary 205
application detail 207
analyzing an application 43
analyzing applications, manual 43
application
analyze job 43
creating 39
exporting definition 181
running reports 43
steps for naming 40
application analysis, manual 43
application comparison report
business value vs. complexity field
descriptions 123
report field descriptions 120
application components, listed 41
application definition
checklist 24
copying 183
creating a template 183
creating an application 39
defining attributes 41
defining components 41
establishing the boundaries of the
application 10
exporting 181
importing 153
manual reference 41
process 24
Application Definition and Analysis, User
Guide 41
application definition, providing an
application description 40
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application description complexity matrix, example 13
steps for entering 40 computing the adjusted function point value,
application exceptions pop-up, report field when counting function points 16
descriptions 118 computing the enhancement function point
application function point analysis report, count 17
final calculations table 102 computing the value adjustment factor, when
application metrics report 113 counting function points 15
application portfolio analysis, description 8 computing unadjusted function points, when
application progress report counting function points 14
report field descriptions 126 confirmation pop-ups, controlling operation
application summary, description 87 of 30
applications, relationship to AKR 39 continuous improvement, scenario 51
AutoChange control variable complexity metric,
accessing from ESW screen xvi described 19
description xiii conventions page Xx
copying application definition 183
B counting function point types 10
batch AKR utility counting function points 10
AKR utility log 203 see also function point counting 10
analysis status report 204 cyclomatic complexity metric, example 18
command format 188
command syntax 189 D
control cards 188 data element types 12
CONVERT command 192 data item
COPY command 193 uninitialized 130
DELETE command 194 use 130
EXPORT command 195 DEADCODE 117, 132
HELP command 196 defining applications, manual 41
INIT command 197 degree of influence 16
JCL 187 detailed function point information 178
MOVE command 198 determining functional complexity, when
PRINT command 199 counting function points 12
print directory report 202
PUNCH command 200 E
punch directory 208 editing function points
reports 201 reclassifying EO/EI pairs as EQ
Bridge elements 76
accessing from ESW screen xvi reclassifying ILF and EIF elements 75
description xiii editing Recap function points, reasons to
perform edits 72
C EI, reclassifying as external inquiry 76
Center, description xiii EIFs, reclassifying element type 75
checklist, application definition 24 Encore
COBOL, support 5 accessing from ESW screen xvi
command syntax diagrams 189 description xiv
compile JCL, importance of 28 enhancement function point count,
compilers computing 17
ANSI COBOL 5 enterprise exceptions report 130
CASE generated COBOL 5 enterprise exceptions report, report field
COBOL for MVS and VM 5 descriptions 132
COBOL for 0OS/390 and VM 5 enterprise metrics report 127
COBOL1I 5 enterprise metrics report, example 128
COBOL/370 5 EO, reclassifying as external inquiry 76
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EQ
how Recap counts 76
reclassifying EO/EI pairs as EQ 76
essential complexity metric, described 19
establishing the boundaries of an application,
when counting function points 10
Estimate
accessing from ESW screen xvi
description xiv
ESW
description xii
invoking products xv
product integration xvi
executive summary report
report generator language 89
Executive Summary Report, printing in
mixed case 45
Executive Summary Report, printing in
upper case 45
export application definition 181
export metrics facility
creating CDF files for export 175
detailed function point
information 178
output from export 177
program and application metric
information 177
summarized function point
information 179
export procedure, application definition 182

F

File - AKR Allocate/Expand pop-up 186
File - AKR Directory pop-up 186
File - AKR Utility pop-up 186
file type referenced 12
function point
adjusting 71
function point analysis, description of
process 9
function point counting
adjusting 71
computing the adjusted function point
value 16
computing the value adjustment
factor 15
computing unadjusted function
points 14
determining functional complexity 12
establishing the boundary 10
function points
as a basis for other metrics 8
counting 10
defined 8

Index

definition 8

scenario using 49

uses of 49

viewing Recap’s calculations 71
functional complexity

data element types 12

file type referenced 12

record element types 12

using a complexity matrix 13
functional quality

description 48

how measured 48

G
general system characteristics
assigning score to 16
influencing the value adjustment
factor 15
list of 15
online worksheet 42
GSC worksheet, how to access online 42

H
help
for abends 228
for general information 226
for messages 229
for pop-ups 224
for reports 225
for screens 224
for specific information 227
how to obtain 223
index 227
navigational commands 224
printing messages 231
Recap reports 225
topics 223
tutorial 223

|
ILFs, reclassifying element type 75
import facility, described 153
import language reference
application information 155
default section 156
definition section 161
definition section example 170, 172
file structure 155
keyword list 172
syntax 154
importing an application definition 153
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Insight
accessing from ESW screen xvi
description xiv
using analysis functions xvi
invoking Recap 29
ISPF
operating systems version 5
when not installed 217

J
JUMP, out of PERFORM 116

K

knots count metric
described 20
example 20

L

list file, allocating 31
live exit 116, 132
log file, allocating 31

M
master index 133
master index, report field descriptions 134
measurement, when performed 47
messages
long 229
printing all 231
short 229
metrics 18
MVS 5

(0]
Options - Product Allocations pop-up 31
Options - Script File Allocations pop-up
description 34
example 34
output from export 177

P
pop-up
File - AKR Allocate/Expand 186
File - AKR Directory 186
File - AKR Utility 186
Function Points - General System
Characteristics 41
options - product allocations 31
Options - Script File Allocations 34
Script File Allocations 34
portfolio analysis, description &

preprocessor support
command level CICS 5
command level DL/I 5
IDMS 5
SQL 5

printer support 5

product integration xvi

product parameters, viewing current
settings 30

program and application metric
information 177

program metrics history report
report help example 84
software science volume field

descriptions 104
program progress report 111

Q

quality
functional 48
technical 48

quality and productivity improvement
program, as supported by Recap 48

R
reanalyzing application, effect on previous
function point edits 80
Recap
accessing from ESW screen xvi
action bar - how to select actions 4
action bar - selecting an item 4
action bar description 4
analyze process 2
CUA features 4
CUA interfaces 4
description xiv
initiating a Recap session 29
operating systems 5
pop-ups - description 4
pop-ups - how to process 4
product overview 2
pull-down description 4
Recap option
APLCMP 217
APLDEF 217
APLEXC 217
APLFPA 217
APLMTC 217
APLPRG 217
BANNER 217
COLON 217
ENTEXC 218
ENTMTC 217



EXCSUM 218
LINESPERPAGE 218
NOAPLCMP 217
NOAPLDEF 217
NOAPLEXC 217
NOAPLFPA 217
NOAPLMTC 217
NOAPLPRG 217
NOBANNER 217
NOENTEXC 218
NOENTMTC 217
NOEXCSUM 218
NOPGMCMP 218
NOPGMHST 218
PGMCMP 218
PGMHST 218
Recap reports, help 225
record element types 12
re-engineering decisions, scenario 55
report generator language
control & text selection - &if 141
control and text selection 141
control and text selection -
&while 143
data manipulation - &assign 140
data manipulation - &compute 141
data structures 138
data structures - primary and
subsidiary tables 139
data structures syntax 138
language constructs 139
language constructs - data
manipulation 140
language constructs - text
substitution 140
output formatting 143
output formatting - &col 145
output formatting - &Ilmargin and
&rmargin 144
output formatting - &newline 144
output formatting - &paragraph 144
output formatting - &space 144
primary and secondary input 138
site specific configuration 137
report generator programming language
language constructs 139
language constructs - text
substitution 140
report heading, program metrics history
report 83
report help 225
report help, example from program metrics
history report 84

Index

report options

application comparison report 217

application definition 217

application exceptions report 217

application function point analysis
report 217

application metrics report 217

application progress report 217

banner page 217

colon substitute 217

enterprise exceptions report 218

enterprise metrics report 217

executive summary report 218

lines per page 218

master index 218

program comparison report 218

program history report 218

program progress report 218

substitution character 218

reports

analysis status 204
application metrics 113
application progress 125
application summary 87
colon substitution character 217
enterprise exceptions 130
enterprise metrics 127
generate 217

generating 43

program progress 111
substitution character 218
suppress 217

Sample AKR 235
Script File Allocations pop-up 34
SmartDoc

accessing from ESW screen xvi
description xiv
VCHAR option 218

SmartEdit

accessing from ESW screen xvi
description xv

SmartQuest

accessing from ESW screen xvi
description xv

SmartTest

accessing from ESW screen xvi
description xv

software metrics

control variable complexity 19
described 48

essential complexity 19

for complexity 19
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for logical structure 19
for physical structure 20
for size 19
knots count 20
software science volume 19
uses of 18
software science volume metric,
described 19
starting Recap 29
summarized function point information 179

T
technical quality, how measured 48
total degrees of influence 16

U

unadjusted function point values
complexity rating association 14
example 14

user interface 5

user options
allocating the log and list files 31
listed 30
Log/List Definition 32
product parameters 30
Script File Allocations 34

uses of software metrics 18

\%
value adjustment factor
adjusted function point total effect 16
computing 42
constants used in equation 16
verifying user options, why important 30
version 244
VIAIN DD statement, DPARM
parameter 217
VIASAKRA JCL 209
VIASAKRX JCL 209
VIASMPRT program, JCL 231
VIASMPRTprogram 231
VIAXESUM 244
VIAXESUU 244
viewing current settings, for product
parameters 30
viewing Recap’s function point analysis 71
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